
Modular Messaging 
Release 1.1
Installation 

585-310-332
Comcode 700292022

Issue 3
December 2003



 2003, Avaya Inc.
All Rights Reserved, Printed in U.S.A.

Notice
Every effort was made to ensure that the information in this book was complete 
and accurate at the time of printing. However, information is subject to change.

Avaya Web Page
The world wide web home page for Avaya is:
http://www.avaya.com

Preventing Toll Fraud 
Toll Fraud is the unauthorized use of your telecommunications system by an 
unauthorized party (for example, a person who is not a corporate employee, 
agent, subcontractor, or working on your company�s behalf). Be aware that 
there is a risk of toll fraud associated with your system and that, if toll fraud oc-
curs, it can result in substantial additional charges for your telecommunications 
services.

Avaya Fraud Intervention
If you suspect that you are being victimized by toll fraud and you need technical 
assistance or support, call the Technical Service Center�s Toll Fraud Interven-
tion Hotline at 1.800.643.2353.

Providing Telecommunications Security
Telecommunications security of voice, data, and/or video communications is 
the prevention of any type of intrusion to, that is, either unauthorized or mali-
cious access to or use of, your company�s telecommunications equipment by 
some party.

Your company�s �telecommunications equipment� includes both this Avaya 
product and any other voice/data/video equipment that could be accessed via 
this Avaya product (that is, �networked equipment�).

An �outside party� is anyone who is not a corporate employee, agent, subcon-
tractor, or working on your company�s behalf. Whereas, a �malicious party� is 
Anyone, including someone who may be otherwise authorized, who accesses 
your telecommunications equipment with either malicious or mischievous in-
tent.

Such intrusions may be either to/through synchronous (time-multiplexed and/
or circuit-based) or asynchronous (character-, message-, or packet-based) 
equipment or interfaces for reasons of:

� Utilization (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or toll-facility 

access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, regardless of 

motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated with 
your system and/or its networked equipment. Also realize that, if such an intru-
sion should occur, it could result in a variety of losses to your company, includ-
ing but not limited to, human/data privacy, intellectual property, material assets, 
financial resources, labor costs, and/or legal costs).

Your Responsibility for Your Company�s Telecommunications Security
The final responsibility for securing both this system and its networked equip-
ment rests with you � an Avaya customer�s system administrator, your tele-
communications peers, and your managers. Base the fulfillment of your 
responsibility on acquired knowledge and resources from a variety of sources 
including but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and your 
peers should carefully program and configure your:

� Avaya provided telecommunications systems and their interfaces
� Avaya provided software applications, as well as their underlying hard-

ware/software platforms and interfaces
� Any other equipment networked to your Avaya products

Federal Communications Commission Statement
Part 15: Class A Statement. This equipment has been tested and found to 
comply with the limits for a Class A digital device, pursuant to Part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environ-
ment. This equipment generates, uses, and can radiate radio-frequency ener-
gy and, if not installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference, in which case the user 
will be required to correct the interference at his own expense.

Industry Canada (IC) Interference Information
This digital apparatus does not exceed the Class A limits for radio noise emis-
sions set out in the radio interference regulations of Industry Canada.

Le Présent Appareil Nomérique n�émet pas de bruits radioélectriques dépas-
sant les limites applicables aux appareils numériques de la class A préscrites 
dans le reglement sur le brouillage radioélectrique édicté par le Industrie Can-
ada.

Trademarks
All trademarks identified by ® and � are registered trademarks or trademarks 
of Avaya Inc. All other trademarks are the property of their respective owners. 

Ordering Information
Call: Avaya Publications Center

Voice 1 800 457-1235   International Voice +1 207 866 6701
Fax 1 800 457-1764      International Fax +1 207 626 7269

Write: GlobalWare Solutions
200 Ward Hill Avenue
Haverhill, MA 01835 USA
Attn: Avaya Account Management

Email: totalware@gwsmail.com

Obtaining Products
To learn more about Avaya products and to order products, visit 
www.avaya.com. 

European Union Declaration of Conformity
The �CE� mark affixed to the equipment means that it conforms to the refer-
enced European Union (EU) Directives listed below:
EMC Directive89/336/EEC   
Low-Voltage Directive73/23/EEC
For more information on standards compliance, contact your local distributor.

Warranty 
Avaya Inc. provides a limited warranty on this product. Refer to your sales 
agreement to establish the terms of the limited warranty. In addition, Avaya�s 
standard warranty language as well as information regarding support for this 
product, while under warranty, is available through the following web site: 
www.avaya.com/support.
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About this book

Purpose

This book, Avaya Modular Messaging Release 1.1 Installation, Issue 3, contains 
instructions for installing the Avaya Modular Messaging software in an Avaya 
S3400-family message server setup. Information includes equipment set up, 
configuration, initial administration, and acceptance testing. 

Instructions for updating the messaging software or reinstalling the operating system 
and application software on S3400-family message servers are also included. 

Intended audience

This book is intended primarily for on-site technical personnel who are responsible for 
installing, configuring, or updating the hardware and software for S3400-family 
message servers. We assume that the users of this book have completed a relevant 
hardware installation training course. See Related resources in this preface for 
information on training.

Note: This document is intended to get a Modular Messaging system up 
and running. Customers are encouraged to tailor the basic Modular 
Messaging parameters for their site after a successful installation 
using the Avaya Modular Messaging Software Messaging 
Application Server Administration guide (PDF 3 MB). Copies of this 
guide are on the documentation CD and application software DVD.
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Changes to this book

Changes from Issue 2 (June 2003) to Issue 3 include:

! New configuration wizards that streamline initial MAS administration have 
been added to Chapter 4, ��Administering the Avaya MAS.�� 

! Serviceability information for INADS and SNMP alarming has been added to 
Chapter 4, ��Administering the Avaya MAS,�� and Chapter 5, ��Completing initial 
administration.�� 

! Chapter 6, ��Updating Modular Messaging software,�� has been added to 
support Modular Messaging Release 1.0 to Release 1.1 updates. 

! Appendix A, ��System planning forms,�� and Appendix E, ��Reloading the 
software on an MAS,�� have been updated for the latest software.

! Appendix G, ��Removing Modular Messaging components from an MAS,�� has 
been added.

How to use this book

Before you begin a new installation:

1. Complete all the worksheets listed in Appendix A, ��System planning forms.�� 
You cannot do a new installation without having this material complete and 
accurate. Some of the material must be provided in advance by the customer.

2. Read Chapter 1, ��Preinstallation requirements.�� This chapter covers 
prerequisites and site preparation, including the documentation, tools, and 
equipment you will need to complete an installation. 

3. From there, read and use each chapter in the order presented. Procedures are 
listed in the order in which you must perform them. 

Print Appendix B, ��Installation checklist,�� and use it to track your progress 
during the installation. 

Before you attempt to update or repair a system that is already installed:

! Obtain a copy of the completed worksheets listed in Appendix A, ��System 
planning forms.�� Any information you enter must exactly match what was 
previously administered on the system.

! For a software update: Go directly to Chapter 6, ��Updating Modular Messaging 
software.�� Obtain the software and documentation listed in the Overview 
section. Proceed with the update as directed.

! For a hard disk repair: Go directly to Appendix F, ��Recovering from a 
catastrophic disk failure.�� Proceed as directed.
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Trademarks

Avaya and the Avaya Logo are trademarks of Avaya Inc. and may be registered in 
certain jurisdictions. Unless otherwise specified, all trademarks identified by ® and � 
are registered trademarks or trademarks, respectively, of Avaya Inc. 

Microsoft is a registered trademark of Microsoft Corporation. All other trademarks are 
the properties of their respective owners.

Related resources

This section describes additional documentation and training available to you.

Documentation

See the inside front cover for information on how to order documentation for this 
product. 

Technical assistance

The following technical assistance is available if needed. 

Remote support center

Your project manager or systems consultant is responsible for providing you with the 
telephone number of your remote support center.

The following numbers are available for technical assistance with Avaya products and 
services: 

! Within the United States and Canada: call 1-800-876-2835, prompt 2, then 2.

! Within any other country: call your local distributor.

Help on the system

Online help is available for both the system and administration command-line screens. 
On the web-interface screens, use the Help button. On the command-line interface, 
press F6 (Choices) from the field for which you want the help. 

Note: Always refer to the appropriate CD, DVD, or book for specific 
information on planning, installing, administering, or maintaining an 
Avaya system. See the online catalog for more information on 
other books and CD-ROMs in the documentation set.
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Training 

For information about product training, go to the Avaya web site at www.avaya.com 
and click Training.

How to comment on this book

We are interested in your suggestions for improving this information. Use one of the 
following methods to communicate with us:

Please be sure to include the name of this book:

Avaya Modular Messaging Release 1.1 Installation, Issue 3. 

Method Contact

Email infodev@avaya.com

Voice mail or fax number 303-538-9625

http://www.avaya.com
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Preinstallation requirements

This chapter describes requirements and prerequisites for installing the Avaya Modular 
Messaging software in a new Avaya S3400-family message server setup.  

Section Page

Required documentation 1-2

� Information on the web 1-2

� Documentation and software shipped with the system 1-3

Security considerations 1-4

� Customer's responsibility for their system's security 1-4

� On-site security 1-5

� System security 1-5

Test equipment and tools 1-6

Initial switch and LAN administration 1-7

Site requirements for Avaya message servers 1-8

� Environmental requirements 1-8

� Weight and space considerations 1-8

� Customer-provided cabinet requirements 1-9

� Installation area requirements 1-9

� Power requirements 1-10

� Grounding requirements 1-10

� Demarcation points 1-11
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Required documentation

The following documentation is required to install an S3400-family message server 
system. Some of this information can only be obtained from the Avaya web site. Other 
information is available in the Avaya Modular Messaging Documentation files on CD 
and DVD shipped with the system software. However, the required documentation can 
also be accessed online and printed out prior to beginning the actual installation.

Information on the web

Required documentation for a new installation is available as follows:

! The configuration notes for integrating the MAS and any Dialogic port 
boards installed in it with the PBX or switch at this site. To view these: 

a. Access the www.avaya.com/support web site. 

b. Under Technical Database, click Messaging.

c. Click Modular Messaging.

d. Under General Info, download or print the appropriate configuration notes 
for your switch integration. 

! An editable Microsoft Word version of the planning forms from Appendix 
A, ��System planning forms,�� and the installation checklist from Appendix 
B, ��Installation checklist,�� are also accessible from this web site. To 
download the Word or PDF version: 

a. Under R 1.1, click General Reference.

b. Click the System Planning Forms link to download or print the files 
appropriate for your configuration.

! Additional information needed for installing a new system is on the 
Avaya Modular Messaging Application Software disk and the 
documentation CD. To access this information online:

a. Under R 1.1, click CD Collections.

b. Click the Avaya Modular Messaging Release 1.1 Documentation link.

c. Select the appropriate configuration (such as Avaya Modular Messaging 
with the Avaya MAS and MSS). 

d. On the main page, under Reference, download the files you need:

! The appropriate Dialogic port board installation documents for this 
site (see Table 2-2 on page 2-4 for details)

Note: This information is available only on the Avaya support web 
site and must be obtained prior to installing the software. 

http://www.avaya.com/support
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! The Avaya Modular Messaging Subscriber Options User Guide 
(585-310-789, PDF 1 MB), used for acceptance testing

e. In the Message Storage Server (MSS) Administration section, under 
Backup and Restore, print the MSS backup procedures: �Backing up 
system files (attended)� and �Backing up system files (unattended)�.

Documentation and software shipped with the system

The following software and documentation is shipped with every Modular Messaging 
system.  

Table 1-1. Required Modular Messaging software

Disk: Purpose:

Avaya Modular Messaging 
Application Software DVD

� Installing the Modular Messaging software, Dialogic port 
board drivers, and Text-to-Speech (TTS) software

� Updating an MAS that is running Modular Messaging 
Release 1.0 software to the current release 

� Accessing a copy of the documentation files (see contents 
listed under the documentation CD) 

Avaya Modular Messaging 
Documentation CD 

(2 copies are shipped, one 
for the customer and one for 
the technician) 

Accessing required documentation, including:
� The Dialogic port board installation documents listed in 

Table 2-2 on page 2-4
� Avaya Modular Messaging Subscriber Options User Guide 

(585-310-789, PDF 1 MB), used for acceptance testing
� Avaya Modular Messaging Client Add-in for Microsoft 

Outlook User Guide (PDF 1 MB), if used at this site instead 
of Subscriber Options 

� Backup and restore procedures for the MSS 

Avaya Modular Messaging 
Message Storage Server 
(MSS) Software CD

� Updating an MSS that is running Modular Messaging 
Release 1.0 software to the current release 

� Reinstalling the boot-image software if needed, such as 
after a catastrophic disk failure. See Appendix D, 
��Reloading the software on an MSS,�� for this procedure. 

Avaya Modular Messaging 
OS Boot Software DVD

� Reinstalling the boot-image software if needed, such as 
after a catastrophic disk failure. See Appendix E, 
��Reloading the software on an MAS,�� for this procedure. 

CD-only set (special order only): 

Avaya Modular Messaging 
Application Software and 
Languages CD

Installing Modular Messaging Release 1.1 software on an 
MAS, or updating a Modular Messaging Release 1.0 MAS 

Intel Dialogic Drivers CD Installing or updating Dialogic port board drivers 

Enhanced Email Reader 
Software (3 CDs in set)

Installing ScanSoft RealSpeak Text-to-Speech (TTS) software 
for multiple languages

Documentation CD Identical to the CD shipped with the DVD set 

MSS software CD Identical to the CD shipped with the DVD set 

a_sysbr_2.htm
a_sysbr_2.htm
a_sysbr_3.htm
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Security considerations

The following security-related issues apply to all Modular Messaging installations.

Customer's responsibility for their system's security 

No telecommunication system can be entirely free from the risk of unauthorized use. 
Customers have ultimate control over the configuration and use of the product and are 
solely responsible for ensuring the security of their systems. Customers who 
administer and use the system can tailor the system to meet their unique needs and 
are in the best position to ensure that the system is secure to the fullest extent 
possible. Customers are responsible for keeping themselves informed of the latest 
information such as security patches, anti-virus updates and other relevant information 
for configuring their systems to prevent unauthorized use. System managers and 
administrators are also responsible for reading all the recommendations, installation 
instructions, and system administration documents provided with the product in order 
to understand the features that can introduce risk of toll fraud and the steps that need 
to be taken to reduce that risk.

Avaya does not warrant that this product is immune from or will prevent unauthorized 
use of telecommunication services or facilities accessed through or connected to it. 
Avaya will not be responsible for any damages or charges that result from either 
unauthorized uses or from incorrect installations of the security patches that are made 
available from time to time. To aid in combating these crimes, Avaya intends to 
strengthen relationships with its customers and its support of law enforcement officials 
in apprehending and successfully prosecuting those responsible.

Suspected security vulnerabilities with Avaya products should be reported to Avaya by 
sending mail to securityalerts@avaya.com. Reported vulnerabilities are prioritized and 
investigated. Any corrective actions resulting from the vulnerability investigation are 
posted at http://support.avaya.com/security. Whether or not immediate support is 
required, please report all toll fraud incidents perpetrated on Avaya services to Avaya 
Corporate Security. In addition to recording the incident, Avaya Corporate Security is 
available for consultation on product issues, investigation support, law enforcement, 
and education programs.

See Modular Messaging and Security on the documentation CD for more information 
on system security. 

http://support.avaya.com/security
se_toc.htm
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On-site security

It is the responsibility of the on-site installer to take precautions to protect passwords 
and the system�s physical location as described in this section. 

Password security 

To protect password security: 

! Do not leave written passwords laying out or allow anyone to see them.

! At the first opportunity, give the passwords directly to the customer's 
designated representative.

! If you suspect that the security of any password has been compromised, 
notify your project manager or system administrator.

System security during the installation

To protect system security during the installation: 

! Remove all test subscribers and test mailboxes from the system when 
the procedures instruct you to do so.

! Do not configure any unassigned mailboxes. 

! Always log off or lock the server if you will be leaving it unattended, even 
for a short period of time.

System security

Customers are responsible for obtaining and installing anti-virus software on any 
Microsoft Windows machine that is used to run Avaya Modular Messaging software, in 
accordance with their local policy. In addition, Microsoft Windows security patches 
must be installed and routinely updated to protect the operating system from known 
security weaknesses.

Note: Unassigned mailboxes are mailboxes that have an 
extension, but no subscriber assignment. 
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Test equipment and tools

The following test equipment and tools are recommended for all new Modular 
Messaging installations.

Test equipment

Recommended test equipment for a successful installation includes: 

! At least one telephone that is connected through the switch or Private 
Branch Exchange (PBX). It must be of the same type as the majority of 
telephones the customer will be using on the system. 

� If the message waiting indicator (MWI) for the system is a lamp, the 
test telephone must be equipped with a lamp. If the MWI is a stutter 
tone, it must be able to give the stutter notification. 

� The test telephone must be placed so that you can easily see the 
monitor while using it. 

! If fax messaging is to be installed, you need access to a fax machine.

! A volt/ohm meter. 

Tools

You should have the following tools on site to successfully install a new system: 

! A medium-width flatblade screwdriver 

! A No. 2 Phillips screwdriver 

! A small pair of needlenose pliers 

! A small pair of wire cutters 

! A sharp, pointed instrument such as a ballpoint pen

CAUTION: Do not use the point of a lead pencil to operate the system 
reset switch. The graphite can damage a circuit card, and 
cause problems such as electrical shorts.

!
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Initial switch and LAN administration

This section describes the initial switch or Private Branch Exchange (PBX) and local 
area network (LAN) administration that must completed by the customer before or 
during a new S3400-family message server installation. 

Initial switch or PBX administration

Initial switch or PBX administration may or may not be complete when you arrive on 
site, depending on the contract or customer agreements. When you install a new 
server, the switch must be administered to support the following situations: 

! For configurations that use analog and DSE port boards, testing each 
channel to be connected to the system before assigning the channels to 
the server or another application. During this testing, you must be able to 
call each channel individually. 

! Testing the system with at least one test subscriber. 

! Performing cut-to-service procedures that provide the subscribers with 
an active coverage path.

Verify that initial switch administration and testing is complete.

Initial LAN administration

The LAN administrator must administer the corporate LAN for the messaging system. 
Some LANs might be administered prior to your arrival on site. Other LANs require that 
the administration for a new server be done at the time of installation. 

Preinstallation planning forms

Complete the planning forms in Appendix A, ��System planning forms,�� prior to 
beginning an installation. By acquiring IP addresses, server, and domain name 
information in advance, you can save hours of installation time and debugging.

Note: Avaya is not responsible for the installation, administration, or test 
of communications between customer computers and the LAN.

CAUTION: It is crucial to coordinate the IP addresses that will be used 
with the Avaya S3400-family message server with those on 
the corporate LAN. If you specify an IP address for a 
message server that conflicts with another Ethernet 
endpoint, the resulting traffic problems on the local area 
network may be extremely difficult to diagnose and solve.

!



585-310-332, Issue 3

Avaya Modular Messaging Release 1.1 Installation

1�8 December 2003

Site requirements for Avaya message servers

This section describes the physical requirements for the installation site, including 
environmental, weight, space, and power considerations for Avaya S3400-family 
message servers.

Environmental requirements

Table 1-1 lists the environmental conditions that must be maintained in the area where 
the S3400-family message server is installed and maintained.  

Weight and space considerations

Table 1-2 lists the weight, height, width, and depth of each Messaging Application 
Server (MAS) and the Message Storage Server (MSS). At least one MAS and the MSS 
message store are required for every S3400-family message server installation.  

For safety considerations, at least two technicians should be on site and available to 
mount the units.

Table 1-1. Environmental requirements

Operating state Temperature Maximum heat output Humidity (noncondensing)

Operating +10 to +35ºC 
(+50 to +95ºF)

MAS: 730 BTU/hr
MSS-S: 352 BTU/hr
MSS-H: 682 BTU/hr

20% to 80% RH

Non-operating 
(in storage or being 
shipped)

-20 to +50ºC 
(-4 to+122ºF)

N/A 20% to 90% RH

Table 1-2. Server weight and space considerations

Server Weight (full) Height Width Depth

Avaya Messaging Application Server 
(MAS)

40 lb.
(18.1 kg)
(without port boards)

6.8 in.
(17 cm)

16.9 in.
(43 cm)

18.9 in.
(48 cm)

Avaya Message Storage Server Standard 
Availability version (MSS-S) 

41 lb.
(18.6 kg)

6.8 in.
(17 cm)

16.9 in.
(43 cm)

18.9 in.
(48 cm)

Avaya Message Storage Server High 
Availability version (MSS-H)

52 lb.
(23.6 kg)

6.8 in.
(17 cm)

16.9 in.
(43 cm)

18.9 in.
(48 cm)
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Customer-provided cabinet requirements

If an S3400-family message server is to be installed in a rack-mount configuration, the 
customer-provided cabinet must meet the following requirements: 

! The cabinet must contain a 4-post rack to support the servers� weight.

! The sliding rails and extender brackets provided with each server are 
designed for mounting in cabinets 22.5 to 32 inches in depth.

! The customer-provided cabinet must be secured to the floor before 
attempting to mount any units.

! The cabinet height needs to accommodate the number of units to be 
mounted (see Table 1-2 for server height). It may also need to hold the 
MAS modems and optional equipment such as the KVM switch and UPS 
units (see Figure 2-1 on page 2-7 for an example). 

Installation area requirements

Observe the following when determining where to place the system: 

! Maintain an air-distribution system that provides adequately cooled, 
filtered and humidity-controlled air. 

! Do not install the S3400-family message server such that the ventilation 
or fan openings will be blocked.

! For T1/E1 connections, the circuits require isolation from exposed lines. 
For T1 lines, the customer must provide a CSU (T1) at the building point 
of entry. This CSU must be UL Listed and/or CSA Certified. For E1 lines, 
either the network provider or the customer must provide a CSU (E1) or 
other equivalent protection that has the product safety approvals 
required by the local jurisdictions. 

! Systems installed in Finland, Norway, Sweden and Australia must be 
installed in a restricted-access location. A restricted-access location is 
defined as an installation location where access can be gained only by 
service personnel or customers who have been instructed on the 
reasons for the restricted access and safety precautions that must be 
taken. A restricted-access location also allows access through the use of 
a tool (such as a lock and key) or other means of security.

CAUTION: To reduce the risk of fire, use only No. 26 AWG or 
larger telecommunication line cord.!

ATTENTION: Pour réduire les risques d�incendie, utiliser 
uniquement des conducteurs de 
télécommunications 26 AWG au de section 
supéleure.

!



585-310-332, Issue 3

Avaya Modular Messaging Release 1.1 Installation

1�10 December 2003

Power requirements

Table 1-3 lists the power requirements for the S3400-family servers. The AC power 
supply source needs to be a single phase 3-conductor (line, neutral, and ground), with 
a 15 A circuit breaker for 100-127 Vac installations or a 10 A circuit breaker for 200-240 
Vac installations. 

Consideration must be given to the server connection to a branch circuit with respect to 
overload or overcurrent protection. Check the system's ratings to ensure that, together 
with other equipment connected to the same branch circuit, an overcurrent or overload 
condition does not exist.

Grounding requirements

An S3400-family message server relies on the ground connection through the mains 
socket-outlet for continued safe operation. Ensure that the AC main outlet to be used to 
power the system (via the power cord or UPS) is a grounded outlet. If you are unsure of 
the ground integrity of the outlet, have a trained and certified electrician check the 
outlet. 

In addition, observe the following grounding requirements when determining where to 
place the server:

! Use only the power cord provided with each unit to connect it to the 
universal power supply (UPS) or to an AC mains outlet.

! Install the server within 6 feet (2 m) of a grounded AC mains 
socket-outlet.

! Do not use extension cords with the system.

Table 1-3. Server power requirements

Server # of power 
supply units Volts AC Hertz Amperes 

120V/240V

Avaya MAS 1 100-240 +/� 10% 50/60 +/� 3 Hz 10/5

MSS-S 1 100-240 +/� 10% 50/60 +/� 3 Hz 10/5

MSS-H 2 100-240 +/� 10% 50/60 +/� 3 Hz 6/3 for each 
supply

WARNING: The S3400-family message servers must be connected to 
an earthed mains socket-outlet. Failure to do so will result in 
allowing a hazard to be present that could cause severe 
personal injury or death.

!
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Demarcation points

This section lists the demarcation points for switches (PBXs) and LAN connectivity.

Demarcation point for switches (PBXs)

The demarcation point for switch (PBX) connections to the S3400-family message 
server is the wall field for Avaya switches. 

For non-Avaya switches, it is the end of the connector of the Avaya-provided cables for 
the port boards. Avaya service technicians dispatched for the system installation are 
not responsible for making any connections directly to switches that are not maintained 
by Avaya.

Demarcation point for LAN connectivity 

The demarcation point for the LAN connection to the S3400-family message server is 
the physical Ethernet interface on the server that connects to the corporate LAN. The 
customer is responsible for: 

! The LAN cables that connect the Avaya S3400-family message server 
to the corporate system (unless the customer uses the Avaya-provided 
cables, in which case the demarcation point is the modular connector at 
the end of the LAN cables). 

! LAN administration not performed on the S3400-family message server.

! Maintaining the TCP/IP addresses and administration on the server after 
cutover, unless otherwise specified by contract.

! Providing the IP address, subnet mask, and gateway information for 
administration on the server, as well as any DNS server IP information 
and corporate domain names.

Avaya service technicians dispatched for system installation are not responsible for 
troubleshooting the customer's LAN.

CAUTION: System grounding must comply with the general rules for 
grounding provided in article 250 of the National Electrical 
Code (NEC), National Fire Protection Agency (NFPA), or the 
applicable electrical code in the country of installation.

!

Note: Avaya recommends joint acceptance testing for systems integrated 
with switches that are not maintained by Avaya. 
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2
Installing the system hardware

This chapter describes how to install the S3400-family message server system 
hardware.   

Note: Before you can successfully complete the tasks in this section, you 
must have read Chapter 1, ��Preinstallation requirements,�� and 
verified that all preinstallation requirements have been met.

If any of the preinstallation requirements have not been met, do not 
continue with the hardware installation tasks in this chapter. 

Section Page

Overview 2-2

Unpacking the system hardware 2-3

� Required and optional hardware 2-3

� Saving the packing materials 2-5

Installing the system hardware 2-6

� Installing the UPS and optional EBMs 2-8

� Installing the S3400-family servers 2-12

� Installing the KVM switch 2-25

� Connecting the Ethernet cables 2-29

� Attaching ferrites 2-31

� Connecting the USB modem on the MAS 2-33

� Connecting the MSS RMB 2-34
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Overview

An Avaya S3400-family message server system contains two servers: a Message 
Storage Server (MSS)�either the Avaya Message Storage Server Standard 
Availability version (MSS-S)  or the Avaya Message Storage Server High Availability 
version (MSS-H)�and one or more Avaya Messaging Application Server (MAS) units. 
The servers are connected through a private Ethernet LAN to operate as a unified 
system. 

This chapter is organized as follows:

! "Unpacking the system hardware" on page 2-3

! "Installing the system hardware" on page 2-6

Because an S3400-family system installation requires many steps, make a copy of the 
checklist in Appendix B, ��Installation checklist.�� Check off items as you complete them 
to track your progress.
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Unpacking the system hardware

This section lists the required and optional hardware that is needed to successfully 
install an S3400-family message server system. 

Required and optional hardware

Table 2-1 lists the required and optional hardware needed to set up an S3400-family 
system. Verify that all the hardware components needed for this installation are on site.

Table 2-1. Required and optional hardware 

Item Quantity Required/optional

S3400-family system components:

Message Storage Server (MSS)�either the Avaya 
Message Storage Server Standard Availability version 
(MSS-S)  or the Avaya Message Storage Server High 
Availability version (MSS-H)

1 required

Avaya Messaging Application Server (MAS) 1 minimum, 
4 maximum

required

Server AC power cables 1 per Avaya MAS server,
1 per MSS-S server,
2 per MSS-H server

required

Front bezel 1 per server required

Rack-mount assembly (rails, handles, brackets, and 
connecting hardware)
and rubber spacers for stackable desktop configuration 

1 set of each per server; 
use mount type required

required

Ethernet switch (includes power transformer and rubber 
spacers)

1 required

Ethernet LAN cables 2 per server required

MSS-specific components:

COM2 port adapter to RMB cable 1 required

External modem adapter for RMB with long cable 1 required only for 
International customers

DVD backup media 1 box required

MAS-specific components:

USB modem (includes USB cable) 1 per MAS server required

Port board cables (see Table 2-2) 1 set per port board required for port boards
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Table 2-2 lists supported port boards. The appropriate cards are preinstalled in the 
Avaya MAS, but the external cabling must be connected, and the cards must be 
configured during initial administration. The cabling varies per type of card. 

Additional required documentation, particularly the configuration notes for your PBX or 
switch, must be obtained from the Avaya support web site. See "Required 
documentation" on page 1-2 for this procedure.

Other:

Monitor (includes power cord and VGA cable) 1 optional; may be 
customer-provided

Keyboard and mouse (includes cords and Y cable) 1 set optional; may be 
customer-provided

KVM switch (includes power transformer)

KVM switch cable to each server

includes 1 set of rack-mount brackets if needed for 
rack-mount setup

1 KVM switch

1 cable per server

1 set if needed

optional; other models 
of switching devices 
may be used

Uninterruptible power supply (UPS) with required power 
cord

includes 1 set of rack-mount brackets and rubber spacers 
for a stackable setup

1 � required for MSS-H; 
model may vary

� optional for MSS-S 
and Avaya MAS

Extended battery module (EBM) with required power cord

includes 1 set of rack-mount brackets and rubber spacers 
for a stackable setup

1 to 4 optional; may be 
ordered with the UPS

Table 2-1. Required and optional hardware 

Item Quantity Required/optional

Table 2-2. Supported MAS port boards 

Protocol Ports Port boards Max # Dialogic files on documentation CD

Analog 4 - 8

12 - 48

Dialogic 4-port T/R board

Dialogic 12-port T/R board

2

4

D/41JCT-LS (PDF 133K)

D/120JCT-LS (PDF 131K)

Digital Set 
Emulation

8 - 40 Dialogic D/82JCT-U

Dialogic D/82JCT-U-PCI-UNIV

5 D/82JCT-U (PDF 240K) 

D/82JCT-U PCI Univ (PDF 234K)

T1-QSIG 23 - 69 Dialogic D/480JCT-2T1 3 DualSpan JCT boards (PDF 104K)

E1-QSIG 30 - 60 Dialogic D/600JCT-2E1 2 DualSpan JCT boards (PDF 104K)
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Saving the packing materials

Save the shipping cartons and all packing materials in case any hardware needs to be 
returned to the manufacturer. If you ordered more than one Avaya MAS, saving one 
carton and one set of packing materials should be sufficient. 

Packing materials include: 

! Antistatic bags 

! Cardboard and foam inlays 

Also save the shipping cartons for all peripheral devices, such as the Ethernet switch, 
monitor, keyboard/mouse, all required modems, and the UPS and any EBMs (if used). 

Note: The packing materials may include a plastic bag designed to 
protect the system from moisture during shipment. Discard this 
bag. It is not reusable. 
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Installing the system hardware

This section covers how to install the required and optional system hardware. 
Hardware components that are optional are noted in the text. For more information 
about required and optional hardware, see Table 2-1 on page 2-3. 

The system can be installed in one or more customer-provided commercial cabinets as 
a rack-mount system, or without a commercial cabinet in a stackable desktop 
configuration. This section includes instructions on how to install both rack-mount and 
stackable desktop systems.

Only one Message Storage Server (MSS), either an MSS-S or an MSS-H, is installed 
per system. Up to four Avaya Messaging Application Server (MAS) units may be 
installed in a S3400-family system. 

Figure 2-1 on page 2-7 shows an example of an installed rack-mount system. 

Note: The sample figure shows the MSS-H and Avaya MAS servers with 
their front bezels removed.
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Figure 2-1. Example of an installed rack-mount system (front view)
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1 Customer-provided cabinet (type may vary; see physical requirements in "Installation 
area requirements" on page 1-9)

2 EBM (optional; 0 to 4 may be installed with a UPS)

3 UPS (required for MSS-H, optional for MSS-S; model may vary)

4 Required Message Storage Server (MSS), may be the MSS-H or MSS-S

5 Avaya Messaging Application Server (MAS); 1 to 4 units may be present

6 KVM switch (type may vary)

7 Ethernet switch (one is always required)

8 External modem; one is required for every Avaya MAS 
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Installing the UPS and optional EBMs

This section describes how to install an uninterruptible power system (UPS) and one or 
more optional extended battery modules (EBMs). 

! Customers may order a different model of UPS, or supply their own. See 
the documentation that came with the UPS for instructions if needed.

! If the customer did not purchase a UPS, continue with the next section, 
"Installing the S3400-family servers" on page 2-12.

The UPS is a required component for the MSS-H but is optional for the MSS-S. The 
UPS protects the system from most common power problems including power failures, 
power sags, power surges, and so on. 

The EBM is an optional component that works in conjunction with the UPS to add 
additional run time for the system. The customer has the option of adding up to four 
EBMs per UPS. For more information, see the documentation that was shipped with 
the EBM and UPS.

To install the UPS and EBMs:

! For rack-mount installations, see "Installing the UPS and any EBMs into 
a rack" on page 2-8. 

! For a stackable desktop configuration, see "Installing the UPS and any 
EBMs as a stackable configuration" on page 2-10.

Installing the UPS and any EBMs into a rack

In a rack-mount configuration, the UPS and EBMs must be positioned in the rack below 
the S3400-family servers, with the EBM units in the lowest-available position. 

To install the UPS and EBMs into a rack:

1. Gather the necessary rack-mount hardware, including the mounting 
handles, brackets, and screws. 

2. Place the UPS on a flat, stable surface with the front of the UPS facing 
toward you.
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3. Attach the mounting handle to each bracket using the supplied screws. 
See item 1 in Figure 2-2.

4. Align the mounting brackets with the screw holes on the side of the UPS 
and secure using the supplied screws. See item 2 in Figure 2-2.

5. If you are installing one or more EBMs, repeat steps 1 through 4 for each 
EBM. 

6. Place the EBM into the rack in the lowest-available position and attach 
the EBM to the rack using customer-provided screws. 

7. Place the UPS into the rack in the lowest-available position above any 
EBMs and attach the UPS to the rack using customer-provided screws.

8. Continue with the "Cabling the UPS and any EBMs" on page 2-11.

Figure 2-2. Attaching mounting handles and bracket for a rack-mount UPS

Note: The EBMs must be installed below the UPS.

Note: If additional EBMs need to be installed into the rack, install 
them above the first installed EBM.
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Installing the UPS and any EBMs as a stackable configuration

To configure the UPS and any EBMs in a stackable configuration:

1. If you are installing one or more EBMs, remove the adjacent corner 
screws from the rear panels. See Figure 2-3 for the location of these 
screws. If you do not have any EBM units, go to step 4.

2. Install the EBM brackets by aligning each bracket with the screw holes 
and secure the bracket the supplied screws as shown in Figure 2-3.

3. Repeat steps 1 and 2 for each additional EBM.

4. On the bottom unit (either the UPS, or an optional EBM), secure four 
rubber spacers to the bottom of the unit, one at each corner.

5. Set the unit on a stable platform. This unit will form the base of the 
S3400-family system configuration.

Figure 2-3. Attaching connecting brackets between a UPS and EBM (back view)
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Cabling the UPS and any EBMs

To cable the UPS and any EBM units: 

1. Connect the EBM cable to the battery connector on the UPS. See item 1 
in Figure 2-4. 

2. If you need to connect additional EBMs, plug the EBM cable of the 
second EBM into the battery connector on the first EBM. 

3. Repeat step 2 for each additional EBM. Up to four EBMs may be 
connected to the UPS. 

Figure 2-4. Connecting a UPS and an EBM (back view)
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1 UPS (model may vary; see the provided documentation for details)

2 EBM (optional; 0 to 4 may be installed)

3 EBM battery cable to UPS

4 Battery connectors for additional EBMs if needed (optional)

5 UPS power cable to a grounded AC power outlet
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Installing the S3400-family servers

This section describes each of the S3400-family servers, and how to install them in a 
customer-provided commercial cabinet or in a stackable desktop configuration. 

Identifying the server components

This section describes the key components of each of the S3400-family servers, 
including the MSS-S, MSS-H, and Avaya MAS. 

Key components of the MSS-S

Figure 2-5 shows the Avaya Message Storage Server Standard Availability version 
(MSS-S) . 

Figure 2-5. MSS-S standard configuration (front view with bezel removed)
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1 Redundant chassis fans

2 Chassis fan retaining screw

3 System reset button

4 Disk drive access indicator

5 System power indicator

6 System power on/off button

7 DVD-RAM drive

8 IDE RAID disk drive C (hdc)

9 IDE RAID disk drive A (hda)
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Figure 2-6 shows the back view of a Avaya Message Storage Server Standard 
Availability version (MSS-S) . 

Figure 2-6.  MSS-S standard configuration (back view)
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1 Power supply

2 AC power receptacle

3 Power supply on/off switch

4 Latch for top cover

5 Mouse connector

6 Keyboard connector

7 Serial port (COM1)

8 Parallel port (not used)

9 Serial port (COM2), used for the Remote Maintenance Board (RMB)

10 Corporate LAN interface

11 USB ports

12 Audio connectors (not used)

13 Video card (contains monitor connector)

14 Network interface card (used for the private LAN to the Avaya MASs)

15 Remote Maintenance Board (connects to analog line for alarm reporting and 
servicing; international versions require an external modem)
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Key components of the MSS-H

Figure 2-7 shows the Avaya Message Storage Server High Availability version 
(MSS-H). 

Figure 2-7. MSS-H high-availability configuration (front view with bezel removed)
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2 Chassis fan retaining screw

3 System power indicator

4 Disk drive access indicator showing activity on any hard disk drive

5 System reset button

6 Power supply failure indicator

7 Power supply alarm buzzer reset switch

8 Disk drive access indicator for each hard disk drive (HDD 0, 1, and 2)
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10 DVD-RAM drive

11 SCSI RAID drive 0 (HDD 0)

12 SCSI RAID drive 1 (HDD 1)

13 SCSI RAID drive 2 (HDD 2)

14 SCSI fan tray
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Figure 2-8 show the back view of a Avaya Message Storage Server High Availability 
version (MSS-H). 

Figure 2-8.  MSS-H high-availability configuration (back view)

h3vyvmhb LJK 120202

1

1

2

2

3

3

4

5

6
7

8

9

10

11

11

12

13 14 15 16

17

1 Redundant power supply

2 Power supply on/off switch 

3 AC power receptacle

4 Latch for top cover

5 Mouse connector

6 Keyboard connector

7 Serial port (COM1)

8 Parallel port (not used)

9 Serial port (COM2), used for the Remote Maintenance Board (RMB)

10 Corporate LAN interface

11 USB ports

12 Audio connectors (not used)

13 Video card (contains monitor connector)

14 Network interface card (used for the private LAN to the Avaya MASs)

15 SCSI RAID controller card

16 Remote Maintenance Board (connects to analog line for alarm reporting and 
servicing; international versions require an external modem)

17 Reset switch for faulty power supply alarm
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Key components of the MAS

Figure 2-9 shows the Avaya Messaging Application Server (MAS). You may have up to 
four Avaya MASs per S3400-family system. 

Figure 2-9. Avaya MAS (front view with bezel removed)
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Figure 2-10 shows the back view of an Avaya Messaging Application Server (MAS). 

Figure 2-10.  Avaya MAS (back view)
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13 Video card (contains monitor connector)

14 Network interface card (used for the private LAN to the MSS)

15 Port boards (type varies from machine to machine). Up to five port boards can be 
installed in each MAS (depending on the type of board and traffic requirements), 
typically starting from the end of the cabinet. Port boards are not present for IP 
H.323 integrations. See Table 2-2 on page 2-4 for details. 
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Attaching the front bezel

The front bezel must be attached to each S3400-family server as described. 

1. Insert the bottom of the front bezel into the chassis. See item 1 in Figure 
2-11.

2. Push the bezel upright until the two upper tabs snap into place under the 
top cover. 

Installing the S3400-family servers in a rack-mount or stackable setup

The S3400-family servers can be installed either in a commercial cabinet in a 
rack-mount configuration, or stacked on top of one another in a desktop configuration. 
Continue with the appropriate section based on the installation method to be used at 
your site: 

! "Installing the servers in a rack-mount configuration" on page 2-19

! "Installing the servers in a stackable desktop configuration" on page 
2-21

Figure 2-11. Attaching the front bezel
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CAUTION: The S3400-family servers are heavy. Get another 
person to assist you with lifting and placing the 
server units.

!
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Installing the servers in a rack-mount configuration

The task describes how to install an MSS-S or MSS-H and one or more Avaya MASs in 
a commercial cabinet. This is also called a rack-mount configuration.  

Before you begin to install the servers into the rack, verify that the necessary 
rack-mount hardware is on site. Required equipment is summarized in Table 2-3.

To install a server into a rack:

1. Gather the necessary rack-mount hardware as listed in Table 2-3. 

2. Place the server on a flat, stable surface.

3. If the mounting handles are not already attached, attach them now:

a. Connect the handles to the bracket using the supplied flat-head screws. 
See item 1 in Figure 2-12 on page 2-20.

b. Align the mounting bracket with the screw holes on the side of the server 
and secure using the supplied flat-head screws. See item 2 in Figure 2-12.

4. Attach the rack-mount rails to the server as follows:

a. Remove the two screws and retaining bar on the rail slide just before the 
server-retaining latch. Set them aside for later. See item 3 in Figure 2-12.

Note: The MSS-S or MSS-H is typically installed directly above the UPS. 
If the customer did not purchase a UPS, install the MSS-S or 
MSS-H in the lowest available position in the cabinet. The first 
Avaya MAS is typically installed directly above the MSS. 

If the customer purchased more than one MAS, you typically install 
each additional MAS above the first MAS. However, all the servers 
in an S3400-family system do not have to be in the same cabinet.

Table 2-3. Required rack-mount hardware

Part Quantity

Extension bracket (two different lengths may be shipped) 2 per server

Right-side rack-mount rails and slides 1 set per sever

Left-side rack-mount rails and slides 1 set per sever

Front panel handle set (handles and mounting brackets; these 
may already be assembled on some units)

1 set per server

Miscellaneous screws and mounting hardware 1 set per server

Customer-provided: Mounting hardware to secure the extension 
bracket and rack-mount slide to the customer-provided rack.

1 set per rack-mount rail 
and extension bracket
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b. Disassemble the slide (necessary to access all three screw holes).

c. Place the flat piece of the rail slide against the server and secure it with the 
three supplied flat-head screws. See item 4 in Figure 2-12.  

5. Position the extension bracket on end of the rail slide to provide the 
depth needed for the server to fit in the rack. A couple of extension 
brackets may be shipped; choose the correct length for your cabinet. 
See item 5 in Figure 2-12.

6. Attach the extension bracket to the rear of the rail slide using the 
supplied screws and retaining bar (2 pan-head screws per bracket). See 
item 6 in Figure 2-12.

7. Connect the extension bracket and rail slide to the customer-provided 
four-post rack using the correct customer-provided hardware for that 
model of cabinet. See item 7 in Figure 2-12.

8. Fully extend the rail slides to the locked-out position.

9. With another technician supporting the unit, align the front of the rail 
slide with the rack-mount rail that is attached to the server.

10. Push the unit onto the rail slide far enough so that the safety catch 
engages.

11. Slide the server completely into the rack. Ensure that the server moves 
smoothly in an out of the rack.

Note: The rack-mount rails are labeled L for left and R for right. Verify 
that you are installing each rail on the correct side.

Figure 2-12. Attaching server mounting handles, bracket, and rack-mount rail assembly
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12. Reattach the two screws and retaining bar on the rail slide just before 
the server-retaining latch (item 3 in Figure 2-12, from step 4a).

13. Repeat steps 2 through 10 for each server that needs to be installed.

14. When all servers are mounted, continue with "Connecting the 
S3400-family power cables" on page 2-22.

Installing the servers in a stackable desktop configuration

If the system is to be installed in a stackable desktop configuration, you must install 
four rubber spacers on the bottom on each of the servers. This allows you to stack the 
servers on top of one another.

See Figure 2-13 for a sample configuration. 

CAUTION: For safety, do not stack more than two servers atop one 
another; use multiple stacks if needed. If you have a UPS 
and an EBM, stack only one server on top of them.

!

Figure 2-13. Installing rubber spacers for a stackable desktop configuration
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To install the servers in a stackable desktop configuration:

1. Gather the rubber spacers shipped with each server.

2. Attach the rubber spacers to the bottom of each of the servers, one at 
each corner. See Figure 2-13 on page 2-21 for an example.

3. Position the UPS (if present), or the MSS (if no UPS is present) in an 
appropriate location. See "Site requirements for Avaya message 
servers" on page 1-8 for details. 

4. Place the MSS-S or MSS-H on top of the UPS (if present). 

5. Place the first (required) Avaya MAS on top of the MSS. 

6. If the customer purchased additional Avaya MASs, create a second 
stack, placing each additional MAS on top of the last one.

Connecting the S3400-family power cables

See the figures in "Installing the S3400-family servers" on page 2-12 if you need help 
locating the power connections on the back of the servers. 

To connect the power cables:

1. Connect the female end of the power cable for the MSS to the male 
power connector located on the back of the MSS-S or MSS-H.

2. Connect the male end of the MSS power cable to an AC receptacle 
located on the back of the UPS (if present), or to an appropriate AC 
power outlet. See Figure 2-14 for an example.

3. For an MSS-H: repeat steps 1 and 2 for the second MSS-H power 
supply.

4. Connect the female end of the MAS power cable to the male power 
connector on the back of the Avaya MAS.

5. Connect the male end of the MAS power cable to AC receptacle on the 
back of the UPS (if present), or to an appropriate AC power outlet.

6. If you have more than one MAS: repeat steps 4 and 5 for each MAS.

7. If the customer is using a UPS, connect the UPS power cable into an 
appropriate AC power outlet.
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Figure 2-14. Attaching power cables to a UPS (sample configuration)
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1 UPS (model may vary; see the provided documentation for details)

2 EBM (optional; 0 to 4 may be installed)

3 UPS power cable to a grounded AC power outlet

4 AC power cable to required MSS

5 AC power cable to required MAS

6 AC power cable for redundant power supply on MSS-H (if an MSS-H is 
installed) or for an additional Avaya MAS (up to 4 may be installed)

7 AC-to-DC transformer for Ethernet switch

8 Additional AC sockets; use as needed for external modems, the KVM switch 
and monitor (if desired), or any additional MASs



585-310-332, Issue 3

Avaya Modular Messaging Release 1.1 Installation

2�24 December 2003

Connecting the MAS port boards

An Avaya MAS may have up to five port boards installed. See Table 2-2 on page 2-4 for 
a list of supported Dialogic port boards and their associated documentation. PDF files of 
the Dialogic installation guides are on the documentation media shipped with the 
system.  

Connect the cables supplied with your voice port board to the switch as follows:

1. Identify the type of port boards installed in your MAS.  

2. Connect each port on the port boards to the switch (PBX) as required:

! For analog boards: 

a. Connect each port on the installed analog boards to one end of a standard 
RJ-11 tip/ring cord (individual tip/ring cables and a 12-port harmonica may 
also be used). Note which cables connect to which ports.

b. The other end of the cable should be connected to an analog line on the 
corporate switching system. The entity responsible for maintaining the 
corporate switch should make this connection (see the customer contract or 
the statement of work).

! For set emulation boards: 

a. Connect each port on the Dialogic set emulation board using the D/82U 
cable (Intel part number 86-0155-001).

b. The other end of the cable should be connected to a 4-wire punch-down 
block on the corporate switching system.The entity responsible for 
maintaining the corporate switch should make this connection (see the 
customer contract or the statement of work). 

! For T1- or E1-QSIG boards: 

a. Connect each port on the Dialogic T1-QSIG or E1-QSIG board using the 
provided RJ-48C (Ethernet) cable.

b. The other end of the cable should be connected through a patch panel to a 
4-wire punch-down block on the corporate switching system.The entity 
responsible for maintaining the corporate switch should make this 
connection (see the customer contract or the statement of work). 

Note: If this MAS uses an IP H.323 integration, no port boards are 
present. Continue with "Installing the KVM switch" on page 
2-25. 

Note: Check the numbering on the board�s faceplate to make sure 
that you are connecting the correct cord to the correct port. 
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Installing the KVM switch

A keyboard, video, and mouse (KVM) switch is currently required for all S3400-family 
systems. However, the model of KVM switch and the specific monitor, keyboard, and 
mouse used may vary from site to site (for example, a flat-panel monitor setup may be 
used instead). See Figure 2-1 on page 2-7 for a sample installation. 

To install the Belkin OmniView Pro2 Series KVM switch:

! For rack-mount installations, see Installing the KVM switch in a 
rack-mount configuration. 

! For a stackable desktop configuration, see "Installing the KVM switch in 
a stackable configuration" on page 2-26.

Installing the KVM switch in a rack-mount configuration

To install the Belkin OmniView Pro2 Series KVM switch in a commercial cabinet:

1. Gather the necessary rack-mount hardware, including the adjustable 
mounting brackets and screws. 

2. Select a bracket-hole scheme to determine how far the KVM switch 
should protrude from the rack. 

3. Install the two rack-mount brackets on the KVM switch using the 
provided screws. See Figure 2-15.

4. Install the KVM switch into the rack above the last installed MAS.

5. Continue with "Connecting the KVM cables" on page 2-26.

Figure 2-15. Attaching mounting brackets for a rack-mount KVM
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Installing the KVM switch in a stackable configuration

To install the Belkin OmniView Pro2 Series KVM switch in a stackable desktop 
configuration: 

1. Place the KVM switch on top of the uppermost MAS. Rubber spacers 
are already in place. 

2. Continue with connecting the KVM cables.

Connecting the KVM cables

The Belkin OmniView Pro2 Series KVM switch must be connected to the keyboard, 
monitor, and mouse, and then to the MSS and MAS units, as described in this section. 

Connecting the KVM switch to the keyboard, monitor, and mouse

The KVM switch setup for the keyboard, monitor, and mouse may vary from site to site, 
depending on the equipment and cabling used. This section provides instructions for a 
Belkin OmniView Pro2 Series KVM switch setup. 

To connect the KVM switch to the keyboard, monitor, and mouse:

1. If a new monitor or keyboard/mouse was ordered for this system, 
unpack them now. Otherwise, continue with step 2. 

a. Set up the monitor in the desired location.

b. Connect the keyboard/mouse to the monitor.

c. Plug the female end of the monitor�s power cable into the monitor.

d. Plug the male end of the monitor�s power cable into a free UPS receptacle 
(if available) or into a grounded AC outlet.

2. Connect the VGA cable from the monitor to the female port on the back 
of the KVM switch labeled �Console VGA.� See item 1 in Figure 2-16 on 
page 2-27.

3. Tighten the thumbscrews on the video cable connector with your fingers 
or with a small flatblade screwdriver.

4. Connect the PS/2 cables for the mouse and keyboard to their 
corresponding connectors on the back of the KVM switch in the 
�Console� section using the Y cable. See item 2 in Figure 2-16.

The mouse connector is color-coded green, and the keyboard connector 
is color-coded purple. 

Note: If a new monitor was not purchased with the system, any 15" or 
greater monitor can be used.
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5. Attach the KVM power cable to the DC power jack labeled �DC 12V, 1A� 
on the rear of the KVM switch. 

6. Connect the other end of the KVM power cable (the AC-to-DC 
transformer) to a receptacle located on the back of the UPS (if present) 
or to an appropriate power outlet.

Figure 2-16. Connecting a Belkin OmniView Pro2 Series KVM switch (rear view)
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1 VGA cord from monitor to Console VGA port on KVM switch

2 Y cable to combination keyboard/mouse (setup may vary)

3 DC power jack for transformer cable

4 KVM switch video/keyboard/mouse cable to each server unit

5 VGA connector on the MSS or MAS (in the AGP slot)

6 Keyboard and mouse connectors on the MSS or MAS 

7 Belkin OmniView Pro2 Series KVM switch; typically the MSS-H or MSS-S is 
connected to the first computer port VGA 01 as shown; Avaya MASs are connected in 
the subsequent port positions beginning with VGA 02
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When power is connected, the LED for port 01 begins flashing.

7. Push the direct-access port selectors for ports 01 through 08 in order. 
The corresponding LED should flash as each button is pressed, 
indicating that the port is ready for the server connection. 

Connecting the KVM switch to the S3400-family servers

To connect the KVM switch to the installed MSS and MAS units: 

1. Using the provided KVM cable, plug the male VGA connector into the 
VGA port on the MSS. See Figure 2-16 on page 2-27.

2. Connect the PS/2 keyboard and mouse connectors of the KVM cable to 
the keyboard and mouse ports on the back of the MSS.  

3. Connect the other end of the KVM cable to the port on the back of the 
KVM switch labeled VGA 01.

4. Connect the ends of the cables to the keyboard and mouse ports located 
directly underneath the VGA 01 port.

5. Using the second provided KVM switch cable, plug the male VGA 
connector into the VGA port on the first MAS. 

6. Connect the PS/2 keyboard and mouse connectors of the KVM cable to 
the keyboard and mouse ports on the Avaya MAS.

7. Connect the other end of the KVM cable to the port on the back of the 
KVM switch labeled VGA 02.

8. Connect the ends of the cables to the keyboard and mouse ports located 
directly underneath the VGA 02 port.

9. Repeat steps 5 through 8 for each additional MAS, connecting to port 
VGA 03, VGA 04 and so on, as needed.

Note: The mouse connector is color-coded green, and the keyboard 
connector is color-coded purple.
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Connecting the Ethernet cables

A pair of standard Ethernet cables is shipped with every S3400-family server. Use 
these cables to make the two required LAN connections: one to a private LAN through 
an Ethernet switch, and one to the corporate LAN. Both of these connections are 
covered in this section. 

Connecting the S3400-family servers to the private LAN

The private LAN allows the MSS and the Avaya MASs to communicate. 

To connect the S3400-family servers to the private LAN:

1. Unpack the Ethernet switch. This section assumes you are using a 
3COM Office Connect Dual Speed Switch 8 Plus model.

2. Attach the rubber spacers to the four marked areas in each corner on 
the bottom of the Ethernet switch. See Figure 2-17 on page 2-30. 

3. Place the Ethernet switch on top of the KVM switch.

4. A suitable power cord and transformer for your region should have been 
shipped with your Ethernet switch. 

a. Peel back the label, then insert the end of the Ethernet switch power cable 
into the DC power connector on the back of the switch.

b. Connect the other end of the AC-to-DC transformer to the back of the UPS 
(if present) or to an appropriate AC power outlet.

5. Connect the private LAN cables for each of the S3400-family servers. 
See Figure 2-17 for an example.

! MSS-S or MSS-H: Connect the provided Ethernet cable between 
the RJ45 jack on the NIC and the first Ethernet interface on the 
back of the switch, labeled 1.

! Avaya MAS: Connect the provided Ethernet cable between the 
RJ45 jack on the NIC and the second Ethernet interface on the 
back of the switch, labeled 2.

! Additional MASs (if present): Connect the provided Ethernet cable 
between the RJ45 jack on the NIC in each unit with the next 
Ethernet available interface on the back of the switch, labeled 3, 
4, and so on. 

CAUTION: Do not connect the private LAN switch to the corporate LAN.!
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Figure 2-17. Connecting the MSS and MAS servers to an Ethernet switch (rear view)
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1 Ethernet switch

2 Rubber spacers

3 DC power jack

4 Ethernet interface to private LAN on MSS (typically Ethernet switch port 1)

5 Private LAN interface on MSS (NIC card in the first PCI slot)

6 Ethernet interface to corporate LAN on MSS 

7 Ethernet interface to private LAN on first Avaya MAS (typically Ethernet switch port 
2); subsequent MASs would use ports 3, 4, and so on
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Connecting the S3400-family servers to the corporate LAN

To connect each MSS and MAS to the corporate LAN: 

1. Connect one end of the standard Ethernet cable (provided with the 
server) to the RJ45 connector on the back of the server. See Figure 2-17 
on page 2-30.  

2. The other end of this cable should be connected to an Ethernet interface 
on the corporate LAN. The entity that is responsible for maintaining the 
corporate LAN should make this connection (see the customer contract 
or the statement of work).

3. Repeat steps 1 and 2 for each S3400-family server in your configuration.

Attaching ferrites

Ferrites must be attached to the S3400-family system video cable and to each T1- or 
E1-QSIG port board cable (if this type of board is present on the MAS) to meet 
electromagnetic conductance (EMC) regulations. The optional flat-panel monitor with 
an integrated KVM switch also requires ferrites. 

To install a ferrite on a cable: 

1. For all systems: Locate the video connector in the first slot on the back 
of the S3400-family system unit.

2. Open the ferrite by gently pulling the fastener away from the body of the 
ferrite. See Figure 2-18 on page 2-32.

8 Private LAN interface on Avaya MAS (NIC card in second PCI slot)

9 Ethernet interface to corporate LAN on MAS 

Note: Make sure that you connect the Ethernet cable for the 
corporate LAN to the Ethernet interface on the back of the 
server. The Ethernet interface on the NIC in the PCI slot is 
used for the private LAN.

CAUTION: Handle all ferrites with care. They are easily broken. Do not 
use any that are broken or fractured. Damaged ferrites are 
no longer effective for EMC control.

!
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3. Place the cable cord in the groove inside the ferrite, then gently snap the 
ferrite shut.  

4. Attach a large cable tie directly behind the ferrite to secure it. Trim the 
cable tie. 

5. For systems that use a T1- or E1-QSIG port board: Repeat steps 2 
through 4 to attach a ferrite to each QSIG port board cable.

6. For systems that use a flat-panel monitor: Repeat steps 2 through 4 to 
attach a ferrite to the mouse and keyboard cables at each server. One 
ferrite can be used for both cables.

Note: Place ferrites as close as possible to the chassis to minimize 
the amount of cable between the ferrites and the chassis.

Figure 2-18. Attaching a ferrite to a cable
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Connecting the USB modem on the MAS

A USB modem is required for every Avaya MAS. The type of modem you have may 
vary depending on your location. See the documentation included with your modem if 
you have questions about modem installation, setup, or operation. 

This section describes a MultiTech USB modem setup. See Figure 2-19 for an 
example.

To connect a USB modem:

1. Attach the rubber spacers to the four marked areas in each corner on 
the bottom of the modem (if spacers are not already in place).

2. Place the USB modem on top of the KVM switch or in a secure location 
as required. 

3. Connect one end of the USB cable to the back of the USB modem.

Figure 2-19. Connecting a USB modem to an Avaya MAS server (rear view)
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4. Connect the other end of the USB cable to the back of the Avaya MAS. 
USB port A is recommended as shown in Figure 2-19 on page 2-33. 

5. Connect the RJ-11 cable to the LINE connector on the modem.

6. The other end of the cable should be connected to an analog line on the 
corporate switching system. The entity responsible for maintaining the 
corporate switch should make this connection (see the customer 
contract or the statement of work).

7. Repeat steps 1 through 6 for every Avaya MAS modem.

Connecting the MSS RMB 

A Remote Maintenance Board (RMB) is installed in every MSS-S or MSS-H. This 
board sends system alarms to a remote maintenance center, and allows Services 
personnel to dial in to repair or update the S3400-family system. 

The RMB setup varies depending on your location: 

! A domestic (United States) setup uses an on-board modem. See Figure 
2-20 on page 2-35.

! An international setup uses an external modem that meets the operating 
requirements for that region. See Figure 2-21 on page 2-36 for a sample 
setup.  

To install the RMB:

1. Connect the adapter end of the RMB-to-COM2 cable to the COM2 serial 
port on the back of the MSS. Tighten the thumbscrews on the adapter. 

2. Attach the other end of the cable to the lower RJ45 jack on the RMB 
faceplate. Make sure the jack snaps securely in place.

3. Make the appropriate connections based on the type of RMB installed: 
either an on-board model or an external modem.

Note: The type of external modem used with the RMB varies 
depending on geographical location. See the documentation 
included with your modem if you have questions about modem 
installation, setup, or operation.
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! On-board modem (United States): Connect a standard modular 
telephone cord to the RJ11 jack near the top of the RMB faceplate. 
See Figure 2-20. 

! External modem (international): Connect the RMB as described. See 
your modem documentation for details if needed:

(1) Connect the modular end of the RMB-to-modem adapter cable to 
the upper modular jack on the RMB. See Figure 2-21 on page 
2-36.

(2) Plug the adapter end of the cable into the external modem�s 
RS-232 connector. Tighten the thumbscrews on the adapter. 

(3) Connect the required telephone cord to the external modem.

Figure 2-20. Connecting an RMB with an on-board modem (rear view)
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2 RMB-to-COM2 serial port adapter cable

3 RMB faceplate

4 Telephone cord to tip/ring connection on the corporate switch



585-310-332, Issue 3

Avaya Modular Messaging Release 1.1 Installation

2�36 December 2003

4. The other end of the telephone cord should be connected to an analog 
line on the corporate switching system. The entity responsible for 
maintaining the corporate switch should make this connection (see the 
customer contract or the statement of work).

Figure 2-21. Connecting an RMB with an external modem (rear view)
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1 MSS-H (for example purposes only; this could also be an MSS-S)

2 RMB-to-COM2 serial port adapter cable

3 RMB faceplate

4 RMB-to-modem�s RS-232 port adapter cable

5 External modem (model varies per region) 

6 Telephone cord to tip/ring connection on the corporate switch
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3
Powering up the system and

performing initial MSS
administration

This chapter describes how to power up the S3400-family message server system and 
perform initial administration on the Message Storage Server (MSS).  

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the tasks in Chapter 2, 
��Installing the system hardware.�� 

Section Page

Powering up the S3400-family system 3-2

Logging in to the MSS server 3-3

Setting up the monitor 3-4

Setting the time and date 3-5

Setting up network addressing 3-6
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� Accessing the messaging administration screens 3-10

� Setting up the MSS host machine profile 3-11

� Setting up the trusted servers 3-13

Rebooting the MSS 3-17
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Powering up the S3400-family system

This task assumes that you have already assembled and correctly connected all 
required hardware components. 

To power up the S3400-family message server system:

1. Verify that the power cables for the S3400-family servers and all 
peripheral devices are connected to the UPS or an appropriate AC 
power outlet. See Figure 2-14 on page 2-23 for an example. 
Connections include:

! UPS (if present): connected to an appropriate AC power outlet.

! MSS and any MAS units: each connected to the UPS (if present), or 
to an appropriate AC power outlet.

! KVM switch and monitor: optionally connected to the UPS (if 
present), or to an appropriate AC power outlet.

! Ethernet switch: connected to the UPS (if present), or to an 
appropriate AC power outlet.

! External modems: if a power cord is required, it may be connected to 
the UPS (if present), or to an appropriate AC power outlet.

2. If a UPS is present: Press the On button on the front of the UPS. The 
appropriate lamps should light (see your UPS documentation). 

3. Press the monitor�s power button.

The power lamp on the monitor should light.

4. If an external modem is present, press the On button if needed. The 
appropriate lamps should light (see your modem documentation for 
details). 

5. Verify that the power lamps for the Ethernet switch and KVM switch are 
lit (these units do not have on/off buttons).

6. Power up the Message Storage Server (MSS) first. 

a. Toggle the power switch at the rear of the unit to on (| is on, 0 is off).

b. Press the power button on the front of the unit.

The LEDs on the front of the unit will flash once, then the LEDs will 
light to indicate system power and drive activity.

Note: Always power up the UPS first, if a UPS is installed.
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c. Wait up to 1 minute for the display to appear on the monitor.

7. Power up the MAS units next, using the same procedures as in step 6. 

! See the figures in ��Installing the S3400-family servers�� on page 2-12 
to locate the power switch or power button on each server.

! The power lamp on the front of each server should light when the unit 
is powered on.

Do nothing further with the MAS at this time. 

Logging in to the MSS server

When the S3400-family system is powered up, you must first log in to the Message 
Storage Server (MSS). Because the system is not yet administered, you can only 
access the MSS from the console (monitor) directly connected to the KVM switch. 

To log in to the MSS from the console:

1. The KVM switch should be connected to the MSS through the first 
computer port (VGA 01). Verify that the monitor is showing the MSS.

! For a Belkin OmniView Pro2 KVM: To have the monitor show a 
different server, press slowly in sequence Scroll Lock, then Scroll 
Lock, then the up (or down) arrow key to change to the server 
connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the up 
or down arrow key (such as 02 for port 2). See your KVM switch 
documentation for complete user instructions. 

! If the monitor is not showing the correct server boot procedure, see 
��Connecting the KVM cables�� on page 2-26 and verify the cable 
connections. To correct cabling problems, power down the system, 
correct the cabling, then power up the system again. 

2. As the MSS boots up, a splash screen appears. 

Optional: To bypass this screen and speed up the initial boot procedure:

a. Press Esc to clear the splash screen.

b. Press the space bar to bypass the memory check.

Note: You may need to reload the operating system software if new 
software was shipped with the system. In this case, continue 
with Appendix D, ��Reloading the software on an MSS.��
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3. When the boot completes and you see the message 
�Press Enter to return to prompt...�, press Enter. 

4. At the localhost login prompt, log in to the MSS server as craft using 
the default password.

5. The Netscape license agreement screen appears the first time you log 
in. Click Accept to continue.

The server displays the Messaging Administration main menu. 

Setting up the monitor

Check the display quality of the screen. 

! If the display quality is poor enough that it is difficult to do initial 
administration, try to correct it using the steps in this section. 

! If the monitor displays system information well enough to do initial 
administration, continue with ��Setting the time and date�� on page 3-5.

To adjust the monitor display:

1. Click Log Off. 

If the display is so poor that you cannot see the mouse pointer well 
enough to exit or log off, you can exit by simultaneously pressing 
CTRL+ALT+BACKSPACE. 

2. Log in at the console as monitor with the password of monitor. 

The server displays the Monitor setup screen.

3. Attempt to find the brand name of the monitor to be used. Use the down 
arrow or PageDown keys to scroll through the list of many available 
monitors, or try typing the first letter of the brand name. 

4. Highlight the name of the monitor that most closely matches the model 
you are using.

5. Tab to Set and press Enter. 

The monitor screen flashes during testing and adjusting, then the cursor 
returns to the localhost login prompt. 

6. Log in to the system as craft and see if the display has improved. 

7. If the display is still poor, relogin as monitor and select one of the 
Generic monitor settings. 
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8. If there is still no improvement, the customer must supply a different 
monitor.

Setting the time and date

The first time you log in to a new MSS, you need to set the time and date. 

! If you reinstalled the operating system from a CD, you already set the 
time and date. Continue with ��Setting up network addressing�� on page 
3-6.

! If you have not yet set the time and date, do the following procedure.

Set the time of day, date, and time zone as follows:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
Date and Time Administration 

The server displays the Linux Date and Time screen.

2. For Date, select the month and day. Type the current year (such as 
2003).

3. For AM/PM, select the type of time you are using (AM, PM, or 24-hour 
clock).

4. For Time, select the hours and minutes.

5. For Time Zone, select your current time zone.

6. When finished, click Save.

The new settings are saved, and you are prompted to log off. 

7. Click Log Off.

8. Log in as craft using the default password.

Note: If you did not make any changes to this screen (the time and 
date were already correct), you are not prompted to log off. 
Continue with ��Setting up network addressing�� on page 3-6.
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Setting up network addressing

You need to set up the MSS to work correctly on the corporate local area network 
(LAN) and the private LAN to any Avaya MAS units. 

To set up the MSS to work correctly on the private and corporate LANs:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
TCP/IP Administration 

Network Addressing

The server displays the Network Addressing screen. See Figure 3-1 for 
an example of a completed Network Addressing screen.

CAUTION: Use the S3400-family system planning form in Appendix A, 
��System planning forms,�� to enter the correct values.!

Figure 3-1. Network Addressing screen, sample Ethernet 0 interface
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Complete the Networking Addressing screen using the information from 
the S3400-family system planning form on page A-6. Click the Help 
button or field name for additional information about each field.  

2. For Host Name, enter the MSS NetBIOS machine name (such as 
zigzag). See item 1 on the S3400-family system planning form on page 
A-6.  

3. For Default Gateway Address, enter the corporate default gateway IP 
address for the MSS. This is item 10 on your planning form.

4. To administer the corporate LAN settings, verify that the TCP/IP 
Interface is set to eth0. 

! For Primary Name + Domain, enter the MSS corporate FQDN for 
Eth0 (such as zigzag.loc.avaya.com). See item 7 on your planning 
form.

! For IP Address, enter the MSS corporate IP address for Eth0 (see 
item 8 on your planning form).

! For Subnet Mask, enter the MSS corporate subnet mask for Eth0 
(such as 255.255.255.0). See item 9 on your planning form.

! For Network Media Type, select the correct type (usually Auto_
Detect).

The following fields must be filled in if a corporate DNS is used:

! Set Enable DNS to Yes if a corporate DNS is used (if this screen has 
a pushbutton, click the button so that it is dark).

! For Domain Name, enter the corporate domain name (see item 6 on 
your planning form).

Note: The format of the Network Addressing screen varies 
depending on how it is accessed. For example, at the console 
interface, the Enable DNS field shows a diamond instead of a 
radio button. To enable DNS, verify that the Yes diamond is 
pushed in (looks gray or shaded).

Note: The first letter may not appear when you type the new name. 
Complete this procedure, then verify the name in step 8.

CAUTION: Use the information from the S3400-family system planning 
form on page A-6 for these fields. Do not use the examples 
shown.

!
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! For Name Server, add any IP addresses listed for MSS corporate 
DNS servers IP addresses (see item 11 on your planning form). 
Press Enter after each IP address.

! For Search Order, always enter the domain shown in the Domain 
Name field first. Press Enter. 

Add any other domain names listed for the MSS Search order of 
DNS domains, pressing Enter after each domain name (see item 12 
on your planning form).

5. Click Save.

6. You always see a message to logoff and restart the browser when you 
change the host name. Click OK. 

7. If you see a confirmation message, click Continue Submission to 
proceed.  

8. After the request processes, follow the instructions on the screen. For 
example, you may be advised to wait 1 minute before logging back in.

! Click Logoff to log off now. 

! If you wait, the server logs you off automatically.

The system then displays the following prompt:

hostname login:

9. Verify that hostname in the login prompt is the same name you entered 
in step 2. If not, you have to re-enter it in step 12, and log in again. 

10. Log back in to the MSS server as craft using the appropriate password.

The system displays the Messaging Administration main menu. 

11. Access the Network Addressing screen again. Click the links for:

Basic System Administration
TCP/IP Administration 

Network Addressing

12. Verify the private LAN settings as follows. See Figure 3-2 on page 3-9 
for an example. 

! Select TCP/IP Interface eth1.

Note: You can deselect the �Show this alert next time� option in the 
message box (click the button so it is light in color) to prevent 
the confirmation message from appearing again. This message 
will not be noted again in these instructions.



December 2003

Powering up the system and performing initial MSS administration

3�9585-310-332, Issue 3

! For Primary Name + Domain, use the predefined MSS default 
private system name: mss1 (see item 13 on the S3400-family 
system planning form on page A-6).

! For IP Address, use the MSS private IP address for Eth1 (should be 
192.168.1.1, as shown in item 14 on your planning form). 

! For Subnet Mask, use the MSS private subnet mask for Eth1 
(should be 255.255.255.0, as shown in item 15 on the planning form). 

! For Network Media Type, verify that the correct type is selected 
(usually Auto_Detect).

13. If you made any adjustments, click Save.

14. Click Return to Main.

Figure 3-2. Network Addressing screen, sample Ethernet 1 interface
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Administering the message core

Use the tasks in this section to set up basic messaging functions on the MSS. Message 
core administration is done through a command prompt screen. The tasks in this 
section must be completed in the order presented. 

Accessing the messaging administration screens

To access the screens used to administer the message core:

1. Starting from the Messaging Administration main menu, select:

Global Administration
Messaging Administration 

The system displays the administration command prompt screen and 
and the SSH dialog box, which provides protection for this screen. You 
must re-enter your password for security reasons.

2. Verify your login and type the password. Press Enter or click Login. 

3. If you are prompted for a terminal type, use vt100.  

Note: The administration command prompt screen function keys do not 
always work from all terminal emulators. If the function keys are not 
working in your terminal emulator, try using the key sequences 
associated with each of the function keys as shown in Table 3-1. 

Table 3-1. Function key sequences

Function Key sequence Function key

Cancel  Ctrl+X F1

Refresh Ctrl+L F2

Enter Ctrl+E F3

Clear Field (ClrFld) Ctrl+K F4

Help Ctrl+W F5

Choices Ctrl+C F6

Next Page (NextPg) Ctrl+N F7

Previous Page (PrevPg) Ctrl+P F8 

Back space Ctrl+H �
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Setting up the MSS host machine profile

Set up a machine profile for the MSS. Use your planning forms to complete these fields 
as directed. 

To set up a machine profile for this MSS:

1. At the administration command prompt, type change machine (or its 
abbreviation ch m) and press Enter.

The system displays the Machine Profile screen. See Figure 3-3 for a 
completed example. 

Next Field Ctrl+M �

Break out of the webadmin interface 
and return to the Linux prompt

Ctrl+Alt+ 
Backspace

�

Table 3-1. Function key sequences

Function Key sequence Function key

Figure 3-3.  Machine Profile screen example
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2. Tab through the form to update the fields in the Machine Profile screen 
using the planning forms as shown in Table 3-2. 

3. When finished, press F7 (Next Page).

The server displays the Machine Profile screen, page 2.

4. Type a password to be used for SMTP networking with other messaging 
machines. This password will be known to other machines to allow them 
to communicate. See Required switch and messaging information on 
page A-12.

! Do not change any other fields on this screen. Leave Updates In and 
Out set to n.

! When finished, press F3 (Enter).

5. Check the status line to verify that the command completed successfully.

Table 3-2. Machine Profile screen settings

Field Setting

Machine Name Change from �local� to the MSS host name (see item 1 on the 
S3400-family system planning form on page A-6).

Machine Type tcpip [display-only field]

Location local [display-only field]

Mailbox # Length 3 through 10 (see Required switch and messaging 
information on page A-12 for mailbox extension length) 

Default Community 1

Start Num. Enter the appropriate starting mailbox extension number for 
this dial plan�s address range. For example, for a five-digit dial 
plan, you might enter 00000 (see Required switch and 
messaging information on page A-12 for extension ranges).

End Num. Enter the appropriate ending mailbox extension number for 
this dial plan�s address range. For example, for a five-digit dial 
plan, you might enter 99999.
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Setting up the trusted servers

You must add a trusted server for every Avaya MAS and set up other required servers 
that will be in this messaging domain. Use your planning forms as directed to enter the 
correct values to set up the required trusted servers. 

Add all MASs:

1. At the command prompt, type the following command (or use its 
abbreviation). You must type the MAS host name in all-capital letters as 
shown. For example, type add tru ZIPPY me and press Enter. 

add trusted-server MASNAME messaging-application-server 

The Trusted-Server Profile screen appears. The me suffix in the 
command prepopulates most of the fields as shown in Figure 3-4. 

Note: The MAS NetBIOS or host name must be in all-capital letters.

Figure 3-4.  Add MAS trusted server screen example
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2. Tab through the form to update the password and IP address fields using 
the planning forms as shown in Table 3-3. 

3. When finished, press F3 (Enter).

The Trusted Server ID field is populated automatically.

4. If you are installing more than one MAS: Repeat steps 1 through 3 for 
every Avaya MAS in the system. Use the names, passwords, and IP 
addresses from the S3400-family system planning form on page A-6.

Add the MWI server (if used):

5. If the Message Waiting Indicator (MWI) Server is to be installed on any 
MAS, add a trusted server for it now. At the command prompt, type the 
following and press Enter: 

add tru VVSTS mw 

(Note that the server name has two Vs, as in V-V-S-T-S.)

The Trusted-Server Profile screen appears. The mw suffix in the 
command (for mwi-server) prepopulates most of the fields as shown in 
Figure 3-5 on page 3-15. 

Table 3-3. Trusted Server Profile screen host settings

Field Setting

Trusted-Server Name Shows the host name (NetBIOS name) for this Avaya MAS in 
all-capital letters (such as ZIPPY). See item 1 for this MAS on the 
S3400-family system planning form on page A-6.

Password Type a password that will be known to all machines in this network. 
All trusted servers that have Service Name Messaging 
Application Server must use the same password (see items P1 
and P2 on the S3400-family password table on page A-9).

IP Address Type the private IP address for this Avaya MAS (such as 
192.168.1.250 for MAS#1). See item 14 for this MAS on the 
S3400-family system planning form on page A-6.

Service Name Messaging Application Server [This is a display-only field if you 
used the �me� suffix as shown; otherwise, type this name exactly.]

 Trusted Server ID Field will be filled in automatically. 

Minutes of Inactivity Before Alarm 10 
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6. Update the password and IP address fields in the Trusted Server screen 
as shown in Table 3-4. 

Figure 3-5.  Add MWI trusted server screen example

Table 3-4. Trusted Server Profile screen service settings

Field Setting

Trusted-Server Name VVSTS

Password Type a password that will be known to all machines in this 
network. See item P3 on the S3400-family password table on 
page A-9. 

IP Address Type the private IP address for the Avaya MAS that will have the 
MWI Server feature installed. Check your MAS features list on 
page A-11 to verify which MAS this is. 
Enter the appropriate IP address (see item 14 for this MAS on the 
S3400-family system planning form on page A-6).

Service Name MWI Server [This is a display-only field if you used the �mw� suffix 
as shown; otherwise, type this name exactly as shown.]

 Trusted Server ID Field will be filled in automatically. 

Minutes of Inactivity Before Alarm 0 
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7. When finished, press F3 (Enter).

The Trusted Server ID field is populated automatically.

Update the IMAP trusted server:

8. On all systems, modify the first IMAP trusted server to match the new 
settings. At the administration command prompt, type the following and 
press Enter: 

ch tru Imap4TS1 

Type the trusted server name exactly as shown in upper and lower case. 

The Trusted-Server Profile screen for this service is displayed as shown 
in Figure 3-6.

9. Tab to the Password field, and type the IMAP4 password (see item P4 
on the S3400-family password table on page A-9). 

10. Press F3 (Enter).

Check the status line to verify that the command completed successfully.

Figure 3-6.  Change IMAP trusted server screen example
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11. At the command prompt, type exit and press Enter.

12. Scroll down and click Return to Main. 

Rebooting the MSS

To make sure that the MSS is working correctly, reboot it now as follows: 

1. Starting from the Messaging Administration main menu, select:

Utilities
Reboot System

The server displays the Reboot System screen. 

2. Click Reboot. 

3. At the reboot warning message, click OK to proceed.

Status messages display as the server shuts down the messaging 
software. This may take several minutes. Proceed with the installation.
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4
Administering the Avaya MAS

This chapter describes how to perform basic administration on the Avaya Messaging 
Application Server (MAS).   

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the initial MSS administration 
tasks in Chapter 3, ��Powering up the system and performing initial 
MSS administration.�� 
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Installing Modular Messaging software 4-14

Setting up remote access 4-22

Configuring and testing the port boards 4-27

Configuring the voice mail system 4-38

Completing initial MAS administration 4-49
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Overview

You need to configure the Avaya Messaging Application Server (MAS) to work correctly 
on the corporate local area network (LAN) and the private LAN used for the required 
MSS and any other Avaya MASs. You also need to configure the port boards and set 
up all required Modular Messaging services. 

To successfully install an MAS, you need:

! A completed copy of all the forms in Appendix A, ��System planning 
forms,�� specifically:

� S3400-family system planning form on page A-6

� S3400-family password table on page A-9

� MAS logon accounts form on page A-10

� MAS features list on page A-11

� Required switch and messaging information on page A-12 

� Services logins and passwords on page A-14

! The software and documentation listed in "Required documentation" on 
page 1-2. 

! All required hardware, including the MAS port boards, installed as 
described in Chapter 2, ��Installing the system hardware.��

! Initial MSS administration completed as described in Chapter 3, 
��Powering up the system and performing initial MSS administration.��

Because an S3400-family system installation requires many steps, use your copy of 
the checklist in Appendix B, ��Installation checklist.�� Check off steps as you complete 
them to track your progress.

CAUTION: Use your completed planning forms from Appendix A, 
��System planning forms,�� to enter the correct values. You 
cannot use these examples or guess at the values. If you do, 
the current operation of the customer LAN may be damaged.

!
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Setting up the MAS

You need to set up the initial configuration on every Avaya Messaging Application 
Server (MAS) as described in this section.

Switching the monitor to show the correct server

The KVM switch is normally connected to the required Avaya MAS through the second 
computer port (VGA 02). Subsequent MASs (if present) are connected to computer 
ports VGA03, VGA 04, and VGA 05. 

To switch the monitor to show the server that you need to administer:

1. For a Belkin OmniView Pro2 KVM: Press slowly in sequence Scroll 
Lock, then Scroll Lock, then the up (or down) arrow key to change to the 
server connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the up or 
down arrow key (such as 02 for port 2). See your KVM switch 
documentation for complete user instructions.

2. If you cannot access the correct server, see "Connecting the KVM 
cables" on page 2-26 and verify the cable connections. To correct 
cabling problems, power down the system, correct the cabling, then 
power up the system again.

Starting up the system

The Avaya MAS begins to boot after power up. 

1. If the MAS is not already on, power up the unit now (push the power 
button on the front panel). 

See "Powering up the S3400-family system" on page 3-2 for details if 
needed. 

CAUTION: Because MAS#1 will become the domain controller, 
complete the administration of MAS#1 before administering 
any subsequent MASs. Otherwise, problems may occur. 

!

Note: If an updated version of the MAS Modular Messaging software 
is required, it must be copied to the hard disk on each new 
Avaya MAS server before administration can begin. To reload 
the operating system, continue with Appendix E, ��Reloading 
the software on an MAS.��
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2. Optional: When the system begins to boot, you can:

a. Press Esc when the splash screen appears.

b. Press the space bar to skip the memory check. 

Setting up the Windows system

After the machine boots, a wizard guides you through the Windows system 
configuration process. Complete all steps as directed. 

1. On the Welcome to the Windows 2000 Server Setup Wizard screen, 
click Next. (If you wait, the wizard automatically shows the next screen.) 

2. On the License Agreement screen, review the text. 

! If you agree to the terms, choose I accept this agreement. 

! If you decline the terms, you cannot proceed with the installation.

! Click Next.

3. On the Regional Settings screen: 

a. Check if the settings are correct. 

b. To change system and user locales, click the first Customize button. 

c. In the Regional Options window, on the General tab:

(1) Select your locale from the drop-down list.

(2) Update your language settings if needed. Click Apply. 

(3) Click the other tabs in order, and verify that your Numbers, 
Currency, Time, and Date settings are correct for this system. 
The defaults should reflect the locale you selected. 

(4) Click the Input Locales tab. Verify your locale and keyboard 
settings. 

(5) When finished, click OK to close the Regional Options window.

d. Click Next.

4. On the Personalize Your Software screen, enter the customer name and 
organization in the appropriate fields. See item 17 on your S3400-family 
system planning form on page A-6. Click Next. 
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5. On the Your Product Key screen:

a. Type the Windows product key for this MAS (each unit has a unique product 
key). 

b. Click Next.

6. On the Licensing Modes screen:

a. Select Per Server if needed.

b. For �Number of concurrent connections,� type 50.

c. Click Next.

7. On the Computer Name and Administrator Password screen:

a. Change the �Computer name� to the required host name (NetBIOS name) 
for this MAS (such as zippy). See item 1 on your S3400-family system 
planning form on page A-6. (The name is forced to upper-case.)

b. Enter and confirm the new password for the administrator account for this 
machine (case is important). See items A1 to A4 on the MAS logon 
accounts form on page A-10.

c. Click Next. 

8. On the Modem Dialing Information screen: 

a. Select your country or region.

b. Enter the area code or city code.

c. If needed, enter the prefix required to access an outside line (such as 9).

d. Select the type of dialing used (typically Tone dialing).

e. Click Next. 

9. On the Date and Time Settings screen: 

a. Set the Date and Time settings. 

b. Set the Time Zone and daylight savings values as needed.

c. Verify your settings, then click Next. 

The system pauses to update its settings.

Note: This number must be entered exactly as shown. It is located on 
a sticker or tag on the side or rear of each MAS unit.

Note: This screen appears only if a modem is connected. See 
"Connecting the USB modem on the MAS" on page 2-33. 
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10. On the Network Settings screen:

a. Select Custom settings.

b. Click Next.

Assigning IP addresses to this MAS

Use your completed S3400-family system planning form on page A-6 to assign IP 
addresses and other TCP/IP properties for the corporate and private LAN interfaces 
that this MAS will use. 

On the Networking Components screen for device Intel(R) PRO/100 VE Network 
Connection, specify the IP addresses for the corporate LAN interface for this MAS as 
follows:

1. In the components box, select Internet Protocol (TCP/IP).

2. Click Properties.

The Internet Protocol (TCP/IP) Properties window appears. See Figure 
4-1 on page 4-7 for an example. 

3. In the Internet Protocol (TCP/IP) Properties window:

a. Click the �Use the following IP address� radio button.

b. Change the IP address, Subnet mask, and Default gateway to the corporate 
LAN values for this MAS listed in the S3400-family system planning form on 
page A-6 (items 8, 9, and 10). 

c. Click �Use the following DNS server addresses.� Specify the corporate DNS 
IP addresses as follows:

(1) For the Preferred DNS server, enter the first Corporate DNS 
server IP address from your planning form (item 11, if any). 

(2) For the Alternate DNS server, enter the next Corporate DNS 
server IP address from your planning form (item 11, if any).

(3) Click the Advanced button.

The Advanced TCP/IP Settings window appears. 
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Figure 4-1. Sample corporate LAN TCP/IP properties 
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(4) Click the DNS tab. See Figure 4-2 for an example. 

(5) On the Advanced TCP/IP Settings DNS tab, enter the following: 

! If you need to add IP addresses for any additional corporate DNS 
servers, click Add (see item 11 on the S3400-family system planning 
form on page A-6). Click OK to approve each entry. 

! Select the radio button for �Append these DNS suffixes (in order)�. 
Click Add.

! In the TCP/IP Domain Suffix window, in the Domain suffix field, enter 
any corporate domain suffixes listed for Search order of DNS 
domains using item 12 on the system planning form (for example, 
loc.avaya.com and avaya.com). After each entry, click Add. Repeat 
as needed to add all required suffixes.

! In the �DNS suffix for this connection� text box, enter the suffix for the 
fully qualified corporate LAN domain name (do not include the 
machine name). For example, loc.avaya.com (see item 6 on the 
S3400-family system planning form on page A-6).

Figure 4-2. Sample advanced TCP/IP settings for the corporate LAN
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(6) Click OK to close the Advanced TCP/IP Settings window.

4. Click OK to close the Internet Protocol (TCP/IP) Properties window.

5. On the Networking Components screen, click Next.

On the Networking Components screen for device Intel(R) PRO/100+ PCI Adapter, 
specify the IP addresses for the private LAN for this MAS as follows: 

6. In the components box, select Internet Protocol (TCP/IP).

7. Click Properties.

The Internet Protocol (TCP/IP) Properties window appears. See Figure 
4-3 on page 4-9 for an example.

8. In the Internet Protocol (TCP/IP) Properties window:

a. Click the Use the following IP address radio button.

Figure 4-3. Sample private LAN TCP/IP properties 
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(1) Enter the private IP address required for this MAS. See item 14 on 
your S3400-family system planning form on page A-6.

(2) Enter the private subnet mask (such as 255.255.255.0). See item 
15 on your S3400-family system planning form on page A-6. 

(3) Leave the DNS server addresses as they appear (blank is okay).

b. Click OK to close the Internet Protocol (TCP/IP) Properties window.

c. If you see a warning that the DNS server list is empty, click OK. 

9. On the Networking Components screen, click Next.

The system pauses to update its settings. 

Completing the initial setup

Complete the initial administration for this MAS as follows: 

1. On the Workgroup or Computer Domain screen, choose the correct 
option for this MAS machine:

a. For MAS#1: 

(1) Select the first radio button: No, this computer is not in a 
network.

(2) Leave the Workgroup or domain name set to WORKGROUP. 

(3) Click Next.

b. For a subsequent MAS: 

(1) Select the second radio button, Yes, make this computer a 
member of the following domain.

(2) Enter the name of the Windows domain that you already created 
(such as zodiac). See item 3 on the S3400-family system planning 
form on page A-6. (The name is forced to upper case.) 

(3) Click Next.

(4) You are prompted to enter the user name and password that will 
allow this machine to join the domain:

! Enter the Modular Messaging account name (such as mmacct) in the 
format domain\account name (such as zodiac\mmacct). See item 
A5 on the MAS logon accounts form on page A-10. 
(The name is forced to upper case.) 

! Enter the correct Modular Messaging account password.

! Click OK.
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It may take several minutes to join the domain.

(5) Click Next.

2. On the Completing the Windows 2000 Setup Wizard screen, click 
Finish.

The machine reboots. 

3. When the reboot completes, press Ctrl+Alt+Del and log in as follows:

a. On the Log On to Windows screen, verify that the user name is 
Administrator. 

b. Enter the same password that you typed for the administrator account when 
you set up this machine. See items A1 to A4 on the MAS logon accounts 
form on page A-10.

c. Press Enter or click OK. 

4. If a Found New Hardware wizard appears, follow the prompts to 
complete each wizard. The hardware wizard appears once for every 
Dialogic port board installed in the system. 

Disable the Dialogic hardware for now as follows:

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next.

c. On the Locate Driver Files screen, clear the checkbox for �Specify a 
location� (no boxes will be checked). Click Next.

d. On the Driver Files Search Results screen, make sure that �Disable the 
device� is selected. Click Finish.

e. Repeat steps a through d for each repetition of the wizard.

Note: If the wizard comes up in a tiny window, press Esc to cancel 
this wizard (subsequent wizards should run in a normal-sized 
window). The skipped wizard will reappear the next time the 
system restarts; run it then.

If you reinstalled the operating system (see Appendix E, 
��Reloading the software on an MAS,��) and ran the Found New 
Hardware wizards then, the wizards do not appear again. 

This wizard does not appear for IP H.323 configurations.
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Changing the default LAN names

Rename the corporate and private LAN connections for this MAS so they will be easier 
to identify. To rename the LAN entries:

1. Click Start > Settings > Network and Dial-up Connections.

The Network and Dial-up Connections window appears.

2. Verify that Local Area Connection2 is the corporate LAN (a 
mouse-over should show �Intel(R) PRO/100 VE Network Connection� as 
the type). 

3. Rename this item as follows:

a. Right-click Local Area Connection2 and select Rename.

b. Change the name to Corporate LAN.

4. Rename the other Local Area Connection entry as follows:

a. Right-click Local Area Connection and select Rename.

b. Change the name to Private LAN.

5. Close this window. 

Testing IP addresses on the private network

To test if the IP addresses are correct and working on the private Ethernet interface: 

1. Click the Start button, then select Run to open a Command prompt 
window. 

2. In the Run box, type cmd in the Open field and press Enter. 

3. Test ping over the private Ethernet interface.

a. At the command prompt, ping all IP addresses administered on the private 
network. For example, ping 192.168.1.1 and verify success. See item 14 
on your S3400-family system planning form on page A-6. 

b. If the ping test fails, verify that your network connections between the MAS 
and MSS are good. If so, check your administration. 

Note: Submenu choices are indicated with a right angle sign (>) in 
the rest of this document. For example, the procedure above 
would appear as Start > Run.
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See Figure 4-4 for an example of a successful ping by IP address.  

c. Optional: If you are using a corporate DNS, you may also want to test ping 
over the corporate Ethernet interface to make sure it is set up correctly. For 
example:

! You could ping any corporate IP addresses on your system (such 
as items 8 through 11 on your S3400-family system planning form 
on page A-6). 

! You could also ping the MSS machine the corporate FQDN (such 
as ping zigzag.loc.avaya.com). Any name tests should show the 
corporate IP address for the entity you ping. 

4. When finished, type exit and press Enter to close this window.

Figure 4-4. Example of successful ping by IP address

Note: In order for a name test to succeed, the machine names must 
be administered on the corporate DNS. If a corporate DNS is 
not used, ping will not be able to resolve the corporate name.
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Installing Modular Messaging software

You need to install all required Modular Messaging software and configure each MAS 
as described in this section. 

Configuring Modular Messaging

Specify the message store and set up Modular Messaging accounts for this MAS as 
follows:

1. Double-click the OSConfigWizard.exe icon on the desktop. 

The Modular Messaging OS Component Configuration Wizard appears.

2. On the Welcome screen, click Next.

3. On the Modular Messaging setup information screen:

a. Select the message store type Avaya MSS. 

b. For MAS#1: 

(1) Check the box for �First MAS in system.�

(2) For Private fully qualified domain name (FQDN), enter the 
private domain name (such as zodiac.com). See item 2 on the 
S3400-family system planning form on page A-6. 

(3) For Windows NetBIOS domain, enter the private NetBIOS name 
(such as zodiac). See item 3 on the S3400-family system planning 
form on page A-6. 

(4) Click Next.

c. For a subsequent MAS: 

(1) Clear the checkbox for �First MAS in system.�

(2) For Windows NetBIOS domain, enter the private NetBIOS name 
(such as zodiac). See item 3 on the S3400-family system planning 
form on page A-6. 

(3) Click Next.

4. On the next Modular Messaging setup information screen, enter the 
Modular Messaging account information as follows: 

! For MAS#1, under New account information, enter the following 
(these accounts will be shared across all MASs):
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a. For Administrator account for MAS, enter the customer-defined domain 
administrator account logon name (such as dom-admin). Type the 
password in each password column to confirm it. See item A1 on the MAS 
logon accounts form on page A-10.

b. For Modular Messaging (MM) account, enter the customer-defined 
Modular Messaging account logon name (such as mmacct). Type the 
password in each password column to confirm it. See item A5 on the MAS 
logon accounts form on page A-10.

c. For Services account, enter the customer-defined services account logon 
name (such as craft). Type the password in each password column to 
confirm it. See item A6 on the MAS logon accounts form on page A-10.

d. For Customer account, enter the customer-defined services account 
logon name (such as cust). Type the password in each password column to 
confirm it. See item A7 on the MAS logon accounts form on page A-10.

e. For Safe mode password, enter the password that is to be used for the 
administrator to log in to Safe mode. See item A8 on the MAS logon 
accounts form on page A-10.

f. Click Next.

! For a subsequent MAS, enter the following:

a. Under Existing account information, enter the following:

(1) Modular Messaging (MM) account: enter the same 
customer-defined Modular Messaging account logon name (such 
as mmacct) that you entered for MAS#1. Type the password in 
each password column to confirm it. See item A5 on the MAS 
logon accounts form on page A-10.

(2) Domain Administrator account: enter the same 
customer-defined domain administrator account logon name 
(such as dom-admin) that you entered for MAS#1. Type the 
password in each password column to confirm it. See item A1 on 
the MAS logon accounts form on page A-10.

b. Under New account information, for Administrator account for MAS, 
enter the customer-defined local administrator account logon name for this 
MAS (such as mas2-admin). Type the password in each password column 
to confirm it. See items A2 to A4 on the MAS logon accounts form on page 
A-10.

c. Click Next.

5. Wait while the system processes the information you have entered. 

! MAS#1 is promoted to a domain controller, after which the machine 
restarts twice. Allow up to 15 minutes for the entire process.

! Subsequent MASs restart only once. 
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6. After the MAS reboots, you are prompted to log in or simply enter a 
password. The final reboot logs you into the Modular Messaging account 
(such as mmacct). 

a. If prompted, press Ctrl+Alt+Del. 

b. On the Log On to Windows screen, check the user name. The software 
selects the correct account to log into automatically.

c. Enter the correct password for this account. See items A1 to A5 on the 
MAS logon accounts form on page A-10.

7. When prompted to insert the Modular Messaging application software:

a. Insert the first installation disk in the DVD drive. This is either: 

! The Avaya Modular Messaging Application Software DVD, or 

! For a system that uses CD-ROMs, the Avaya Modular Messaging 
Application Software and Languages CD. 

b. Close the drive door and wait for the green LED to go out. Click OK. 

Installing the Modular Messaging software

When the previous procedure completes, the Modular Messaging - Installation Wizard 
window appears. 

To install the Modular Messaging software:

1. In the Modular Messaging - Installation Wizard window, for the 
�Configuration� drop-down box, verify that Avaya MSS is selected. 

2. In the components list, check the boxes for any messaging services you 
need to install on this MAS as follows: 

a. Required on every MAS: 

! Administration Tools

! Diagnostic Tools 
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b. Required on every MAS that will handle calls: 

! Messaging Application Server (includes the Alarming Server, 
which also installs the Event Monitor Server, Performance Monitor 
Server, and Process Monitor Server) 

! Prompt Files (at least one set is required on every MAS) 

c. Required on this MAS as specified by the customer: See the MAS features 
list on page A-11 for the specific services you need to put on this server. 
Services include:

! Call Me Server (includes the Mailbox Monitor Server)

! Caller Applications Editor

! Fax Sender Server

! Language Packs 

! Message Waiting Indicator (MWI) Server (also includes the 
Mailbox Monitor Server)

! Tracing Server 

3. When all required services are selected, click Install.

4. Wizards run for all the Modular Messaging software packages you 
selected. Complete each wizard as directed. 

The following components install automatically (no response is needed): 

! Administration Tools (required) 

! Caller Applications Editor (optional on any machine) 

! Diagnostic Tools (required) 

! Language Packs (optional on any MAS) 

! Prompt Files (required; this may take several minutes) 

5. The following components must be installed on every MAS that will 
handle calls:

! Alarming Server 

! Messaging Application Server 

The wizards for these components must be completed as follows: 

Note: These software components are not required on an MAS that 
does not handle calls, such as a machine that has only the 
Caller Applications Editor or Tracing Server installed on it. 
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a. When one of the above server installation wizards runs, click Next.

b. When prompted, enter the following account information:

! For Domain, enter the NetBIOS name of the Windows domain 
(such as zodiac). See item 3 on the S3400-family system planning 
form on page A-6.

! For User Name and Password, enter the Modular Messaging 
account name (such as mmacct) and its password. See item A5 
on the MAS logon accounts form on page A-10. 

! Click Next. 

c. Click Install.

d. When done, click Finish.

6. The following components may be installed on any MAS:

! Mailbox Monitor Server (by default, this is installed first if the Call Me 
or MWI Server is selected) 

! Call Me Server 

! Fax Sender Server

! Message Waiting Indicator (MWI) Server 

! Tracing Server 

The wizards for these components must be completed as follows: 

a. When one of the above server installation wizards runs, click Next.

b. When prompted, enter name of this MAS machine (such as zippy). See 
item 1 on the S3400-family system planning form on page A-6. Click Next. 

c. When prompted, enter the password for the Modular Messaging account 
(such as mmacct). See item A5 on the MAS logon accounts form on page 
A-10. Click Next. 

d. Click Install.

e. When done, click Finish.

7. For a system that uses CD-ROMs, you are prompted to insert additional 
disks to install the RealSpeak Text-to-Speech software in multiple 
languages. When prompted to insert installation disk 2: 

a. Remove the Avaya Modular Messaging Application Software and 
Languages CD from the drive. 

b. Insert the first Enhanced Email Reader (Text-to-Speech) RealSpeak 
software CD in the drive and close the door. 

c. Wait for the drive�s green LED to go out. Click OK. 
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d. After the disk is copied, you are prompted to insert the next disk: 

! Insert the next RealSpeak TTS software CD in the DVD drive.

! Repeat steps b and d for each RealSpeak TTS software CD.

Allow several minutes for the RealSpeak software to install. When 
finished, the wizard returns to the main screen. 

8. To complete the installation, click Close.

9. Click Restart when prompted to restart the system now. 

10. Remove the media from the DVD drive. 

Configuring the MAS

To configure Modular Messaging services on this MAS:

1. When the reboot completes, press Ctrl+Alt+Del to log back in. Use the 
Modular Messaging account name (such as mmacct) and its password 
(see item A5 on the MAS logon accounts form on page A-10).

The Messaging Application Server - Configuration Wizard launches. It 
may take a few minutes to connect to the MAS.

2. For the Peer Messaging Storage Server Selection screen: 

a. Enter the name of the Messaging Storage Server. This is always the MSS 
private system name mss1 (the name is forced to upper-case). See item 13 
on the S3400-family system planning form on page A-6.

b. Click Next.

The Service configuration may take several minutes.

3. For the Voice Mail Domain Selection screen:

a. Select a new or existing voice mail domain as follows:

! For MAS#1: Click the radio button for �First server in a new voice 
mail domain.�

! For a subsequent MAS: Click the radio button for �Subsequent 
server in an existing voice mail domain.� 

b. Click Next. 

CAUTION: If you are restoring an MAS to service after a disk failure, 
you need to do a different procedure here. See Recovering 
from a catastrophic disk failure on page F-1. 

!
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4. On the Messaging Application Server Credentials screen: 

a. Enter and confirm the password for the LDAP service that you previously 
administered on the MSS. This is the MAS trusted server password 
specified in "Setting up the trusted servers" on page 3-13. See items P1 
and P2 on the S3400-family password table on page A-9.

b. Click Next.

5. For MAS#1: Another Messaging Application Server Credentials screen 
appears. 

a. Enter the password for the IMAPI service that you previously administered 
on the MSS. This is the password for the MWI trusted server that activates 
message-waiting lamps, currently called VVSTS. See item P3 on the 
password table.

b. Click Next.

6. For MAS#1: A third Messaging Application Server Credentials screen 
appears.

a. Enter the password for the IMAP4 service that you previously administered 
on the MSS. This is the Imap4TS1 trusted server password. See item P4 on 
the password table. 

b. Click Next.

7. On the Voice Mail Domain Selection screen:

a. Specify the voice main domain as follows:

! For MAS#1: Enter the unique voice mail domain name for this 
pair of MAS and MSS servers (such as zebra). See item 4 on the 
S3400-family system planning form on page A-6. 

! For a subsequent MAS: Verify that the existing voice mail 
domain name appears in the drop-down box (such as zebra). 

b. Click Next.

The VMD configuration may take several minutes.

8. For a subsequent MAS: The Offline Storage Location screen appears if 
offline access is enabled in the voice mail domain and an offline 
message store has not already been selected. Browse to an existing, 
shared directory in the domain to set up the remote offline message 
store, used to synchronize messages in a multiple-MAS configuration. 
See item 16 on the S3400-family system planning form on page A-6. 

CAUTION: Be extremely careful to type the correct name for the voice 
mail domain. If you type the wrong name or spell it 
incorrectly, you will have to reinstall all the Modular 
Messaging software from the beginning to correct it. 

!
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a. For Store Location, click Browse. 

b. In the Browse for Folder window, navigate to the specified directory.

c. Select the folder and click OK. 

d. Click Next. 

9. For a subsequent MAS: The Caller Application screen appears if Caller 
Applications are deployed in the domain. 

a. Use the default setting for this step.

b. Click Next.

10. For the User Information screen, just click Next.

11. For the Setup Complete screen, click Finish. 

Installing anti-virus software and Windows updates

We strongly recommend that anti-virus software be installed on any Microsoft Windows 
machine that is used to run Avaya Modular Messaging software. The type of 
virus-checking software used and the method of installation depends upon the 
customer�s requirements and local implementation. 

In addition, Microsoft Windows security patches must be installed to protect the 
operating system from known security weaknesses. Check with the appropriate 
customer administrator for the software and installation/update procedures to use.
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Setting up remote access

Use this procedure to set up the MAS to take incoming service calls.

To set up this MAS for remote access: 

1. Activate remote access service as follows:

a. Double-click the Monitor icon on the desktop.

b. In the Monitor window, click Services (Local) in the left-hand pane.

c. In the right-hand pane, scroll down to Routing and Remote Access. 
Double-click it to open the properties window.

d. In the Routing and Remote Access Properties window: 

(1) On the General tab, set the �Startup type� to Automatic. 

(2) Click Apply. 

(3) Under �Service status,� click Start. 

(4) Wait for service to start, then click OK to close this window.

e. Close the Monitor window.

2. Double-click the Configure icon on the desktop. 

3. To set up remote access properties for this MAS:

a. Expand Routing and Remote Access.

b. Expand the server name (such as ZIPPY).

4. Verify that remote access service (RAS) is running as follows:

a. If a green upward-pointing arrow appears on the server�s icon, RAS is 
running. Continue with step 5.

b. If a red symbol appears on the server�s icon, activate RAS as follows:

(1) Right-click the server�s name, and select All Tasks > Start.

(2) When prompted to re-enable Routing and Remote Access, click 
Yes. 

5. Set up inbound remote access to the modem as follows:

a. Right-click Ports and select Properties.

Note: This icon has a .msc extension and is labeled Configure.msc.
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b. In the Ports Properties window, make sure the modem is highlighted, then 
click Configure.

c. In the Configure Device - <model> Modem window, verify that the box to 
activate Remote access connections (inbound only) is checked.

d. Click OK.

e. Click OK to close the Ports Properties window.

6. Verify your modem setup:

a. Click Ports in the left-hand pane.

b. In the right-hand pane, verify that there is an entry for the modem attached 
to this MAS, such as MultiTech ZBA-USB-V92. 

! If the modem entry is present, go to step 7.

! If the modem entry is missing, continue as follows: 

(1) Verify that the modem is plugged into the recommended USB port 
on the MAS (see "Connecting the USB modem on the MAS" on 
page 2-33).

(2) Click Start > Settings > Control Panel.

(3) Double-click Phone And Modem Options.

(4) The first time you select Phone and Modem Options, a wizard 
runs. 

! Complete the wizard following the steps on each screen to configure 
your locale settings. 

! When finished, your new entry appears in the Locations box on the 
Dialing Rules tab.

(5) In the Phone And Modem Options window, click the Modems tab.

(6) Verify that the modem is present and attached to a port (typically 
COM3 if you used the recommended USB port).

(7) If the modem is not present or attached to a port, you may need to 
remove the modem entry, then reinstall the modem.

(8) When finished, click OK to close the Phone And Modem Options 
window.

(9) Close the Control Panel.

(10)Return to step a and verify that the modem is now present.
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7. Set up a static IP address pool as follows:

a. In the left-hand pane, right-click the server name (such as ZIPPY) and 
select Properties.

b. Click the IP tab.

c. Under �IP address assignment,� select �Static address pool�. 

d. If an IP address range of 0000 to 0000 appears, select it and click Edit. (If 
no address appears, click Add.)

e. In the New Address Range properties box, enter the start and end IP 
addresses depending on the MAS you are installing as follows: 

! MAS#1: 192.168.2.200 to 192.168.2.201

! MAS#2: 192.168.2.202 to 192.168.2.203

! MAS#3: 192.168.2.204 to 192.168.2.205

! MAS#4: 192.168.2.206 to 192.168.2.207 

f. Make sure the number of addresses is 2.

g. Click OK.

h. For the Adapter field, select �Allow RAS to select adapter.� 

i. Click OK to close the Properties window.

8. Close the Configure window. 

9. Proceed with remote access administration as follows:

! For MAS#1, continue with "Administering the first MAS for remote 
access" on page 4-24.

! For a subsequent MAS, continue with "Adding a subsequent MAS 
to the remote access group" on page 4-26.

Administering the first MAS for remote access

Continue the previous procedure on MAS#1 as follows: 

1. Log in to the domain administrator account for MAS#1. For example:

a. From the task bar, click Start > Shut Down...

b. On the Shut Down Windows screen, select Log off mmacct. Click OK. 

c. Press Ctrl+Alt+Del to log on.

Note: These IP addresses use a 2 (not a 1) in the third number place.
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d. On the Log On to Windows screen, change the user name to the domain 
administrator account name (such as dom-admin). See item A1 on the MAS 
logon accounts form on page A-10.

e. Enter the password for this account.

f. Press Enter or click OK.

2. Double-click the Configure icon on the desktop. In the left-hand pane of 
the Configure window:

a. Expand Active Directory Users and Computers.

b. Expand the directory for the domain name (such as zodiac.com).

c. Click Users.

3. In the right-hand pane of the Configure window, double-click RAS and 
IAS Servers to open the properties window.

4. In the RAS and IAS Servers Properties window:

a. Click the Members tab.

b. Click Add.

c. In the Select Users, Contacts, Computers or Groups window, locate this 
MAS (such as ZIPPY); it will have a blue terminal icon beside it. 
Double-click it.

d. Verify that the correct computer name appears underlined in the list box.

e. Click OK to close this window.

f. Click OK to close the RAS and IAS Servers Properties window.

5. In the right-hand pane, double-click Services Account. In the Services 
Account Properties window:

a. Click the Dial-in tab.

b. Under Remote Access Permission (Dial-in or VPN), click the radio button to 
select Allow access.

c. CallBack Options should be left at No Callback.

d. Click OK. 

6. Close the Configure window. 

7. Log back in to the Modular Messaging services account. For example:

a. Click Start > Log Off dom-admin.

b. Click Yes when prompted to confirm the logoff. 

c. Press Ctrl+Alt+Del to log on.
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d. On the Log On to Windows screen, change the user name to the Modular 
Messaging services account name (such as mmacct). See item A5 on the 
MAS logon accounts form on page A-10.

e. Enter the password for this account.

f. Press Enter or click OK.

8. Continue with "Configuring and testing the port boards" on page 4-27.

Adding a subsequent MAS to the remote access group

Add subsequent MASs to the existing remote access group as follows: 

1. Switch the monitor to show MAS#1. See "Switching the monitor to show 
the correct server" on page 4-3 for this procedure if needed. 

2. Repeat steps 1 through 3 in "Administering the first MAS for remote 
access" on page 4-24. 

3. For step 4, do the following in the RAS and IAS Servers Properties 
window:

a. Click the Members tab.

b. Click Add.

c. In the Select Users, Contacts, Computers or Groups window, locate this 
MAS (such as ZORRO); it will have a blue terminal icon beside it. 
Double-click it.

d. Verify that the correct computer name appears underlined in the list box.

e. Repeat steps c and d to add all MASs to this list. See the S3400-family 
system planning form on page A-6. 

f. Click OK to close this window.

g. Click OK again to close the RAS and IAS Servers Properties window.

4. Close the Configure window.

5. Log off the domain administrator account on MAS#1. For example:

a. Click Start > Log off dom-admin.

b. Click Yes when prompted to confirm the logoff. 

Note: If you are installing multiple MAS units, you may want to do this 
procedure after you configure the final MAS. That way you only 
have to do this procedure once.

Note: Do this procedure on MAS#1.
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6. Switch the monitor back to show the MAS that you are currently 
installing. Continue with the installation.

Configuring and testing the port boards

The MAS port boards must be configured and tested as described in this section. 

Port board administration involves three phases: 

1. The appropriate party must administer the switch for the port boards 
using the configuration notes for your particular PBX or switch 
integration. See "Required documentation" on page 1-2 for instructions 
on obtaining the configuration notes.

2. Configure and test the port boards as described in this section.

3. Afterwards, complete board administration using the configuration notes 
as described in "Configuring MAS-specific parameters" on page 4-46. 

Table 4-5 lists supported Dialogic port boards and their associated documents (copies 
of these PDF files are on the documentation CD and application software disk). The 
type of port boards may vary on different MASs in the system, although each MAS can 
have only one type of board installed in it.  

Note: If this MAS uses an IP H.323 integration, no port boards are 
present. Continue with "Configuring the voice mail system" on 
page 4-38. 

CAUTION: You can only install this system by using the required 
configuration notes for your switch or PBX. The PBX 
administrator must have administered the ports on the 
switch before you can proceed.

!

Table 4-5. Supported MAS port boards 

Protocol Ports Port boards Max # Dialogic files on documentation CD

Analog 4 - 8
12 - 48

Dialogic 4-port T/R board
Dialogic 12-port T/R board

2
4

D/41JCT-LS (PDF 133K)
D/120JCT-LS (PDF 131K)

Digital Set 
Emulation

8 - 40 Dialogic D/82JCT-U
Dialogic D/82JCT-U-PCI-UNIV

5 D/82JCT-U (PDF 240K) 
D/82JCT-U PCI Univ (PDF 234K)

T1-QSIG 23 - 69 Dialogic D/480JCT-2T1 3 DualSpan JCT boards (PDF 104K)

E1-QSIG 30 - 60 Dialogic D/600JCT-2E1 2 DualSpan JCT boards (PDF 104K)



585-310-332, Issue 3

Avaya Modular Messaging Release 1.1 Installation

4�28 December 2003

Continue based on the type of port boards installed in this MAS:

! "Configuring analog port boards" on page 4-28

! "Configuring set emulation boards" on page 4-30

! "Configuring T1- or E1-QSIG boards" on page 4-32

Configuring analog port boards 

You may have the following analog port boards installed in an MAS: 

! Dialogic 4-port Tip/Ring board (up to 2 per MAS; see the D/41JCT-LS 
PDF file on the documentation media for details)

! Dialogic 12-port Tip/Ring board (up to 4 per MAS; see the D/120JCT-LS 
PDF file on the documentation media for details)

To configure either of these analog cards:

1. Click Start > Programs > Intel Dialogic System Software > Configuration 
Manager - DCM.

The Intel Dialogic Configuration Manager window appears.

2. In the Computer Name popup window, make sure that the radio button 
for Local is selected and verify the server�s name, such as ZIPPY.

3. Click Connect.

The Dialogic software locates any installed port boards.

4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. In the Dialogic Configuration Manager Properties window:

a. Click the Files tab.

The TSFFileName parameter should be selected.  

Note: If you are using a D/41JCT-LS card, you must highlight the 
�Configured Devices� parameter on the DCM display when 
selecting Configure Device. This is necessary to be able to 
view the TSFFilename parameter.

CAUTION: If you can�t find a suitable TSF file for your PBX, you need to 
build an appropriate tone file now or the integration will not 
work. Cancel out of this screen, then see Appendix C, 
��Creating a new tone file.��

!
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b. Locate the prerecorded TSF file for your PBX or switch:

(1) Click the ... button to browse, then navigate to the 
C:\Avaya_Support\Tone_Files directory. 

(2) In the Search File window, select a TSF file that is appropriate for 
the PBX to which you are connecting (for example, 
Avaya-G3-US.tsf). Double-click the file name. 

The appropriate TSF file is inserted in the Value field.

6. After an appropriate TSF file is selected, click the Misc tab.

a. Click the TSFFileSupport parameter. 

b. Select Yes from the Value drop-down list. 

c. Click the DisconnectTone parameter.

d. Select Yes from the Value drop-down list.

e. For a D/120JCT-LS board: Click the FirmwareFile parameter, then select 
spfax.fwl from the Value drop-down list.  

f. Click OK to close the Properties window.

7. Repeat steps 4 through 6 for any other installed Dialogic boards (such 
as #1). 

8. For a D/120JCT-LS board: When all boards are configured, close the 
Intel Dialogic Configuration Manager window, then reopen it (see step 
1). This is required to load the new firmware file that supports fax. 

9. Click the green Start Service button on the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active. See 
Figure 4-5 on page 4-30 for an example. 

10. Close the Intel Dialogic Configuration Manager window.

Note: You must have selected an appropriate TSF file for your PBX 
or switch before setting the TSFFileSupport parameter to Yes, 
or errors may occur.

Note: You need to close the Dialogic Configuration Manager to load 
the new firmware (see step 8). The D/41JCT-LS board uses 
the default.fwl file and does not need to be specifically set. 

Note: Most of the first board�s settings will persist between boards, 
except for the FirmwareFile parameter.
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11. Continue with "Testing the port boards" on page 4-35.

Configuring set emulation boards 

You may have up to five 8-port Dialogic Digital Set Emulation boards installed in your 
MAS. See the D/82JCT-U or D/82JCT-U PCI Univ PDF file on the documentation 
media for more information. 

To configure your digital set emulation boards:

1. Click Start > Programs > Intel Dialogic System Software > Configuration 
Manager - DCM.

The Intel Dialogic Configuration Manager window appears.

2. In the Computer Name popup window, make sure that the radio button 
for Local is selected and verify the server�s name, such as ZIPPY.

3. Click Connect.

The Dialogic software locates any installed port boards. See Figure 4-6 
on page 4-31 for an example.

Figure 4-5. Sample Dialogic Configuration Manager analog window - service started
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4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 

5. In the Dialogic Configuration Manager Properties window:

a. Click the Telephony Bus tab and select the PCMEncoding parameter.

b. On the pull-down list of values, select either A-Law or µ-Law depending on 
your location. Typically, A-Law is Europe and µ-Law is United States.

c. Click the Misc tab and select the PBXSwitch parameter.

d. On the pull-down list of values, select the name of the PBX (for example, 
use Lucent 2-wire for an Avaya G3 switch).

e. Click the Country tab and select the Country parameter.

f. On the pull-down list of values, select your country.

g. Click OK to close the Dialogic Configuration Manager Properties window.

6. Repeat steps 4 and 5 for any other installed Dialogic boards (such as 
#1).

Figure 4-6. Sample Dialogic Configuration Manager DSE window - service not started

CAUTION: If the DSE boards are connected to a Nortel (NTM-1) PBX, 
you need to reboot the MAS before starting the Dialogic 
drivers. Close the DCM and reboot the system now. When 
the reboot completes, log back in and reopen the DCM (see 
step 1), then proceed to step 7.

!
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7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active.

8. Check that the boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. It flashes a code for 
each port consecutively as follows:

! Ports that are connected to a phone line and functioning correctly 
show 0 and the port number (such as 00 or 01).

! Ports that are not connected to a phone line or not functioning 
correctly show En, where n is the port number. For example, the 
display reads E3 if there is an error on port 3.

b. If any errors (En codes) are present, check your board configuration, the 
physical connections between the board and the PBX, or the PBX 
configuration itself. (For example, make sure you have configured the 
correct PBX). Repeat steps 4 through 8 as needed.

9. Close the Intel Dialogic Configuration Manager window.

10. Continue with "Testing the port boards" on page 4-35.

Configuring T1- or E1-QSIG boards 

You may have either of the following QSIG port boards installed in your MAS. See the 
DualSpan JCT boards PDF file on the documentation media for more information. 

! Dialogic D/480JCT-2T1 board (up to 3 boards per MAS)

! Dialogic D/600JCT-2E1 board (up to 2 boards per MAS)

To configure either of these QSIG boards:

1. Click Start > Programs > Intel Dialogic System Software > Configuration 
Manager - DCM.

The Intel Dialogic Configuration Manager window appears.

2. In the Computer Name popup window, make sure that the radio button 
for Local is selected and verify the server�s name, such as ZIPPY.

3. Click Connect. 

The Dialogic software locates any installed port boards. 

4. Under Configured Devices, double-click the name of the first Dialogic 
board shown (such as #0). 
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5. In the Dialogic Configuration Manager Properties window:

a. Click the Interface tab and select the ISDNProtocol parameter.

b. Select the correct value for this type of board from the pull-down list:

! For E1-QSIG: select QTE

! For T1-QSIG: select QTU

c. Click the Telephony Bus tab and select the PCMEncoding parameter.

d. Select the correct value for this type of board from the pull-down list:

! For E1-QSIG: select A-Law 

! For T1-QSIG: select µ-Law 

e. Click the Misc tab:

(1) For the FirmwareFile parameter, verify that default is displayed.

(2) Select the FirmwareFile2 parameter. Select spfax.fwl from the 
Value drop-down list.

f. Click the Country tab and select the Country parameter.

g. On the pull-down list of values, always use United States for either type of 
board. 

h. Click OK to close the properties window.

6. Repeat steps 4 and 5 for any other installed Dialogic boards (such as 
#1).

7. When all boards are configured, click the green Start Service button on 
the button bar.

Wait for service to start. The installed boards show a green light when 
service is started, and the Stop Service button becomes active. See 
Figure 4-7 on page 4-34 for an example. 

8. Check that the boards are operating correctly. 

a. Check the LED display on the Dialogic board faceplate. 

! A red status LED appears on the back of the voice card during 
driver start-up.

! If the drivers start successfully, the LED of the board whose port is 
connected to the PBX is replaced by a green LED within about 20 
to 30 seconds. LEDs on the other boards remain red.

b. If a problem occurs, check your board configuration, the physical 
connections between the board and the PBX, or the PBX configuration 
itself. Repeat steps 4 through 8 as needed. 
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9. Close the Intel Dialogic Configuration Manager window.

10. Continue with "Testing the port boards" on page 4-35.

Figure 4-7. Sample Dialogic Configuration Manager QSIG window - service started
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Testing the port boards 

Test all port boards and channels to verify that they can send and receive calls. 

Prepare for port board testing as follows: 

1. Stop Modular Messaging service as follows:

a. Double-click the Monitor icon on the desktop. 

b. Click Services (Local) in the left-hand pane if it is not already selected.

c. In the right-hand pane, scroll down to MM Messaging Application Server.

d. Right-click MM Messaging Application Server and select Stop.

2. For software updates only, the Dialogic Line Tester program is not yet 
installed. Access the test program on disk as follows: 

a. Insert the application software disk in the DVD drive. This is either: 

! The Avaya Modular Messaging Application Software DVD, or 

! For a system that uses CD-ROMs, the Avaya Modular Messaging 
Application Software and Languages CD. 

b. Close the drive door and wait for the green LED to go out. Click OK. 

c. In Windows Explorer, navigate to the DVD drive (D:).

d. Navigate to the Install directory, then to the DLTest subdirectory. 

e. Double-click the file DLTest.exe.

The Dialogic Line Test Application launches.

3. For T1 QSIG or E1 QISG boards, set up the test options as follows: 

a. Click Start > Programs > Avaya Modular Messaging > Dialogic Line Tester 
(or access the program from the applications disk as described in step 2). 

b. In the Dialogic Line Test Application window, click Tools > Options.

c. In the Options window, select the correct values for each field. Use your 
configuration notes to identify the correct values: 

! For Layer 1 Protocol, select your ISDN protocol from the 
drop-down list.

! For Number Type, select the destination number type.

! For Number Plan, select the destination number plan. 

Note: The values you select here must be the same as those entered 
on the PBX or switch. Check your configuration notes.
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To test Dialogic port board functionality: 

1. Access the Dialogic Line Test application using one of these methods:

! Click Start > Programs > Avaya Modular Messaging > Dialogic Line 
Tester 

! Access the DLTest program from the applications software disk 
described in step 2 on page 4-35. 

The Dialogic Analog - Line Test Application (or DLTest) window appears.

The name of the window varies slightly depending on the type of port 
boards installed. All port numbers and channel designations should be 
listed. See Figure 4-8 for an example. 

2. Test the incoming call connectivity of all ports as follows:

a. From a handset on the same PBX, dial each port individually.

! For analog and set emulation boards, use the individual port 
extensions from Required switch and messaging information on 
page A-12.

! For QSIG cards, repeatedly dial the number for that group of 
ports. The switch connects to the next port in the list each time 
you dial.

b. Check the Status column. Verify that each port shows �Received call� 
followed by �Connected.� See Table 4-6 for different status conditions.

Figure 4-8. Sample Dialogic Analog - Line Test Application window
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The system should answer each connected call with a standard 
welcome message. 

3. Test the outcalling capability of all ports as follows: 

a. Type the number of an extension on this PBX in the Dial Number field near 
the top of the window.

b. Select a Port Number in the Dialogic Line Test Application window.

c. Click Dial Number.

d. When the dialed extension rings, answer the call and hang up.

e. Select the next Port Number, and click Dial Number again. 

f. Repeat steps d and e until all ports have been tested.

4. When finished, close the test application window.

5. If a problem occurs, check your board configuration, the physical 
connections between the board and the PBX, or the PBX configuration 
itself. For example, make sure that you have configured the correct PBX 
and administered it according to the appropriate configuration notes.

Table 4-6. DL Test status messages 

Status Description Highlight

Channel starting� The channel is being started. Normal

Channels idle� The channel is idle. Normal

Waiting for call� The channel is waiting for an incoming call. Normal

Received call� An incoming call is being processed. Normal

Dialling number� A number is being dialled to make on outgoing call. Normal

Resetting� The user reset the channel. Normal

Line Busy. An outgoing call was made but a busy tone was detected. Normal

No Answer. An outgoing call was made but the call was not answered. Normal

Connected. An incoming or outgoing call was answered so the call is now connected. Normal

Call was disconnected. An incoming or outgoing call was disconnected. Normal

Error. A general error with channel occurred. Error

Error, No Dial tone 
detected.

An outgoing call was made but no dial tone was detected before dialling. Error
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Configuring the voice mail system 

Voice mail system configuration falls into three areas:

1. Domain-wide administration, some of which must be done on MAS#1 
only (such as initial PBX setup).

2. Administration of domain-wide features that may be installed on any 
MAS, such as Call Me or Message Waiting Indicator.

3. Port board and feature configuration specific to each MAS.

This section guides you through the administration of key parameters that are required 
to get a new system operational.  

Configuring domain-wide features

This section covers the administration of domain-wide features as follows:

! Required features that must be administered for every Modular 
Messaging system are marked On MAS#1 in this guide. This is to 
ensure the configuration of all required system elements. (Note that, 
except for initial PBX administration, most domain-wide features 
technically can be administered on any MAS.) 

! Some domain-wide features are optional and may be installed on any 
MAS, including the first one (such as the Call Me and Message Waiting 
Indicator Servers). Use the MAS features list on page A-11 to determine 
what features need to be configured on a given MAS.

Note: This section is intended to get a Modular Messaging system up 
and running with the basic required features. Customers are 
encouraged to tailor the Voice Mail System Configuration (VMSC) 
parameters for their site after a successful installation using the 
Avaya Modular Messaging Software Messaging Application Server 
Administration guide (PDF 3 MB), located on the documentation 
media shipped with the system. 

CAUTION: The procedures in this section can only be completed by 
using the required configuration notes for your PBX or 
switch. See "Required documentation" on page 1-2 for 
instructions on obtaining the configuration notes.

!
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To configure the voice mail system:

1. If you installed multiple languages, specify the preferred language for 
this MAS:

a. Click Start > Programs > Avaya Modular Messaging > Languages.

b. On the Modular Messaging User Properties screen, select the Preferred 
language from the drop-down list.

c. Click OK. 

2. Verify that Modular Messaging service is started as follows: 

a. Double-click the Monitor icon on the desktop. 

b. Click Services (Local) in the left-hand pane if it is not already selected.

c. In the right-hand pane, scroll down to MM Messaging Application Server.

d. Check the Status column.

(1) If the status is Started, continue with step 3.

(2) If service is not started, right-click MM Messaging Application 
Server and select Start.

The system begins a messaging service startup. 

e. Track startup progress as follows:

(1) In the left pane, expand Event Viewer (Local), then click 
Application.

(2) Refresh the window periodically until you see Telephony User 
Interface event 1241, �TUI service has been enabled.� You can 
now proceed.

f. When service is restarted, close or minimize this window.

3. Click Start > Programs > Avaya Modular Messaging > Voice Mail 
System Configuration. 

Note: When you restart messaging service, the Monitor window 
immediately shows a status of Started. However, service 
may actually take several minutes to start, depending on the 
number of port boards installed and the integration method. 
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The Voice Mail System Configuration window appears. All MASs 
present in the messaging system are listed. 

4. On MAS#1: Double-click Telephone User Interface.

a. On the General tab, set the �Number of Digits in a Mailbox� to match the 
number of digits in the extension numbers on the customer�s PBX. See 
Required switch and messaging information on page A-12.

b. Click the Subscriber tab. 

(1) If prompted that your extension number changes will invalidate all 
previous mailboxes, click Yes.

(2) Verify that �Login Failures before Mailbox Lockout� is 18. 

c. Click OK to close this window.

5. To set up Call Me service: Do this procedure if the optional Call Me 
Server is installed on any MAS. See the MAS features list on page A-11.

a. Double-click Call Me.

b. In the Call Me - Voice Mail Domain window, on the General tab, check the 
box to Enable Call Me.

c. For Call Me server, specify the MAS on which the Call Me software is 
installed (such as ZIPPY). If this field is blank:

(1) Click the ... button next to the field.

(2) In the Select Computer window, double-click the name of the MAS 
that has Call Me installed (such as ZIPPY).

(3) Click OK to close this window.

6. To set up MWI service: Do this procedure if the optional Message 
Waiting Indicator Server is installed on any MAS. See the MAS features 
list on page A-11.

a. Double-click Message Waiting Indicator.

b. In the Message Waiting Indicator - Voice Mail Domain window, on the 
General tab, check the box to Enable Message Waiting Indicator (MWI).

Note: Do the steps in this section under the voice mail domain, not 
under a specific MAS.

Although you are prompted to restart service several times 
during this procedure, you actually need to restart service only 
before entering the port board extension numbers in 
"Configuring MAS-specific parameters" on page 4-46 and at 
the end, when configuration is complete.
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c. For MAS MWI server, specify the MAS on which the MWI software is 
installed (such as ZIPPY). If this field is blank:

(1) Click the ... button next to the field.

(2) In the Select Computer window, double-click the name of the MAS 
that has MWI installed (such as ZIPPY).

d. In the �Messaging Application Servers that support MWI� box, list all MAS 
servers that support MWI. To add a server�s name:

(1) Double-click inside the top of the big list box, or click the Add 
(dashed-box) button just above the list box.

(2) A data entry field and ... button appear in the list box. Click the ... 
button.

(3) In the Select Computer window, double-click the name of each 
MAS that supports MWI (such as ZIPPY and ZORRO).

(4) Click OK. 

e. Click OK to close this window.

7. To set up fax service: Do this procedure if the optional Fax Sender 
Server is installed on any MAS. See the MAS features list on page A-11.

a. Double-click Fax.

b. In the Fax - Voice Mail Domain window, on the General tab:

(1) Check the box for Fax Enable.

(2) Next to MAS Fax Sender server, click Browse.

(3) In the Select Computer window, double-click the name of the MAS 
on which the Fax Server software is installed. See the MAS 
features list on page A-11.

(4) For Fax Mailbox, enter the extension for the fax mailbox (this 
mailbox must be set up on the MSS as well). See the Required 
switch and messaging information on page A-12.

(5) For Company Fax Number, enter the externally diallable number 
that callers should use to send faxes to subscribers. This number 
also appears on any outgoing fax cover page.

c. Click the Advanced button.

(1) In the Advanced Fax window, change the Max Concurrent 
Outgoing Calls number to a customer-specified number to allow 
faxes to be sent. See the MAS features list on page A-11.

(2) Adjust any other options if required.
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(3) When finished, click OK to close this window.

d. Click OK to close the Fax - Voice Mail Domain window.

e. In the Voice Mail System Configuration window, expand Security.

f. Double-click Messaging Servers Administration.

g. In the Message Servers - Voice Mail Domain window, on the Message 
Servers tab:

(1) The Credentials list shows entries for LDAP, IMAPI, and IMAP4. 

(2) Click the key button above the list to add a new entry for fax.

The FAX value should appear in the box.

(3) Click in the Password column next to the new Fax entry.

(4) Type the password for the fax mailbox and press Enter. This 
value must be numeric (see the Required switch and messaging 
information on page A-12).

(5) Click OK to close this window.

8. On MAS#1: Set up access permissions for Modular Messaging 
administration as follows: 

a. In the Voice Mail System Configuration window, expand Security (if not 
already expanded). 

b. Double-click System Administration.

(1) In the Permissions for System Administration window, verify that 
the Modular Messaging service account (such as mmacct) is 
already listed. Click Add.

(2) In the Select Users, Computers, or Groups window, scroll down to 
Domain Admins. Double-click it, then click OK. 

(3) Click OK to close this window.

c. Double-click Subscriber Administration.

(1) In the Permissions for Subscriber Administration window, click 
Add.

(2) In the Select Users, Computers, or Groups window, scroll down to 
Domain Admins. Double-click it, then click OK.

(3) Click OK to close this window.
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9. On MAS#1: If multiple languages or the optional Text-to-Speech feature 
are used at this site, double-click Languages. Do the following in the 
Languages - Voice Mail Domain window:

a. For Primary Language, select the primary prompt set to be used at this 
site. See the MAS features list on page A-11.

b. If the Text-to-Speech (TTS) feature is used at this site: 

(1) Check the box to enable Enable Multilingual Text to Speech. 

(2) In the list box, check all the languages to use for TTS at this site. 
See the MAS features list on page A-11.

c. Click OK to close this window.

10. To set up the optional offline access feature: Do this procedure on any 
MAS. 

a. Double-click Messaging.

b. In the Messaging - Voice Mail Domain window, click the Offline Access tab.

c. Check the box to Enable offline access to messages.

d. If multiple MASs are installed, check the box to Synchronize offline 
messages with remote store. Click Browse to select an existing, shared 
directory in the domain for the remote offline message store. See item 6 on 
the Modular Messaging MAS planning form on page A-6. 

e. Alter any other parameters on this screen as needed. See the Avaya 
Modular Messaging Software Messaging Application Server Administration 
guide (PDF 3 MB) on the documentation media for details. 

11. On MAS#1: Double-click Serviceability. Enter the following in the 
Serviceability - Voice Mail Domain window:

a. On the General tab, select the type of alarming to be used on this voice 
mail domain for the Modular Messaging system: INADS, SNMP, or none. 

b. If alarming is activated, enter the unique product ID for this system. See 
Services information on page A-13 for this number. 

Note: If the offline message store is to be on a machine other than an 
MAS, the share must be mapped as a network drive on this 
MAS. See the Administration guide (PDF 3 MB) for details. 

Note: If SNMP alarming is selected, INADS alarming on the MSS 
must be disabled. See "Disabling MSS alarm origination for 
SNMP alarming" on page 5-17.

If no modem is present, INADS alarming is not available. 
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c. Generally, you can accept the default values for the following parameters, 
unless directed otherwise: 

! The conditions for sending an alarm notification

! The alarm level at which notification will be sent (minor or major)

! The system behavior for stopping Modular Messaging service

d. If you selected SNMP alarming, click the SNMP tab. See SNMP alarming 
information on page A-14 to enter the required values. 

! For Network Management Station, specify the corporate 
network management system (NMS) that will monitor the Modular 
Messaging system for alarm notifications (traps). Either type the 
IP address or fully qualified domain name for the NMS in the field, 
or click Browse to navigate to and select the appropriate NMS.

!  For Context (community), enter the name of the context or 
community to which the NMS belongs (such as public).

!  For Acknowledgement type, select either Return trap (to have 
traps actively acknowledged) or Ping surround (to send a ping to 
the NMS before and after sending a trap to assume trap receipt). 

e. Click OK to close this window.

12. On MAS#1: Install the license for this system as follows: 

a. To obtain a license, in the Voice Mail System Configuration window, 
right-click Licensing and select Copy Host ID to Clipboard. 

b. Open a text editor application such as Notepad and Paste the ID into the 
file. This is the unique ID for this voice mail domain (system). 

c. Include the following information in the same file: 

(1) The platform (Microsoft Exchange)

(2) Whether this is a new installation or an upgrade (for upgrades, 
specify the release you are upgrading from) 

(3) The number of seats (voice mail-enabled user mailboxes) 
purchased for the system

(4) The maximum number of concurrent sessions of text-to-speech 
conversion purchased for the system

Note: The procedure for obtaining a license file varies. Follow your 
local procedures for obtaining a license for this system.

You can continue administering the system while a license is 
being generated. Return to this procedure after the license is 
received to install the license.
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(5) Specify the text-to-speech engine (such as Fonix DECtalk US 
English, ScanSoft Realspeak Any Language, or ScanSoft 
TTS-3000 International). 

(6) The installer�s name and contact information (telephone number 
and email address)

d. Notify the appropriate Modular Messaging remote support center and 
transmit the file as directed (through email, FTP, and so on). 

e. Continue the installation while the remote support center generates and 
transmits back a valid license for this system. 

After the license is obtained, install it as follows: 

a. In the Voice Mail System Configuration window, right-click Licensing and 
select Import License. 

b. On the License Import Wizard welcome screen, click Next.

c. On the Importing the License screen, click Browse. 

d. Navigate to the location where the license file is stored. 

e. Double-click the appropriate *.xml license file. Click OK. 

f. Click Next to install the license.

g. When the wizard completes, click Finish. 

h. In the Voice Mail System Configuration window, double-click Licensing.

i. On the Licensing - Voice Mail Domain properties screen, on the General 
tab, verify that the correct values for this customer are displayed.

j. Click the Text-to-Speech tab. Every MAS in the voice mail domain is listed. 

(1) For each MAS, double-click the TTS link, such as �Text to speech, 
ScanSoft RealSpeak, Any Language�. 

(2) On the Edit Sessions screen, enter the number of TTS sessions 
required for this MAS (for example, 2 sessions per MAS). See the 
MAS features list on page A-10. 

(3) When finished, click OK. 

k. Click OK again to close the Licensing properties screen.

13. On MAS#1: Set up the PBX service for the system.

a. In the Voice Mail System Configuration window, right-click PBXs and select 
Add New PBX Type.

b. For Telephony Type, select the type of port board that is installed in this 
MAS (such as Dialogic Analog).
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c. In the PBXs scroll box, select the type of switch integration that you have 
(such as Dialogic Avaya G3 CLAN).

d. Click OK to close this window.

e. In the Voice Mail System Configuration window, expand PBXs.

f. Double-click the PBX entry you just added.

g. Using the configuration notes for your PBX or switch, set up the specific 
PBX parameters required for this integration of the system. 

Configuring MAS-specific parameters

After the domain-wide parameters have been configured, set up the port boards and 
features specific to this MAS. 

To specify MAS-specific parameters: 

1. In the Voice Mail System Configuration window, expand Messaging 
Application Servers. See item 1 on your S3400-family system planning 
form on page A-6 for MAS names. 

a. For MAS#1: The first time you access this item, a Telephony Configuration 
Wizard runs to help you set up the basic PBX integration details for all 
MASs in this domain. Complete the wizard as prompted. 

b. For a subsequent MAS: Right-click the server name (such as ZORRO), 
then select Telephony Configuration Wizard to run the wizard. Complete 
all steps in the wizard as prompted. 

2. When the wizard completes:

a. Expand Messaging Application Servers again, then expand the directory 
for this server�s name. 

b. Check your configuration notes and add any additional detailed data that 
are dependent on the switch and the integration type.

3. When the configuration note programming is complete, restart service 
as follows: 

a. Double-click the Monitor icon on the desktop.

Note: Even though you are using the configuration notes for your PBX or 
switch to do many of these steps, read through this section to get 
an overview of the whole configuration procedure.

Note: If the wizard does not start automatically, right-click the server 
name (such as ZIPPY), then select Telephony Configuration 
Wizard.
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b. Click the Services (Local) item in the left-hand pane if it is not already 
selected.

c. In the right-hand pane of the Monitor window, scroll down to MM 
Messaging Application Server. Right-click it and select Stop. 

d. When service is stopped, right-click MM Messaging Application Server 
again and select Start.

The system begins a messaging service startup. 

e. Track startup progress as follows:

(1) In the left pane, expand Event Viewer (Local), then click 
Application.

(2) Refresh the window periodically until you see Telephony User 
Interface event 1241, �TUI service has been enabled.� You can 
now proceed. 

f. When service is restarted, minimize the Monitor window.

4. In the Voice Mail System Configuration window, expand Messaging 
Application Servers. 

a. Expand the entry for this MAS (such as ZIPPY). 

b. Double-click Telephony Interface. Configure the port boards in this MAS. 
Use your configuration notes. See the Required switch and messaging 
information on page A-12 for port board extensions.

c. Click PBX Type. Select the same type of PBX service as you did in step 13 
for "Configuring domain-wide features" on page 4-38. Make sure the entry 
in the PBXs box is highlighted, and click OK. 

d. Click PBX Integration and configure the integration type for your system. 
Use your configuration notes to specify or confirm the detailed settings 
required by your switch integration.  

e. If multiple port groups are used, double-click Port Groups. See the 
Required switch and messaging information on page A-12 for details. 

Note: When you restart messaging service, the Monitor window 
immediately shows a status of Started. However, the service 
may actually take several minutes to start, depending on the 
number of port boards installed and the integration type.

Note: Some values may already be set. Follow the configuration 
notes for your PBX integration.

Note: To set the maximum number of MWI sessions allowed at one 
time, see MAS features list on page A-11.
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f. If INADS alarming is used, double-click Serviceability to set up dial-out 
information for this MAS. See INADS alarming information on page A-13. 

(1) For COM port, select the communications port that the modem 
should use to initiate calls for alarm notification. This is typically 
COM3 if you used the recommended USB port A on the MAS.

(2) For Phone number, enter the complete telephone number that 
the modem must dial to place an alarm notification with the 
remote service center. Include any special characters needed (for 
example, to access an outside line, insert pauses, and so on). 

(3) For Modem setup, enter the modem initialization (setup) string if 
required for the modem to make alarm notification calls. 

(4) Click OK to close this window. 

5. When configuration is complete, restart service again (see step 3). 

6. When finished, close all open windows.
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Completing initial MAS administration

This section covers the final steps for completing initial administration of this MAS.

Setting up and starting messaging services

To allow the Modular Messaging (MM) services to restart automatically during normal 
operation, and to start messaging services:

1. Click Start > Run.

2. In the Run box Open field, type the following and press Enter:

C:\Avaya_Support\Scripts\serverrecovery.vbs 

The script takes a few seconds to run. When it completes, all installed 
MM services will be started.

3. Optional. To verify that all services are started: 

a. Double-click the Monitor icon on the desktop.

The Services (Local) item in the left-hand pane should be selected.

b. In the Monitor window, scroll down to the list of Modular Messaging (MM) 
services. Make sure that the Status column shows that service is started for 
each installed messaging service.

c. If service is stopped or the Status column is blank, right-click the 
appropriate MM service and select Start.

Verifying alarming setup 

Run the following test to verify that alarm notification is working:

1. Click Start > Run.

2. In the Run box Open field, type cmd and press Enter.

3. In the command prompt window, type the following and press Enter:

testaom -v
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4. Check that the last line of the test reads:

Alarm origination test successful 

Continue with administration as required

Continue with administration as required based on the number of MASs in the system:

! If you have another new MAS to install (up to four may be present), 
return to "Setting up the MAS" on page 4-3. Follow the instructions in 
each section for setting up each additional MAS. 

! If all your MASs are now installed, continue with Chapter 5, ��Completing 
initial administration,�� and complete all steps in order.

Note: For instructions on accessing the MAS alarm or error logs, see the 
Avaya Modular Messaging Software Messaging Application Server 
Administration guide (PDF 3 MB) on the documentation media. 
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5
Completing initial administration

This chapter describes how to complete initial administration on the Message Storage 
Server (MSS) and each Messaging Application Server (MAS) to bring the S3400-family 
system into full service.  

Note: Before you can successfully complete the tasks in this section, you 
must have successfully completed the installation tasks in Chapter 
4, ��Administering the Avaya MAS.�� 

Section Page

Completing required administration on the MSS 5-2

Performing acceptance tests 5-9

Removing the test subscriber on the MSS 5-13

Setting up remote access on the MSS 5-14

Backing up the system (MAS and MSS) 5-18
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Completing required administration on the MSS

After you complete the initial administration of all Avaya MASs in your S3400-family 
system, you need to return to the MSS-S or MSS-H to complete the basic messaging 
administration, set up test subscribers, and perform acceptance tests. The amount of 
remaining administration required varies depending on the optional features that the 
customer has chosen to implement. 

Displaying the MSS

Log back in to the MSS as follows: 

1. Switch the monitor to show the MSS.

! For a Belkin OmniView Pro2 KVM: Press slowly in sequence Scroll 
Lock, then Scroll Lock, then the down arrow key to change to the 
MSS (usually connected to port one).

! See "Switching the monitor to show the correct server" on page 4-3 
for more information if needed.

You rebooted the MSS at the end of Chapter 3, ��Powering up the system 
and performing initial MSS administration.�� You need to relogin now.

2. You should see a �Press Enter to return to prompt...� message. Press 
Enter. 

3. At the login prompt, log in to the MSS as craft using the current 
password.

The server displays the Messaging Administration main menu. 

Administering Internet messaging

Activate Internet messaging before load is running or when server usage is low.

To activate Internet messaging:

1. Starting from the Messaging Administration main menu, select:

Feature Administration
Internet Messaging

General Options and Settings

The General Options and Settings screen appears.

2. Click the Yes radio buttons to enable POP3 and IMAP4. (The 
pushbuttons look dark when they are on.)
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Enabling these protocols allows other clients such as Microsoft Outlook 
to access their mailboxes using these protocols.

3. Click Submit to save your changes. 

4. Click Return to Main.

Updating MAS host information 

Host information for each MAS must be entered and then sent to all machines in the 
S3400-family system. See your S3400-family system planning form on page A-6 for 
system information. 

To update the host information for one or more MASs:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
TCP/IP Administration 

MAS Host Information Setup

The MAS Host Information Setup screen appears. 

2. Select the MAS whose information you want to change (MAS1 through 
MAS4). Click Edit. 

3. On the MAS Host Information Setup screen, update the host information 
to identify this MAS on the corporate and private networks:

a. Public System Name is the corporate fully qualified domain name or 
FQDN of the MAS (such as zippy.loc.avaya.com). See item 7 on your 
S3400-family system planning form on page A-6. 

If this name has a domain qualifier (such as loc.avaya.com), then you 
should include just the host name (such as zippy) as an alias.

b. Public IP Address is the corporate IP address of the MAS (see item 8 on 
your planning form).

c. Public Aliases must include at least the following:

! The host name of the public MAS system name (such as zippy for 
zippy.loc.avaya.com). See item 1 on your planning form.

! Any other required aliases. Separate names with a space.

d. Do not change any information in the Private System Name and Private IP 
Address fields for a new system.

Note: A security certificate acceptance dialog box may appear when 
you make changes to this screen. Use the default values to 
accept the certificate, and then proceed.
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e. Private Aliases must include the private FQDN for the private network 
(such as zippy.zodiac.com). See item 5 on your planning form.

4. For Administrator Login, enter the MAS domain administration 
account login (such as dom-admin) and its password to make any 
changes. See item A1 on the MAS logon accounts form on page A-10.

5. When finished, click Save.

The MSS updates its internal information, and then sends this 
information to all MASs in the network.

! The system reports whether or not the information was successfully 
updated. Check that all machines in the network were updated.

! If an update to a machine failed, check your network operation using 
a ping test as follows: 

(1) Click Return to Main.

(2) Starting from the Messaging Administration main menu, select:

Diagnostics
TCP/IP Diagnostics 

Send & Receive Packets To & From (Ping Test)

(3) On the ping test screen, enter the name or IP address of the failed 
MAS to establish connectivity. 

(4) Repeat the test as needed to try to isolate the problem.

(5) Once the problem is corrected, try to send the host information 
again using the MAS Host Information Send screen (under Basic 
System Administration > TCP/IP Administration).

6. Continue as follows:

! If you have one MAS, click Return to Main.

! If you have more than one MAS:

(1) Click Back, then click Back again to return to the MAS Host 
Information Setup screen.

(2) Repeat steps 2 through 5 for every MAS in this system.

(3) When finished, click Return to Main. 

CAUTION: It is strongly recommended that you do not change any 
default private host information (such as the private host 
machine name or its IP address). A change to these values 
could prevent the system from working.

!
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7. If you changed a private MAS IP address (NOT recommended), you 
must synchronize the time on the MSS and MAS servers as follows: 

a. Log in to the MAS whose private IP address changed. 

b. Click Start > Run to open a Command prompt window.

c. In the Run box, type the following in the Open field and press Enter:

C:\Avaya_Support\cmd\time.bat 

The clocks on the message servers will soon show the same time.

Placing the MSS in the Windows domain

The MSS must be added to the Windows domain that you set up on the MAS. 

To add the MSS to the Windows domain:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
TCP/IP Administration 

Windows Domain Setup

The Windows Domain Setup screen appears. 

2. Enter the following information in each field:

a. For Eth1 NetBIOS Name, type the MSS private system name mss1 (see 
item 13 on the S3400-family system planning form on page A-6).

b. For NetBIOS Domain Name, type the Windows NetBIOS domain name 
(such as zodiac) that was created on MAS#1 (see item 3 on your planning 
form).

c. For Fully Qualified Domain Controller Name, type the MAS host name 
for MAS#1, such as zippy (see item 1 on your planning form). 

d. For Domain Controller Administrator, type the domain administrator 
account name (such as dom-admin). See item A1 on the MAS logon 
accounts form on page A-10. 
 

e. For Domain Controller Administrator Password, type the password for 
this account.

3. When finished, click Save.

CAUTION: This same account must be used to set up system backups 
on every MAS (see "Backing up the system (MAS and 
MSS)" on page 5-18).

!
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4. Click Return to Main.

Administering special mailboxes and classes of service

You need to administer a class of service that will be used for the PostMaster and fax 
mailboxes and for the required test subscribers. Use the Required switch and 
messaging information on page A-12 to complete the information in this section. 

To set up a new class of service and the required mailboxes:

1. From the Messaging Administration main menu, select:

Global Administration
Subscriber Management

Manage Classes-of-Service

The Manage Classes-of-Service screen appears. 

a. Select the class of service to modify (such as class00). You may set up 
different classes of service if required (for example, you may use a different 
class of service for the PostMaster and fax-enabled subscribers).

b. Click Edit the Selected COS.

c. On the Edit a Class-of-Service screen, scroll down to Subscriber Features 
and Services. Activate the following features:

(1) Set Outbound Fax Calls to Yes (required for fax service).

(2) Set Record Mailbox Greetings to Yes.

(3) Adjust other feature values if directed. Generally, you enable 
features that you have installed and must test.

d. When finished, click Save.

e. Click Back to return to the Managing Subscribers screen. 

2. Set up the mailbox for the subscriber who is to receive PostMaster 
messages. Use the name and extension specified on the Required 
switch and messaging information on page A-12. 

a. On the Managing Subscribers screen, next to the Local Subscriber 
Mailbox Number field, click Add or Edit.

Note: Typically an existing subscriber such as the system administrator is 
set up to receive postmaster messages. If the PostMaster 
message volume is large, you may set up a secondary mailbox for 
a subscriber to receive postmaster messages, but that secondary 
mailbox must be checked regularly (on a daily basis if possible).
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b. On the Add Local Subscriber screen, enter the following information:

(1) In the Last Name field, type the last name of the subscriber who is 
to receive the postmaster messages.

(2) In the First Name field, type the subscriber�s first name.

(3) Enter the subscriber�s mailbox password (see the planning form).

(4) In the Mailbox Number field, type a valid mailbox extension 
number; enter 3-to-10 digits as required by your dial plan. 

(5) In the Numeric Address field, type a unique number for that 
mailbox in the network. For example, you could prepend a 1 or the 
area code to the mailbox number.

(6) Select the required class of service.

c. Scroll down and click Save.

3. If fax service is installed: Set up the required fax service mailbox using 
the Required switch and messaging information on page A-12.

On the Managing Subscribers screen:

a. Click Add or Edit.

b. On the Add Local Subscriber screen, enter the following information:

(1) In the Last Name field, type fax.

(2) Enter a password (see the planning form).

(3) In the Mailbox Number field, type a valid mailbox extension 
number. This number should not be a real telephone extension on 
your system, or the fax feature will not work correctly.

(4) In the Numeric Address field, type a unique number for that 
mailbox in the network.

(5) Select the required class of service.

c. Scroll down and click Save.

4. From the Managing Subscribers screen, select:

Configure Subscriber Management

The Configure Subscriber Management screen appears. 

a. In the System Mailboxes section:

(1) For the Fax Mailbox Number, enter the extension for the Mailbox 
Number that you used in step 3. 
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(2) For the Internet Postmaster Mailbox Number, enter the 
extension for the Mailbox Number that you used in step 2.

b. Click Save.

You return to the Managing Subscribers screen.

Adding a test subscriber

You need to set up at least one local subscriber to test the system. 

To add a test subscriber:

1. From the Managing Subscribers screen, next to the Local Subscriber 
Mailbox Number field, click Add or Edit.

The Add Local Subscriber screen appears. 

2. Fill in the fields in the Subscriber Information section as shown in Table 
5-1 on page 5-8. Use the Required switch and messaging information on 
page A-12 for mailbox extension numbers and passwords.

Click Help if you need details about completing any fields on this screen. 

3. When finished, scroll down and click Save. 

4. Click Return to Main.

Table 5-1. Subscriber screen sample settings

Field Setting

Last Name Smith

First Name Test

Password 1111 (must comply with minimum password length)

Mailbox Number Type a valid mailbox extension number; enter 3-to-10 digits 
as required by your dial plan.

COS 0 (Use the one you modified or as directed; it must have all 
the features that you need to test activated.)

Numeric Address Type a unique number for that mailbox in the network (for 
example, you could prepend a 1 or the area code to the 
mailbox number)
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Performing acceptance tests

After installing the system, verify that it is working correctly by doing the following tests. 
 

Creating and sending a call answer message

The following test works only if call-coverage has been assigned on the switch to route 
unanswered calls to the test subscriber�s extension.

To create and send a call answer test message:

1. Call the test-subscriber extension from any other telephone. Allow the 
S3400-family messaging system to answer.

2. Speak into the telephone and record the following or a similar test 
message after the tone:

�This is a test call answer message.�

3. Hang up the telephone to disconnect. 

Retrieving test messages in integrated mode

Test the fully integrated operation of the system as directed below. You need access to 
the actual telephone whose extension number is assigned to the test-subscriber 
mailbox to perform this test. 

To verify the receipt of your test messages in integrated mode:

1. If MWI is installed: Check the message waiting indicator (MWI) on the 
test-subscriber telephone. The MWI may be a light, a screen display, or 
a dial-tone stutter when you pick up the phone. 

If the MWI does not indicate that a call was received:

a. Check that the Mailbox Monitor and MWI services are started. Double-click 
the Monitor icon on the MAS desktop, then scroll down to these MM 
services in the right-hand pane and verify status. If needed, select Start.

CAUTION: You must wait about 1 minute for the MSS and MAS to 
synchronize their data after adding any test subscribers. 
Otherwise, the acceptance tests will not run correctly.

!

Note: The message-waiting lamp may take up to 1 minute to light on 
the appropriate telephone after a test message is sent.
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b. If service is started, check for a problem with the test subscriber 
administration, the switch integration or switch integration software, or the 
switch number administration for the test telephone. 

2. From the test-subscriber telephone, dial the Modular Messaging 
messaging system message retrieval number.

The system voices the test subscriber�s name.

3. Enter the password for this mailbox and press . 

4. The first time you access this mailbox, you answer a series of prompts to 
set up the mailbox for operation. Answer all voice prompts as directed.

5. After the mailbox is set up, press  to review your new messages.

6. Press  to retrieve a voice message.

7. Listen to the message. If the message does not play properly, contact 
your remote support center.

8. Press  to erase this message.

9. Follow the voice prompts to retrieve the next message (if any), or press 
 to return to the main menu.

10. Hang up the telephone to disconnect when finished.

11. If MWI is installed: Check the MWI on the test-subscriber telephone. The 
MWI should be off. If it is not off, check your MWI administration on the 
MAS and the PBX. 

Creating and sending a test message in nonintegrated mode

To create and send a test message in nonintegrated mode: 

1. Dial the Modular Messaging messaging system message retrieval 
number from any telephone that is not administered on the system.

The system voices the �Welcome to Avaya Messaging� prompt.

2. Press  to skip the system introduction. 

3. Enter the extension number for test-subscriber mailbox and press .

4. Enter the password for this mailbox and press . 

5. Press  to create a new message.

6. Speaking into the telephone, record the following or a similar test 
message after the tone.

 �This is a test voice mail message.�

#

1

1

7

*

#

#

#

2
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7. Press  to approve your message.

8. Enter the mailbox number for the test subscriber when prompted for the 
extension, followed by .

9. Press  twice (as prompted) to approve the message.

10. Press  again to send the test message to the test-subscriber mailbox.

11. Hang up the telephone to disconnect. 

12. Retrieve the message as described in "Retrieving test messages in 
integrated mode" on page 5-9.

Creating and printing a fax message

Do this test if the Fax Sender Server is installed. 

To create and send a test fax message:

1. From a fax machine, send a fax to the test-subscriber mailbox. This 
subscriber mailbox should have been set up to be fax enabled.

2. Wait a few minutes for the fax to be delivered. The MWI lamp (if present) 
on the test-subscriber telephone should light.

3. From the fax machine, dial the Modular Messaging messaging system 
message retrieval number for that telephone.

4. Press  to access the test subscriber�s mailbox. 

5. Enter the extension number for the test-subscriber mailbox and press 
.

6. Enter the password and press .

7. Press  to retrieve new messages.

8. Press  to retrieve the fax message.

9. When the prompt finishes, press  to print the fax.

10. Press  to print the fax at this fax machine.

11. Press the Start key on the fax machine. 

12. Verify that the fax prints correctly. The call is then disconnected.

13. If MWI is installed: Check the MWI on the test-subscriber telephone 
again. The MWI should be off. 

#

#

#

#

*

#

#

1

3

2

3
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Testing the outcalling capability

Test the outcalling capability of the system using the Subscriber Options package. 

To test system outcalling:

1. Switch the monitor to show the appropriate MAS. See "Switching the 
monitor to show the correct server" on page 4-3 if needed.

2. Install the Subscriber Options package: 

a. Navigate to the directory C:\MM_Install\Client Distrib

b. To install the new software, double-click the Install.exe file. 

3. To run the Subscriber Options package, click Start > Programs > Avaya 
Modular Messaging > Subscriber Options.

4. In the User Logon window:

a. Enter the mailbox number and password for the test subscriber. See 
Required switch and messaging information on page A-12.

b. Use the host name for MAS#1 (such as ZIPPY). See item 1 on the 
S3400-family system planning form on page A-6.

c. Click OK.

5. Play back the spoken name to test outcalling as follows:

a. In the Modular Messaging Software User Properties window, click the 
Record Greetings tab.

b. Under Standard Greetings, click the Spoken Name radio button.

c. Verify that the telephone will be used for name playback:

(1) Check the icon to the left of the status display. If it shows a 
telephone, continue with step d.

(2) If the icon shows a terminal, right-click and select Telephone. The 
icon changes to show a telephone. Continue with step d.

d. Click the Play button (large black single arrow) on the player near the 
bottom of the window. 

e. Answer the telephone when it rings. 

The picture of the phone should change to become off-hook. 

f. Listen for the system to play the spoken name of the test subscriber. 

g. Hang up the telephone. 

The picture of the phone should change back to being on-hook (this 
may take a couple of seconds).
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6. When finished, click OK to close the Modular Messaging Software User 
Properties window.

Running additional tests

You may want to run additional tests to verify the correct operation of features that are 
particularly important to the customer. For example:

! Automated Attendant

! Call Me

! Find Me

! Octel Analog Networking

To test these or other features, see the Avaya Modular Messaging Software Messaging 
Application Server Administration guide (PDF 3 MB) on the documentation media for 
feature setup and operation instructions. 

Removing the test subscriber on the MSS

When acceptance testing is completed, remove the test subscriber as follows:

1. Switch the monitor to show the MSS if needed. See "Switching the 
monitor to show the correct server" on page 4-3. 

2. Starting from the Messaging Administration main menu, select:

Global Administration
Subscriber Management

3. On the Managing Subscribers screen, next to Local Subscribers for 
this MSS machine (such as zigzag), click Manage.

The Manage Local Subscribers screen appears. 

4. Select the test subscriber.

5. Click Delete the Selected Subscriber. 

6. Click Return to Main.
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Setting up remote access on the MSS

Complete remote access administration on the MSS as follows: 

! If INADS alarming is used at this site, complete the steps in this section 
to allow a remote service center to dial in to the MSS to perform 
troubleshooting or system maintenance.

! If SNMP alarming is used at this site, continue with "Disabling MSS 
alarm origination for SNMP alarming" on page 5-17. 

Administering PPP logins and passwords for INADS alarming

It is necessary to administer point-to-point protocol (PPP) logins and passwords for all 
INADS-supported systems to support remote maintenance. See PPP logins, 
passwords, and IP addresses on page A-13 for required PPP logins and passwords.

To administer PPP logins:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
Password Administration

Assign/Change Password

The Assign/Change Password screen appears.

2. At the Login drop-down box, select the PPP login that you want to 
administer (for example, sappp). 

3. For New Password, enter the appropriate PPP password. See PPP 
logins, passwords, and IP addresses on page A-13 for passwords.

4. For Re-enter New Password, type the PPP password again for 
verification.

5. Click Save.

The system displays a confirmation message. 

6. Click the Back arrow in your web browser to return the Assign/Change 
Password screen.

7. Complete steps 2 through 6 for each additional PPP login that needs 
administration.

8. When finished, click Return to Main.
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Activating the RMB modem for INADS (external modems only)

The on-board modem for the model of RMB installed in the United States is 
automatically activated. However, international users must activate the external 
modem that is required for INADS alarming through their RMB boards. 

To activate the modem for an external RMB board:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
Modem and Terminal Administration

Install Modem/Terminal Software

The Install Modem/Terminal Software screen appears.

2. Locate Device Type RMB and update the fields for the modem you are 
using. Click Help for information about completing each field. 

3. When finished, click Save.

4. Click Return to Main.

Setting up the PPP server configuration for INADS alarming

Use this page to identify the local and remote IP addresses that are required for remote 
access to the system.

To set up PPP service on this machine:

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
TCP/IP Administration

PPP Server Configuration

The PPP Server Configuration screen appears.

2. For each login account that you are to administer, enter the following 
information. See PPP logins, passwords, and IP addresses on page 
A-13.

a. For Local IP Address, type the customer-provided IP address for PPP 
access through the MSS modem. 

b. For Remote IP Address, type the customer- or Services-provided IP 
address for the remote device that will connect to this MSS. 

3. Repeat step 2 for each of the PPP logins you need to set up.

4. When finished, click Save.
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5. Click Return to Main.

Specifying MSS alarm origination

Activating alarm origination causes an entity such as the remote service center to 
receive notification of alarms that occur on the S3400-family system. Alarm notification 
through the MSS can only occur if the maintenance modem for the RMB is installed 
and active, and if INADS alarming is enabled for the voice mail domain at this site.  

Activating MSS alarm origination for INADS alarming 

To use INADS alarming, set up alarm origination through the MSS as follows: 

1. Clear all alarms.

2. Insert a labeled writable DVD into the DVD drive for the nightly backup. 
The backup disk must be in place before you activate alarm origination.

3. Starting from the Messaging Administration main menu, select:

Basic System Administration
Alarming Administration

The Alarm Management screen appears.

4. Provide the Product ID and Alarm Destination telephone number. See 
PPP logins, passwords, and IP addresses on page A-13.

5. Complete the remaining fields as required. Generally:

! Alarm Origination should be ACTIVE.

! Alarm Suppression should be INACTIVE.

If needed, click Help for information about completing each field. 

6. When finished, click Save. 

7. Click Return to Main.

Note: If SNMP alarming is enabled at this site, continue with "Disabling 
MSS alarm origination for SNMP alarming" on page 5-17. 
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Disabling MSS alarm origination for SNMP alarming 

To use SNMP alarming, disable alarm origination through the MSS as follows: 

1. Starting from the Messaging Administration main menu, select:

Basic System Administration
Alarming Administration

The Alarm Management screen appears.

2. Set Alarm Origination to INACTIVE. 

3. Click Return to Main.

4. Click Save. 

Testing INADS alarming 

To test INADS alarming on this system:

1. Starting from the Messaging Administration main menu, select:

Global Administration
Messaging Administration 

The system displays the administration command prompt screen and 
and the SSH dialog box.

2. Verify your login and type the password. Press Enter or click Login. 

3. At the command prompt, type test alarm and press Enter.

4. On the test alarm-origination screen, press F3 (Enter). 

5. Check the status line to verify that the command completed successfully.

6. Wait 5 minutes for the test alarm to be acknowledged and resolved.

7. Starting from the Messaging Administration main menu, select Logs > 
Alarm Log. 

8. Set the Alarm Type to Resolve. Click Display. 

9. Verify that the minor alarm VM type ALARM_ORIG was acknowledged 
and resolved. 

The alarm is resolved by MAINT in 30 minutes if the test fails. Check 
your administration to make sure you have a good connection to the 
remote service center, then retry this test. 
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Backing up the system (MAS and MSS)

As a final installation task, set up the system to perform regular, scheduled backups. 
Do an attended backup to verify the backup function. 

Setting up and running backups on every MAS

Do this task on every MAS. 

You need to send MAS backup data to the MSS (a nightly basis is recommended), so 
that it can be backed up with the rest of the system data on DVD-RAM. 

To set up a scheduled backup of data on the MAS: 

1. Switch the monitor to show MAS#1. See "Switching the monitor to show 
the correct server" on page 4-3 if needed.

2. To view the scheduled backup program for this MAS, double-click the 
Scheduled Tasks icon on the desktop.

3. In the Scheduled Tasks window, run an attended backup on this MAS as 
follows:

a. Right-click the task named MAS Backup. 

b. Select Run.

In Scheduled Tasks window, the Status column shows Running as 
the system immediately begins to back up the data on this MAS to 
the MSS. The Status column goes blank (shows nothing) when the 
backup completes.

c. Optional. To verify that the backup completed correctly:

(1) Click Start > Run. In the Open field, type \\mss1\masbackup 

You are prompted for an account name and password.

(2) In the Connect As window, use the domain administrator account 
name (such as dom-admin) and password. See item A1 on the 
MAS logon accounts form on page A-10. Click OK.

Windows Explorer launches.

(3) Confirm that a backup file has been created on the MSS with the 
correct time and date (such as ZIPPYDailyBackup.bkf, where 
ZIPPY is the host name of this MAS). You can expect an initial file 
size of approximately 264 MB. 

If a backup file has not been successfully created, check your 
configuration. Make sure that the account used to join the MSS to 
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the Windows domain matches the account that the scheduled 
task runs under (this should always be the domain administrator 
account, such as ZODIAC\dom-admin).

4. Close the Scheduled Tasks window. 

5. Repeat this procedure for every MAS in the system. 

Setting up and running an attended backup of the MSS

After you have run an attended backup of every MAS machine, run an attended backup 
on the MSS. 

See the MSS administration section on the documentation media for information on:

! Backing up system files (attended) 

! Backing up system files (unattended) 

When finished, log off of the system.

a_sysbr_2.htm
a_sysbr_3.htm
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6
Updating Modular Messaging

software

This chapter describes how to update Modular Messaging software from Release 1.0 
to Release 1.1 on the Message Storage Server (MSS) and any Avaya Messaging 
Application Server (MAS). Procedures for updating the client software on the MAS and 
any other computer where it was previously installed are also covered.  

Note: Do the tasks in this section only if you are updating the software on 
a system that is running an earlier release of the Modular 
Messaging software. 

Review the new version of the planning forms in Appendix A, 
��System planning forms,�� before beginning the software 
update. Make sure that all fields required for the new features 
are completed.

Section Page

Overview 6-2

Updating software on the MSS 6-4

Preparing the MAS for the update 6-6

Updating the Dialogic drivers 6-7

Updating software components on the MAS 6-12

Updating client software 6-16

Performing acceptance tests 6-17
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Overview

If a system running Modular Messaging software is already installed, it can be updated 
to the latest release as described in this chapter. 

Update requirements

To successfully update a Modular Messaging system, you need:

! A completed copy of all the forms in Appendix A, ��System planning 
forms,�� specifically:

� S3400-family system planning form on page A-6

� MAS logon accounts form on page A-10

� MAS features list on page A-11 

! The newest release of the Modular Messaging application software on 
DVD or CD as follows: 

� Avaya Modular Messaging Message Storage Server (MSS) Software 
CD 

� Avaya Modular Messaging Application Software for the Avaya 
Messaging Application Server (MAS) (may be on CD or DVD)

If the MAS Modular Messaging application software is provided on a 
CD, you also need the following CDs: 

! Intel Dialogic Drivers CD

! Enhanced Email Reader Software containing ScanSoft 
Text-to-Speech (TTS) software in multiple languages (3 CDs) 

! Avaya Modular Messaging Documentation CD

If the MAS application software is provided on a DVD, the DVD 
contains all of the information listed on the separate CDs above.

Note: Updating the Modular Messaging software requires several server 
restarts. Plan to do the software update during low-usage hours. 

Note: Review the new version of these forms in Appendix A, ��System 
planning forms,�� before beginning the software update. Make 
sure that all fields required for new features are completed. 
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Update procedure

The update procedure involves:

1. Updating the software on the MSS. 

2. Preparing the MAS for the update.

3. Updating the software on each of the MASs and configuring new 
features as needed. 

4. Updating the client software on each MAS and any other computer 
where it was previously installed. 

5. Performing acceptance tests on the entire system. 

Note: Completely update and test one MAS first, and let it run for 15 
minutes before updating any additional MASs. 

Note: The CD-ROM drive in a Release 1.0 Avaya MAS must be replaced 
with a DVD drive for Release 1.1. The physical mounting, cable 
connections, and jumper settings are identical between the 
Release 1.0 CD-ROM drive and the new DVD player. See the 
Change description for Modular Messaging R1.1 for details. 



585-310-332, Issue 3

Avaya Modular Messaging Release 1.1 Installation

6�4 December 2003

Updating software on the MSS

This section describes how to update the Modular Messaging software from Release 
1.0 to Release 1.1 on the Message Storage Server (MSS).  

Logging in to the server

To log in to the MSS: 

1. Switch the monitor to show the MSS.

! For a Belkin OmniView Pro2 KVM: Press slowly in sequence Scroll 
Lock, then Scroll Lock, then the down arrow key to change to the 
MSS server (usually connected to port one).

! See "Switching the monitor to show the correct server" on page 4-3 
for more information if needed.

2. At the login prompt, log in to the MSS as craft using the current 
password.

The server displays the Messaging Administration main menu. 

Updating the software

To update the MSS to the latest software release: 

1. Perform an attended backup. See �Backing up system files (attended)� 
on the documentation media for more information. 

2. Press the eject button on the front of the DVD-RAM drive and remove 
the DVD-RAM backup medium, if necessary.

3. Insert the Avaya Modular Messaging Message Storage Server (MSS) 
Software CD into the DVD-RAM drive. 

4. Starting from the Messaging Administration main menu, select:

Utilities
Software Management

Software Update

Note: This procedure requires a server restart. 

Note: When inserting the CD into the DVD-RAM drive tray, make 
sure that you place the CD solidly between the plastic clips.

a_sysbr_2.htm
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The software update screen appears. 

5. Click CD to navigate to the CD. 

6. Click Install the newer software management software. 

7. After the new software management package installs, click Continue.

The server displays a list of available packages, some of which are 
marked for installation. 

8. Click Install selected packages. 

9. The server displays a list of packages to be installed. Verify the list. 

10. The system calculates the time needed to install the new software, 
update the LDAP database, and reboot the system. Note the time 
estimate shown on the screen. 

11. Click Proceed with installation.

12. While the server is installing the software, scroll down the page 
periodically to view the installation status.

13. When the update finishes, verify that the software installed successfully. 

14. If all software was installed successfully, remove the CD from the drive. 

15. Insert a new DVD-RAM backup medium into the DVD-RAM drive to 
support the next unattended backup. 

16. Click Restart the system.

The system reboots. Proceed with updating the MAS.

Note: If you did not complete an attended backup within the past 2 
hours, the system displays a warning message. Click Cancel 
(return to Utilities menu) to cancel the software update. 
Return to step 1 and do an attended backup.

Note: You have to wait up to 1 minute before you can continue.

Note: Do not leave the CD in the drive. 

CAUTION: Do not reinsert the same DVD on which you just 
made a backup. Set the pre-update DVD aside 
until you are sure that the update is successful.

!
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Preparing the MAS for the update

Do this task on every MAS. 

This section describes how to take the Messaging Application Server (MAS) ports 
offline and prepare for the Release 1.1 Modular Messaging software update. 

Switching the monitor to show the correct server

The KVM switch is normally connected to the required MAS through the second 
computer port (VGA 02). Subsequent MASs (if present) are connected to computer 
ports VGA03, VGA 04, and VGA 05. 

To switch the monitor to show the server that you need to administer:

! For a Belkin OmniView Pro2 KVM: Press slowly in sequence Scroll 
Lock, then Scroll Lock, then the up (or down) arrow key to change to the 
server connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the up or 
down arrow key (such as 02 for port 2). See your KVM switch 
documentation for complete user instructions.

Preparing the MAS for the software update 

To prepare the MAS for the software update: 

1. The PBX administrator must make sure that the ports for this MAS are 
made busy and rerouted to other MASs using the procedures 
appropriate for your PBX. Otherwise callers into the system could hear 
ringing-no answer or a busy signal. 

2. If anti-virus software is installed, disable it while you upgrade the 
Modular Messaging software. You will enable the virus-checking 
software again after the update is complete.

3. Log in to the server using the customer-specified Modular Messaging 
(MM) account name (such as mmacct) and its password (see item A5 on 
the MAS logon accounts form on page A-10).

4. Close any open windows on the system before you begin.

5. Stop and reset all Modular Messaging (MM) services as follows:

a. Double-click the Monitor icon on the desktop.

Select the Services (Local) item in the left-hand pane if it is not 
already selected.
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b. In the right-hand pane of the Monitor window, scroll down to the set of 
installed Modular Messaging services. These all begin with MM. 

c. Double-click the first MM service to open the Properties window.

d. Set the �Startup type� to Manual. 

e. Under �Service status,� click Stop. 

f. Wait for service to stop, then click OK to close this window.

g. Repeat steps c through f for each MM service.

h. Close the Monitor window.

Updating the Dialogic drivers

This section describes how to replace the drivers for the Dialogic port boards as part of 
the Release 1.0 to Release 1.1 Modular Messaging software update.  

Preparing for driver installation

To prepare the MAS for the Dialogic driver update: 

1. If Dialogic port boards are installed, stop the Dialogic drivers as follows:

a. From the task bar, click Start > Programs > Dialogic System Software > 
Dialogic Configuration Manager - DCM.

b. At the �DCM could not detect devices� message, click OK. 

The Dialogic Configuration Manager window appears.

c. To stop the Dialogic drivers, click the red Stop Service button and wait.

d. When drivers are stopped, close the Dialogic Configuration Manager 
window.

2. For analog boards: If a custom tone file was created, it must be copied to 
the correct directory now, or it will be destroyed during the update 
process:

Note: Stop the MM Messaging Application Server service last. 

Note: If no Dialogic port boards are installed (for example, for IP H.323 
integrations), you do not need to update the drivers. Continue with 
"Updating software components on the MAS" on page 6-12. 
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a. In the Windows Explorer window, navigate to the C:\Program 
Files\Dialogic\DATA directory.

b. If any tone files are present (those with a .tsf extension), select them (use 
Ctrl+click to select multiple TSF files).

c. Right-click one of the selected files and select Copy.

d. Navigate to the C:\Avaya_Support\Tone_Files directory.

e. In the right-hand pane, right-click and select Paste to copy the .tsf files.

Uninstalling the existing Dialogic drivers

To remove the existing Dialogic 5.0.1 drivers: 

1. Insert the applications software media in the DVD drive. This is either:

! Avaya Modular Messaging Application Software DVD, or

! For a system that uses CD-ROMs, the Intel Dialogic Drivers CD. 

2. In Windows Explorer, navigate to the DVD drive (D:).

3. Locate the Dialogic files. They are at the root directory on the CD, or 
under a Dialogic Drivers subdirectory on the DVD. 

4. Double-click the file Uninstall_5_01.bat.

A command (cmd) window opens. Press any key to continue. 

5. If the Dialogic point release Ptr26599 for SR 5.01 for Windows is 
installed, this will be removed first.

a. In the dialog box, select Remove and click Next.

b. At the confirmation message to remove the point release, click OK.

c. If the system reports any files as read only, click Yes to continue with the 
removal.

d. When prompted, select �No, I will restart my computer later� and click 
Finish. 

e. Control returns to the batch file. Press any key to continue. 

6. At the �uninstall the Dialogic System Software and SDK� message, click 
Yes. 

7. When Uninstall pauses, close any open windows. Click OK.

The system stops services.

8. When prompted to Remove Shared File, select No to All.
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9. When Uninstall completes, the Remove Programs From Your Computer 
screen may show that some elements were not removed. Click OK.

10. When prompted to reboot, click Yes.

Installing the new Dialogic drivers

To install the new Dialogic 5.1.1 base release drivers: 

1. Log back in to the server using the Modular Messaging (MM) account 
name (such as mmacct) and its password.

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the DVD drive (D:), and locate the 
Dialogic files. 

5. Double-click the file Install_5_11.bat. 

The Intel Dialogic System Software and SDK for Windows System 
Release 5.1.1 for Windows wizard runs. When the installation 
completes, the system automatically reboots.

Applying the Dialogic Feature Pack

Update the new Dialogic drivers with the 5.11 Feature Pack (FP1): 

1. Log back in to the server using the Modular Messaging (MM) account 
name (such as mmacct) and its password.

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the DVD drive (D:), and locate the 
Dialogic files. 

5. Double-click the file Install_5_11_FP1.bat.

The System Release 5.1.1 Feature Pack 1 wizard launches.

6. On the Welcome screen, click Next.

CAUTION: Several files have similar names. Verify that you 
are about to select the correct file before clicking it.!
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7. On the License Agreement screen, click Yes.

8. On the Customer Information screen:

a. For User Name type Modular Messaging. 

b. Type the appropriate Company Name, then click Next.

9. On the Select Components screen:

a. Verify that the box to install the Program Files is checked.

b. Clear the checkbox to not install the Online Documentation.

c. Click Next.

10. The Start Copying Files screen appears. Click Next. 

This step may take several minutes to complete.

11. When prompted, select Yes, I want to restart my computer now.

12. Click Finish.

The system reboots.

Reconfiguring the Dialogic port boards

Finally, restore the configuration for your Dialogic boards: 

1. Log back in to the server using the Modular Messaging (MM) account 
name (such as mmacct) and its password.

2. A command (cmd) window opens, explaining which batch file to run 
next. Press any key to continue.

3. Right-click My Computer and select Explore.

4. In Windows Explorer, navigate to the DVD drive (D:), and locate the 
Dialogic files. 

5. Double-click the file Restore_Config.bat.

6. A command (cmd) window opens. Press any key to continue.

The program cleans up any temporary installation files and replaces 
certain files used by the Dialogic boards.

For a system that uses CD-ROMs, remove the Dialogic drivers CD from 
the DVD drive. 
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7. Reconfigure and test the Dialogic port boards for this MAS. See 
"Configuring and testing the port boards" on page 4-27.  

Note: Because the Dialogic Line Test application is not yet installed, 
you must insert the application software disk in the DVD drive. 
See step 2 in "Testing the port boards" on page 4-35. When 
testing is complete, continue with the next section. 
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Updating software components on the MAS

Do this task on every MAS. 

This section describes how to update the Modular Messaging software from Release 
1.0 to Release 1.1 on the Messaging Application Server (MAS). 

Updating the Modular Messaging software

To update the Modular Messaging software on this MAS to the latest release:

1. Run the Modular Messaging Installation Wizard as follows:

a. In Windows Explorer, navigate to the DVD drive (D:).

b. Navigate to the Install directory. 

c. Double-click the file Setup.exe.

The Modular Messaging - Installation Wizard launches.

2. On the main screen, verify that the Configuration drop-down box shows 
Avaya MSS.

3. All components that were previously installed on this machine are 
already selected, as well as the Diagnostic tools. Verify that all 
necessary components are checked.

4. Click Install.

Previously installed software components are updated automatically (no 
response is needed). New software components that are required for 
Release 1.1 are also installed. 

5. You may be prompted to enter information for the following components: 

! Alarming Server 

! Messaging Application Server 

The wizards for these components must be completed as follows: 

a. When one of the above server installation wizards runs, click Next.

b. When prompted, enter the following account information:

! For Domain, enter the NetBIOS name of the Windows domain 
(such as zodiac). See item 3 on the S3400-family system planning 
form on page A-6.
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! For User Name and Password, enter the Modular Messaging 
account name (such as mmacct) and its password. See item A5 
on the MAS logon accounts form on page A-10. 

! Click Next. 

c. Click Install.

d. When done, click Finish.

6. You may be prompted for additional information for other software 
components. If prompted, complete the wizards as follows: 

a. If an additional server installation wizard runs, click Next.

b. When prompted, enter name of this MAS machine (such as zippy). See 
item 1 on the S3400-family system planning form on page A-6. Click Next. 

c. When prompted, enter the password for the Modular Messaging account 
(such as mmacct). See item A5 on the MAS logon accounts form on page 
A-10. Click Next. 

d. Click Install.

e. When done, click Finish.

7. For a system that uses CD-ROMs, you are prompted to insert additional 
disks to install the RealSpeak Text-to-Speech software in multiple 
languages. When prompted to insert installation disk 2: 

a. Remove the Avaya Modular Messaging Application Software and 
Languages CD from the drive. 

b. Insert the first Enhanced Email Reader (Text-to-Speech) RealSpeak 
software CD in the drive and close the door. 

c. Wait for the drive�s green LED to go out. Click OK. 

d. After the disk is copied, you are prompted to insert the next disk: 

! Insert the next RealSpeak TTS software CD in the DVD drive.

! Repeat steps b through d for each RealSpeak TTS software CD.

Allow several minutes for the RealSpeak software to install. When 
finished, the wizard returns to the main screen. 

8. To complete the update, click Close.

9. Click Restart when prompted to restart the system now. 

10. Remove the media from the DVD drive. 
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Updating the MAS database 

To update the database on this MAS for the new Modular Messaging software:

1. When the reboot completes, log back in to the server using the Modular 
Messaging (MM) account name (such as mmacct) and its password. 

The Messaging Application Server - Configuration Wizard launches. 

It make take a few minutes to connect to the MAS.

2. On the Front End Database Update screen, click Next. 

The service starts up.

3. On the Setup Complete screen, click Finish. 

Configuring new features

After the new Modular Messaging software is installed, you must configure and activate 
new features for this release using the Voice Mail System Configuration program. 

To configure new features:

1. See "Configuring domain-wide features" on page 4-38 and complete 
steps 1 through 3. 

2. Set up the following new Modular Messaging features: 

a. Serviceability: See step 11 on page 4-43 to activate alarming for the 
system.

b. Licensing: See step 12 on page 4-44 to obtain and install the required 
license file.

c. Optional: If the Text-to-Speech (TTS) feature is used at this site, see 
Languages (step 9 on page 4-43) to activate this feature. 

d. Optional: If Offline Access to stored messages is used at this site, see 
Messaging (step 10 on page 4-43) to activate this feature. 

3. If INADS alarming is used at this site, configure it as follows: 

a. In the Voice Mail System Configuration window, expand Messaging 
Application Servers, then expand the entry for this MAS (such as ZIPPY). 

Note: This step may take several hours for a large database. 

Note: You can enable the anti-virus software on the MAS at this time. 
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b. Click Serviceability to set up INADS service. See step 4-f on page 4-48 
under Configuring MAS-specific parameters for details. 

Setting up and starting messaging services

To allow the Modular Messaging (MM) services to restart automatically during normal 
operation, and to start messaging services:

1. Click Start > Run.

2. In the Run box Open field, type the following and press Enter:

C:\Avaya_Support\Scripts\serverrecovery.vbs 

The script takes a few seconds to run. When it completes, all installed 
MM services will be started. 

3. Optional. To verify that all services are started: 

a. Double-click the Monitor icon on the desktop.

The Services (Local) item in the left-hand pane should be selected.

b. In the Monitor window, scroll down to the list of Modular Messaging (MM) 
services. Make sure that the Status column shows that service is started for 
each installed messaging service.

c. If service is stopped or the Status column is blank, right-click the 
appropriate MM service and select Start.

Completing the software update

Continue the Modular Messaging software update as appropriate:

! If client software is installed on this MAS: Update the client software on 
this MAS as described in "Updating client software" on page 6-16. When 
finished, return to this section. 

! If you have more than one MAS: 

a. For MAS#1 only, let the Modular Messaging software run for 15 minutes so 
that it can update shared data across the voice mail domain.

b. Return to "Preparing the MAS for the update" on page 6-6 to begin updating 
the next MAS.

c. Repeat the Modular Messaging software update procedure through this 
section until all MASs are updated. 

! When all MASs are updated: Continue with "Performing acceptance 
tests" on page 6-17.
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Updating client software

Do this task on every MAS and every subscriber machine where client software is 
installed. 

The client software packages (such as Subscriber Options) must be updated on every 
MAS and on every subscriber�s machine where they are already installed. 

To update the client software to the latest release:

1. Log in to each MAS or subscriber machine where a client software 
package from the previous release is installed. You must use an account 
with administrator rights to install software (such as the Modular 
Messaging account or local administrator account for a client machine).

2. Install a new version of the client software. For example, to reinstall the 
Subscriber Options package: 

a. Navigate to the directory that contains the latest client software.

! On an Avaya MAS: Navigate to the directory 
C:\MM_Install\Client Distrib 

! From the Avaya Modular Messaging Application Software media: 
Insert the disk in the machine�s drive, then navigate to the 
directory D:\Install\Client Distrib 

! From the network: If the administrator has posted this software on 
an accessible share, navigate to the appropriate directory. Locate 
and execute the file Install.exe. 

b. To install the new software, double-click the Install.exe file. 

The reinstallation process removes the old software and installs the 
newest version. 

Note: Update all MASs in the system before you update the software on 
any subscriber machines. 

Note: If Microsoft Outlook is installed on the same machine where 
you are trying to install Subscriber Options, the Add-in Client 
program (which includes Subscriber Options) is installed 
instead. See Avaya Modular Messaging Client Add-in for 
Microsoft Outlook User Guide (PDF 1 MB) for details on the 
installation, operation, and use of this package. 
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3. Repeat this procedure until all existing versions of client software have 
been replaced with the version for the newest release.  

For details on installing or using a client software package, see the appropriate user 
guide in the reference section on the documentation CD:

! The Modular Messaging Subscriber Options User Guide (585-310-789, 
PDF 1 MB), used for the outcalling acceptance test 

! Avaya Modular Messaging Client Add-in for Microsoft Outlook User 
Guide (PDF 1 MB), used instead of Subscriber Options for the outcalling 
acceptance test if Outlook 2000 or 2003 is installed on a client machine 

! The Avaya Mailbox Manager User Guide (available on the Mailbox 
Manager CD)

Performing acceptance tests

After updating the system, verify that it is working correctly by doing acceptance tests. 

1. See "Performing acceptance tests" on page 5-9 and perform all the tests 
relevant to this system. 

2. When all performance tests are complete, back up the system. See 
"Backing up the system (MAS and MSS)" on page 5-18. 

Note: The Subscriber Options software should be updated on every 
MAS prior to performing the acceptance tests.
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A
System planning forms

Overview

A new Avaya S3400-family message server system installation requires 
careful network planning. Server names, IP addresses, domain names, 
accounts, extensions, and passwords must be administered correctly on each 
of the servers in the system. Some information must be provided by the 
customer in advance, or the installation cannot proceed. 

This appendix provides an overview of system planning and a set of forms for 
you to fill out prior to installation with the help of the local LAN, switch, and 
messaging administrators. Information includes:

! Terminology on page A-2 

! Guidelines for completing the forms on page A-3

! S3400-family system planning form on page A-6

! S3400-family system planning form (completed example) on 
page A-8

! S3400-family password table on page A-9

! MAS logon accounts form on page A-10

! MAS features list on page A-11

! Required switch and messaging information on page A-12

! Services information on page A-13
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Terminology

The following terminology applies to the LAN administration process. 

Host name � The unique name of the machine. In Microsoft Windows terminology, this 
is often called the NetBIOS machine name. This name may or may not match one of 
the network interface names. This is often the short name of the public IP interface.

NetBIOS name � The Microsoft Windows term for a host name, also called a NetBIOS 
machine name.

Domain name � A unique designator used to identify a group of related computers on 
the internet (such as avaya.com). Domain names are hierarchical, and the labels go 
from more specific on the left to more general on the right. There can be any number of 
levels in the hierarchy. 

Domain Name Service (DNS) � An Internet protocol service most often used to 
resolve symbolic names to IP addresses. The DNS service is constructed on 
hierarchical domains with different sets of servers serving each hierarchical layer.

DNS server � A machine that has the DNS service active. Such a machine can resolve 
symbolic names for the DNS domain it serves to an IP address. 

Fully Qualified Domain Name (FQDN) � A domain name which identifies an 
individual computer and the network on which it resides (such as zippy.loc.avaya.com). 
The leftmost label is the host name of the computer.

Private FQDN � An FQDN containing the host name and the private domain name 
(such as zippy.zodiac.com).

Public (corporate) FQDN � An FQDN containing the host name and public domain 
name (such as zippy.loc.avaya.com).

NetBIOS domain � A Microsoft Windows domain that is not fully qualified (has no 
periods), such as zodiac.

IP address � A value used to identify a computer connected to a network. If a machine 
has multiple network interfaces, then the machine will have multiple IP addresses, one 
for each connection to a different network. IP addresses are usually specified as four 
numbers separated by a period (for example, 10.9.55.183).

Subnet mask � A value used to tell which bits of an associated IP address are the 
network portion and which bits identify the specific host on the network. Each network 
interface has an IP address and an associated subnet mask.

Corporate IP LAN and interface � Each S3400-family server has two network IP 
interfaces. One is connected to the LAN infrastructure constructed and maintained by 
the enterprise that purchased the system. The LAN is the corporate IP LAN and the 
interface connected to it is the corporate IP interface. This LAN is also identified as 
Ethernet interface 0, Local Area Connection, or Corporate LAC. This LAN gives the 
S3400-family system access to other machines and users.
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Private IP LAN and interface � The second network IP interface in each S3400-family 
server is connected to an Ethernet switch provided by Avaya as part of the product. 
The LAN is the private IP LAN and the interface connected to it is the private IP 
interface. This LAN is identified as Ethernet interface 1, Local Area Connection 2, or 
the Private LAC. It is used only to send information between the S3400-family servers.

IP gateway � An IP gateway is an IP address where IP packets are routed if the 
specified IP address is not on the network directly connected to an interface on the 
machine. An IP gateway is usually an interface on a router.

Default IP gateway � The IP gateway to use if no other specified gateway is available. 
Each S3400-family server has at most one default gateway connected to the corporate 
IP interface. There is no IP gateway on the private LAN.

PPP � Point-to-Point Protocol, an Internet standard protocol used for serial line 
connections, such as dial-up modems.

Voice Mail Domain (VMD) � A group of one or more messaging servers. Messaging 
(or voice) servers in a VMD share configuration properties of the VMD and subscribers 
to the VMD.

Windows domain � A grouping of network objects, such as users, groups, and 
computers. All objects in a domain are stored in Active Directory. Active Directory can 
reside on one or more domain controllers within a domain.

Guidelines for completing the forms

Use the following guidelines to complete the S3400-family system planning form on 
page A-6 for each S3400-family message server you need to install. 

See the S3400-family system planning form (completed example) on page A-8 for a 
sample completed form.

Note: Do not change any values that are already filled in on the form 
unless it causes a conflict with the corporate network. Work with 
the LAN administrator to identify and correct any potential 
addressing problems or conflicts. 

It is crucial to coordinate the IP addresses that will be used on the 
S3400-family servers with those on the corporate LAN. If you 
specify an Ethernet address for an Avaya server that conflicts with 
another Ethernet endpoint, the resulting traffic problems on the 
local area network can be extremely difficult to diagnose and solve.
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To complete the S3400-family system planning form:

1. Choose unique NetBIOS machine (host) names for the MSS and all 
MAS machines (for example, zigzag, zippy, and zorro). You must keep 
track of what machine you are administering. In this guide, zigzag is the 
MSS, zippy is MAS#1, and zorro is a subsequent MAS. 

2. For MAS#1: Select a fully qualified domain name (FQDN) for the private 
Windows domain that will be set up on this MAS (such as zodiac.com). 
This is a new domain and MAS#1 will be the domain controller. 
Coordinate this name with the LAN administrator (see step 6). 

3. For MAS#1: The private Windows NetBIOS domain name is everything 
up to the first period of the previously specified FQDN for the Windows 
domain (for example, zodiac). 

4. For MAS#1: The voice mail domain (VMD) is a simple term different 
from the Windows domain (for example, zebra).

5. The private FQDN for an MAS machine is used only on the private 
network (for example, zippy.zodiac.com). 

6. The corporate FQDN, LAN addresses, domain names, and default 
gateway (if any) must be supplied by the corporate LAN administrator. 
See items 6 through 12 in the S3400-family system planning form. 

! The IP address for any required DNS servers are on the corporate 
LAN and must be supplied by the corporate IP administrator. 

! The domain search order and any domain names must be supplied 
by the corporate LAN administrator in the order required.

Note: The first MAS will be promoted to a domain controller, after 
which its name cannot change. Use its final name now. 

MAS machine names must be 14 characters or less. Names 
shorter than 10 characters long are recommended for ease in 
completing the online screens. (For CLAN integrations, the 
MSS host name must be no longer than 7 characters.) 

The host and domain names can be any term you want, as 
long as they are unique and comply with local conventions. 

Note: All domain names (FQDN, Windows domain, and VMD) should 
be unique to avoid confusion. See the S3400-family system 
planning form (completed example) on page A-8.
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7. The machine names for the private LAN, their associated IP addresses, 
and subnet masks (items 13 through 15 in the S3400-family system 
planning form) are already specified and do not normally change. 

8. If the Offline Access feature will be used in a multiple-MAS system, 
specify the location to be used for the offline message store. The remote 
store is used to synchronize messages in a multiple-MAS configuration. 

9. Complete the S3400-family password table on page A-9 so you can 
supply the correct passwords for all required services and trusted 
servers on the MSS and MAS machines.

10. Complete the MAS logon accounts form on page A-10 using the 
customer-provided account names and passwords required for this site.

11. Have the customer specify the messaging services that they want to 
install on each MAS using the MAS features list on page A-11.

12. Complete the Required switch and messaging information on page A-12 
with help from the relevant messaging or switch administrator. 

13. Complete the required Services information on page A-13 with help from 
the customer and the entity responsible for providing ongoing services 
maintenance of the system. This information varies depending on 
whether INADS or SNMP alarming is to be used at this site. 

Note: It is strongly recommended that only static IP addresses be 
assigned to the Ethernet interfaces and machines in an 
S3400-family system.

IP addresses should be configured on the corporate DNS 
servers (if used) by LAN personnel in keeping with local policy 
and practices. Customers must also register the corporate 
FQDNs for the MSS and each MAS on any relevant corporate 
DNS servers.

Note: If the offline message store is to be on a machine other than an 
MAS, the share must be mapped as a network drive on the 
MAS machine. See the Avaya Modular Messaging Software 
Messaging Application Server Administration guide (PDF 3 
MB) on the documentation media for details. 

CAUTION: Keep a copy of the completed planning forms handy during 
initial administration and system configuration. Save your 
planning forms in a safe place when installation is complete 
in case changes or updates are made to the system. 
Be sure to file records of passwords and account names 
securely.

!
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Page 1 of 2

S3400-family system planning form

# Item MSS MAS #1 MAS #2

1 Host name (machine or 
NetBIOS name)

2 Private fully qualified 
Windows domain 

�Use MAS#1 value� �Use MAS#1 value�

3 Private Windows 
NetBIOS domain

�Use MAS#1 value� �Use MAS#1 value�

4 Voice mail domain �NOT USED� �Use MAS#1 value�

5 Private FQDN for Eth1 �NOT USED�

6 Corporate domain 
name

7 Corporate FQDN for 
Eth0

8 Corporate IP address 
for Eth0

9 Corporate subnet mask 
for Eth0

10 Corporate default 
gateway IP address

11 Corporate DNS servers 
IP addresses 

12 Search order of DNS 
domains

13 Private system name mss1 mas1 mas2

14 Private IP address for 
Eth1

192.168.1.1 192.168.1.250 192.168.1.249

15 Private subnet mask for 
Eth1

255.255.255.0 255.255.255.0 255.255.255.0

16 Offline message store �NOT USED�

17 Customer name: 

Organization: 
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Page 2 of 2

S3400-family system planning form (continued)

# Item MAS #3 MAS #4

1 Host name (machine or 
NetBIOS name)

2 Private fully qualified 
Windows domain 

�Use MAS#1 value� �Use MAS#1 value�

3 Private Windows 
NetBIOS domain

�Use MAS#1 value� �Use MAS#1 value�

4 Voice mail domain �Use MAS#1 value� �Use MAS#1 value�

5 Private FQDN for Eth1

6 Corporate domain name

7 Corporate FQDN for 
Eth0

8 Corporate IP address 
for Eth0

9 Corporate subnet mask 
for Eth0

10 Corporate default 
gateway IP address

11 Corporate DNS servers 
IP addresses 

12 Search order of DNS 
domains

13 Private system name mas3 mas4

14 Private IP address for 
Eth1

192.168.1.248 192.168.1.247

15 Private subnet mask for 
Eth1

255.255.255.0 255.255.255.0

16 Offline message store 

17 Customer name: 

Organization: 
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The following planning form shows a completed example for a two-MAS system. These 
sample values are used in this guide for illustration purposes.
 

S3400-family system planning form (completed example)

# Item MSS MAS #1 MAS #2

1 Host name (machine or 
NetBIOS name)

zigzag zippy zorro

2 Private fully qualified 
Windows domain 

�Use MAS#1 value� zodiac.com �Use MAS#1 value�

3 Private Windows 
NetBIOS domain

�Use MAS#1 value� zodiac �Use MAS#1 value�

4 Voice mail domain �NOT USED� zebra �Use MAS#1 value�

5 Private FQDN for Eth1 �NOT USED� zippy.zodiac.com zorro.zodiac.com

6 Corporate domain name loc.avaya.com loc.avaya.com loc.avaya.com

7 Corporate FQDN for Eth0 zigzag.loc.avaya.com zippy.loc.avaya.com zorro.loc.avaya.com

8 Corporate IP address for 
Eth0

10.9.83.214 10.9.83.72 10.9.83.39

9 Corporate subnet mask 
for Eth0

255.255.255.0 255.255.255.0 255.255.255.0

10 Corporate default 
gateway IP address

10.9.83.254 10.9.83.254 10.9.83.254

11 Corporate DNS servers 
IP addresses 

10.9.1.39
10.9.1.2

10.9.1.39
10.9.1.2

10.9.1.39
10.9.1.2

12 Search order of DNS 
domains

loc.avaya.com 
avaya.com

loc.avaya.com 
avaya.com

loc.avaya.com 
avaya.com

13 Private system name mss1 mas1 mas2

14 Private IP address for 
Eth1

192.168.1.1 192.168.1.250 192.168.1.249

15 Private subnet mask for 
Eth1

255.255.255.0 255.255.255.0 255.255.255.0

16 Offline message store �NOT USED� \\zorro\OfflineStore \\zorro\OfflineStore 

17 Customer name: Messaging Administrator 

Organization: Avaya Inc. 



December 2003

System planning forms

A�9585-310-332, Issue 3

Account and password tables

Fill out the following tables with the customer to assign the passwords, account names, 
and login names at this site. 

 

S3400-family password table

# Trusted server on MSS MSS calls this: MAS calls this: Password

P1 MAS #1 host name 
(NetBIOS name)

trusted-server 
MAS#1NAME

LDAP

P2 MAS #2 through MAS #4 
(if present)

trusted-server 
MASNAME

LDAP �Use MAS #1 password�

P3 Message Waiting Indicator 
(MWI) Server

VVSTS IMAPI

P4 IMAP trusted server Imap4TS1 IMAP4

CAUTION: We strongly recommend that passwords be at least 8 
characters long (up to 10 characters) and not composed of 
easily guessed words or numeric combinations, including 
sequential or repeated numbers. For best security, use a 
combination of alphanumeric characters (case is not 
important for trusted-server passwords). At least one of the 
first 7 characters should be a symbol (such as a # sign or 
punctuation mark). 

Be sure to file records of passwords securely.

!
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Account logon names and passwords should be site-specific for security reasons. 

 

MAS logon accounts form

# Account Logon name (should be 
customer specified) Password Used for

A1 Domain administrator 
account for
MAS#1 (required)

customer specified 
(for example, dom-admin)

Domain controller 
administration and 
system backups

A2 Local administrator 
account for 
MAS #2 (if present)

customer specified 
(for example, mas2-admin)

Local administration 
for this MAS

A3 Local administrator 
account for 
MAS #3 (if present)

customer specified 
(for example, mas3-admin)

Local administration 
for this MAS

A4 Local administrator 
account for 
MAS #4 (if present)

customer specified 
(for example, mas4-admin)

Local administration 
for this MAS

A5 Modular Messaging 
(MM) account

customer specified 
(for example, mmacct) 

MAS messaging 
services (MM) 
administration 

A6 Services account 
for any MAS

customer specified 
(for example, craft)

Services 
administration 
account for MM

A7 Customer account 
for any MAS

customer specified 
(for example, custacct)

Customer 
administration 
account for MM

A8 Safe mode 
administration 
for any MAS

N/A Safe mode login used 
for system state 
restoration 

CAUTION: We strongly recommend that passwords and account names 
on the MAS be at least 8 characters long and not composed 
of easily guessed words or numeric combinations, including 
sequential or repeated numbers. For best security, use a 
combination of upper-case, lower-case, and alphanumeric 
characters. At least one of the first 7 characters should be a 
symbol (such as a # sign or punctuation mark), but not a % 
symbol.

Do not use the above examples as the actual MAS account 
names; they are provided for example purposes only.

!
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MAS services and features

Fill out the following table with the customer to specify the Modular Messaging services 
and optional features to install on each MAS. Guidelines include: 

! If only one MAS is installed, all required services are installed on that 
machine. Check the features to install in the MAS#1 column. 

! If more than one MAS is installed:

� Install the Call Me Server and MWI Server software on the same MAS. 
These services must be co-resident with the Mailbox Monitor Service, 
and should be installed on the MAS with the smallest number of ports 
if possible, or on the MAS with the second smallest number of ports if 
the Tracing Server is installed.

� Install the Tracing Server on a different MAS than the one that is 
hosting the Call Me and/or MWI software. Always put the Tracing 
Server service on the MAS with the smallest number of ports.

 

* Specify the maximum number of concurrent sessions for the feature based on expected usage. 

MAS features list

Messaging service to install Max. # of 
sessions:*

 on 
MAS#1

 on 
MAS#2

on 
MAS#3

 on 
MAS#4

Call Me Server

Message Waiting Indicator (MWI) Server 

Both use Mailbox Monitor Server and should be on the 
same MAS; install these services only once per voice 
mail domain (VMD). 

Caller Applications Editor N/A

Fax Sender Server (install only once per VMD)

Tracing Server (install only once per VMD) N/A

Text-to-Speech (If required, note languages to use; 
only 2 sessions are allowed per MAS.)

Messaging Application Server 

Prompt Files
(One set is required for each MAS that is running the 
Messaging Application Server software; list the default 
file set first and additional prompt files if needed.)

N/A

Language Packs
(Specify additional languages to install if needed; list 
the desired default language first. Install the same set 
of languages on each MAS.)

N/A
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Switch and messaging information 

Collect the required information from the relevant administrator prior to installation. 

CAUTION: You must obtain the required configuration notes for your 
PBX. See ��Required documentation�� on page 1-2.!

Required switch and messaging information

Item Value Notes

Extension numbers for the port boards on the 
MAS, and the switch ports to which they 
connect.
Note: Distribute the port board extensions 

over a number of switch boards if 
possible for greater reliability.

Use format: cabinet carrier slot 
port 

Connects to extension 
number: 

DID numbers used for:
� MM hunt group for messaging services:
� MSS alarm port number (RMB): 
� MAS dial-in number (1 per modem):

Complete dial-in number 

Extension number range for subscriber 
mailboxes in customer dial plan

Starting number Ending number 

SMTP networking password used for 
messaging networking (optional feature)

�

Subscriber mailbox to act as PostMaster:
� subscriber�s extension number
� password (must be numeric)
� class of service (cos) to use

�

Fax mailbox extension number:
� password (must be numeric)
� complete company fax printer number
� class of service (cos) to use

�

Test subscriber name and information:
� extension number to test telephone
� password (must be numeric)
� class of service (cos) to use

�
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Services information 

Fill out the appropriate section depending on how alarming will be implemented at this 
site: either through Avaya's Initialization and Administration System (INADS) or the 
corporation�s Simple Network Management Protocol (SNMP) system. 

Services information required for every installation includes:

! Alarming notification used at this site (INADS, SNMP, or none): ____

! Product ID number: _______________________________________

INADS alarming information

Supply the following information to allow the MAS modem to initiate outgoing calls: 

! Communications (COM) port that each modem should use to initiate 
alarm notification calls. This is COM3 for recommended USB port A on 
the MAS: _________________

! Complete alarm destination telephone number: _________________

! Modem setup (initialization) string required for the modem to make the 
alarm notification calls; see the documentation included with your 
modem for details: _______________________________________

Use the following table to record required customer- or services-provided information 
for establishing a remote access point-to-point (PPP) connection to the Services 
modem on the MSS. 

Note: If SNMP alarming is used, it is the customer�s responsibility to 
provide and provision the SNMP network management system, 
and to configure it to receive (and optionally acknowledge) the 
traps generated by the Modular Messaging system. 

PPP logins, passwords, and IP addresses

MSS login  Password
Local IP address for PPP 
access through MSS modem 
(customer-provided)

Remote IP address for PPP 
access through remote modem 
(may be customer- or 
Services-provided)

sappp

craftppp
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Use the following table if you install new software on an MSS using the steps in 
Appendix D, ��Reloading the software on an MSS.�� 

SNMP alarming information

Supply the following information if SNMP alarming is to be used at this site: 

! Network Management Station IP address or fully qualified domain name 
for the corporate network management system (NMS) that will monitor 
the Modular Messaging system for alarm notifications (traps): 
_______________________________________________________

! Context (community) to which the NMS belongs (see your SNMP NMS 
documentation for details): _____________________________

! Acknowledgement type: choose either Return Trap (to have traps 
actively acknowledged by the NMS) or Ping Surround (to have the MAS 
send a ping to the NMS before and after sending a trap; if the pings 
succeed, the NMS is assumed to have received the trap): 
_______________________________________________________ 

Services logins and passwords

MSS login  Password

root

craft

tsc

craftppp
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B
Installation checklist

Overview

Use this checklist for a S3400-family message server system installation. As 
you complete a procedure, make a check mark in the � � column.

S3400-family system installation checklist 

Task Description Comments

Complete preinstallation planning:

1. Complete the planning forms in Appendix A. Requires 
customer input.

See LAN, messaging, & switch 
administrators as needed. 

2. Obtain virus-checking software for the MAS. Customer obtains if required. 

3. Arrange for LAN administration of the S3400-family system. 
Some LANs may be administered in advance; others require 
new machine administration to be done at installation.
Register MAS and MSS corporate FQDNs on DNS if required. 
Note: Avaya Inc. is not responsible for the installation, 
administration, or test of communications between customer 
PCs and the LAN. 

See the LAN administrator.

4. Verify that the switch is administered. See the switch administrator.

5. Assemble and review the required documentation. Web access is required.

6. Review preinstallation site requirements, including:
� environmental requirements
� weight and space requirements
� customer-provided cabinet requirements
� installation area requirements
� power and grounding requirements
� demarcation points

 (1 of 4)
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7. Review security issues.

8. Gather the necessary tools and test equipment.

9. Collect any software CDs that will be needed during the 
installation (such as anti-virus software or Windows updates) 

Install the hardware:

10. Unpack the S3400-family system and peripheral components. Open boxes as instructed to 
reuse packing materials.

11. Assemble and identify the system components.

12. Attach mounting brackets and handles to UPS and any EBM 
units as needed, then cable the units together.

A UPS is optional for an Avaya 
MAS or MSS-S, but required for 
an MSS-H; 
EBMs are always optional.

13. Attach the front bezel to each MSS or MAS. 

14. Attach rails for rack-mount or rubber spacers for stackable 
configuration to each MSS or MAS.

15. Connect the S3400-family system power cables.

16. If present, connect the MAS port boards to the switch or PBX. See the Dialogic documentation 
for details.

17. Assemble the KVM switch. Steps include:
� Attach mounting brackets to KVM switch (if needed).
� Connect KVM switch to the monitor and keyboard/mouse.
� Connect the KVM switch to each MSS and MAS.

Procedure varies depending on 
type of KVM switch purchased.

18. Connect each MSS and MAS to the Ethernet switch (private 
LAN) and to the corporate LAN.

19. Attach the required ferrites to the video cables and QSIG port 
board cables (if present).

20. Set up the external modem for each MAS.

21. Connect the RMB (and its external modem if required) to the 
MSS and the switch.

Do initial MSS administration:

22. Power up the S3400-family system and peripheral 
components.

23. Log in to the MSS.

24. Adjust the monitor settings if needed.

25. Set the date and time on the system.

S3400-family system installation checklist 

Task Description Comments

 (2 of 4)
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26. Set up network addressing on the private and corporate LANs.

27. Administer the message core including:
� Set up the MSS host machine profile.
� Set up all required MAS, MWI, and IMAP trusted servers.

Requires information from LAN 
and messaging administrators 
(use the planning forms).

28. Reboot the MSS.

Do initial MAS administration:

29. Switch the monitor to show the correct MAS.

30. Install the hard disk image from the OS boot CD or DVD. Do only if the operating system 
must be reloaded on this MAS.

31. Complete the Found New Hardware wizards if they appear. Complete wizards as prompted.

32. Complete the Windows 2000 Server Setup Wizard to:
� Localize system information
� Assign IP addresses and DNS servers 
� Skip (for MAS#1) or join the Microsoft Windows domain 

Use your planning forms.

33. Change the default names of the private and corporate LAN. 

34. Test the IP addresses on the private network using ping.

35. Test IP addresses on the corporate network using ping. Optional but recommended.

36. Use the Modular Messaging OS Component Configuration 
Wizard to: 
� Identify the MSS message store
� Set up account information

Use your planning forms.

37. Install Modular Messaging software packages using the 
Installation wizard.

Install on each MAS based on 
the planning forms.

38. Use Messaging Application Server - Configuration Wizard to:
� Identify the MSS message store and supply credentials 
� Set up (on MAS#1) or join the voice mail domain

Steps vary between MAS#1 and 
a subsequent MAS.

39. Install, update, and enable anti-virus software on the MAS. Do if required; installation 
procedures vary. 

40. Install the latest Microsoft Windows security patches. Do if required; procedures vary. 

41. Set up remote access on each MAS.

42. Add all MASs to the remote access group. Do this on MAS#1 only.

43. Configure and test the port boards. This includes:
� For analog cards, create or use an appropriate tone file.
� Configure each port board.
� Test incoming and outgoing calls on each board.

Configuration notes required.

IP H.323 integrations skip this 
step.

S3400-family system installation checklist 

Task Description Comments
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44. Use the Voice Mail System Configuration program to:
� Enable the messaging services you have installed.
� Configure the MAS for this PBX.
� Set up specific features for each MAS.
� Install the license file when received. 

Configuration notes required.

45. Arrange to obtain a license for this system. Local procedures may vary. 

46. Set up and start MAS messaging services.

47. Verify the alarming setup on the MAS.

48. Administer each additional MAS. Repeat Chapter 4 as needed.

Complete initial administration: Do these tasks on the MSS 
unless otherwise noted.

49. Administer Internet messaging.

50. Update MAS host information and test using ping.

51. Place the MSS in the Microsoft Windows domain.

52. Modify classes of service for special mailboxes.

53. Set up the PostMaster and fax mailboxes.

54. Administer a test subscriber.

55. Perform acceptance tests. These include:
� Creating and receiving test messages in both integrated 

and nonintegrated mode
� Creating and printing faxes (if fax service is installed)
� Testing system outcalling using Subscriber Options
� Testing additional features as required 

56. Remove the test subscriber.

57. Set up remote access on the MSS for INADS if required:
� Administering PPP logins and passwords
� Activating each RMB modem (if applicable) 
� Setting up the PPP server configuration
� Activating and testing alarm origination 

Do if INADS alarming is used.

58. Disable alarm origination on the MSS for SNMP if required. Do if SNMP alarming is used.

59. Perform an attended backup on every MAS. Do this on each MAS.

60. Perform an attended backup on the MSS.

61. Set up unattended backups on the MSS.

62. Save the planning forms in a safe place.

S3400-family system installation checklist 

Task Description Comments

 (4 of 4)
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C
Creating a new tone file

Overview

This appendix describes how to build a tone file for analog port boards by using the 
PBXpert utility to learn PBX tones. 

This procedure must be done after the port boards are administered on the switch, but 
before you configure them using the Intel Dialogic Configuration Manager (see 
��Configuring analog port boards�� on page 4-28). 

You can use PBXpert either automatically or manually to learn the call progress tones 
for your PBX and store them in a Tone Set File (TSF). Many tone sets can be stored in 
a single TSF file. 

! Automatic Learning: PBXpert uses two different channels on the Dialogic 
voice board to set up tones and learn the resulting call progress tones 
automatically. See Learning tones automatically on page C-2.

! Manual Learning: PBXpert uses one channel on the Dialogic voice board 
and a telephone to set up tones and learn the resulting call progress 
tones manually. PBXpert prompts you how and when to use the 
telephone. See Learning tones manually on page C-7.  

Note: If only one line is connected to the Dialogic voice board, you 
must use Manual Learning.

CAUTION: Use the configuration notes to administer the port boards for 
your particular PBX or switch integration. See ��Required 
documentation�� on page 1-2 for instructions on obtaining the 
configuration notes. The port boards must be administered 
on the switch before you can proceed.

!
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Learning tones automatically

This section describes the following procedures:

! Running the PBXpert wizard on page C-2 

! Consolidating and saving the TSF file on page C-6

! Using the new TSF in Dialogic Configuration Manager on page C-6

Running the PBXpert wizard

The PBXpert wizard guides you through learning the tones used by your PBX and 
saving the information as a TSF file. PBXpert can learn the following tones: 

! Dial tone

! Ringback

! Busy

! Reorder (fast busy)

! Disconnect

To run the PBXpert wizard: 

1. Start the Dialogic voice cards. 

a. You should have already started the Intel Dialogic Configuration Manager. 
See steps 1 through 3 in ��Configuring analog port boards�� on page 4-28. 

b. Click the green Start Service button on the button bar. 

The installed boards show a green light when service is started, and the 
Stop Service button becomes active.

2. Click Start > Programs > Dialogic System Software > PBXpert.

The PBXpert main window appears (see Figure C-1 on page C-3). Most 
fields are blank until tones are learned.

! If you are using PBXpert for the first time after installation, the 
PBXpert wizard starts automatically.
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! If the PBXpert wizard does not start automatically, click Tones > Tone 
Wizard.  

Complete the PBXpert wizard screens as follows: 

1. When the PBXpert Wizard Welcome screen appears, click Next. 

2. On the PBX Information page:

! Under PBX, enter the name of the manufacturer (such as Mitel) and 
the model of the PBX (such as SX-2000).

! You can use the automatically created Tone Set File name as it 
appears, or alter it as desired.

! Click Next.

3. On the TAPI Information page, just use the default values. Click Next.

Note: You can change the default settings in the wizard if you are 
familiar with your PBX environment and the Dialogic API. Any 
settings that you change are saved when you exit PBXpert. For 
help on a particular screen, click the Help button in the wizard.

Figure C-1. PBXpert main window



585-310-332, Issue 3

Avaya Modular Messaging Release 1.1 Installation

C�4 December 2003

4. On the Select a Board screen:

! Select the Dialogic board to use.

! Click Next.

5. On the Select the Calling Resource screen, for the Line A Calling 
Channel: 

! For �Select the Channel,� enter the port number or channel to use.

! For �Phone Number,� enter the extension number of this port. See 
Required switch and messaging information on page A-12 for port 
board extensions.

! Click Next.

6. On the Select the Calling Resource screen, for the Line B Called 
Channel: 

! For �Select the Channel,� enter a different port number or channel to 
use.

! For �Phone Number,� enter the extension number of this port. 

! Click Next.

7. On the Settings Confirmation screen:

! Verify your settings. Click Back if you need to change anything.

! Make sure that the Run Wizard Auto-Test box is checked.

! Click Next.

8. The Auto Line Test window appears while PBXpert verifies the 
connection between the two specified channels. 

! If you see a �Test finished successfully!� message, click OK to close 
this window and proceed.

! If the line test fails, click OK to close this window. Click Back on the 
wizard, adjust your settings, and try the test again.

9. On the Learn Tones screen, click Next to begin learning tones 
automatically.

The Learn Tones window appears. See Figure C-2 on page C-5.  

Note: You can click Cancel at any time during the test to stop 
automated learning.
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10. When PBXpert completes learning, buttons appear allowing you to keep 
or discard the data.

! If the tones were learned without errors, select Keep Data. The 
Learn Tones window closes and you can proceed.

! If errors occurred, select Discard Data. The window closes. Click 
Back on the wizard, adjust your settings, and try to learn the tones 
again. You cannot test or save the tone file if it contains errors. 

11. On the Verifying the Learn screen, click Next to test the learned tones.

! If the test succeeds, click OK to close the test window and proceed.

! OK to close this window. Click Back on the wizard, adjust your 
settings, and try the test again. 

12. The Summary of Results page shows the final wizard status and tone 
definitions. Click Finish.

Tone definitions are displayed in the main window (see Figure C-3 on 
page C-6). 

Figure C-2. Learn Tones window (learning in progress)
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Consolidating and saving the TSF file

You must consolidate and save the new TSF file so that you can use it with the Dialogic 
voice driver. To do this:

1. Click Tones > Consolidate.

2. When finished, click File > Save to save the new TSF file.

a. On the Save As screen, navigate to the following directory to ensure that 
the file will be backed up: c:\Avaya_Support\Tone_Files 

(If you use the default DATA directory, this file will not be backed up.) 

b. Specify a file name with file type of TSF (such as Mitel-SX-2000.tsf).

Using the new TSF in Dialogic Configuration Manager

To use the new TSF that you just created: 

1. Return to the Intel Dialogic Configuration Manager window.

Figure C-3. Sample tone definitions in main window 
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2. Click the red Stop Service button on the button bar.

3. Return to step 4 in ��Configuring analog port boards�� on page 4-28 and 
complete board configuration and testing.

Learning tones manually

This section describes the following procedures:

! Running PBXpert on page C-7 

! Adding a new tone set on page C-8 

! Learning tone definitions on page C-8 

! Testing the tone set on page C-10

! Consolidating and saving the TSF file on page C-10 

! Using the new TSF in Dialogic Configuration Manager on page C-10 

Running PBXpert

To run PBXpert manually: 

1. Start the Dialogic voice cards. 

a. You should have already started the Intel Dialogic Configuration Manager. 
See steps 1 through 3 in ��Configuring analog port boards�� on page 4-28. 

b. Click the green Start Service button on the button bar. 

The installed boards show a green light when service is started, and the 
Stop Service button becomes active.

2. Click Start > Programs > Dialogic System Software > PBXpert.

The PBXpert main window appears (see Figure C-1 on page C-3). Most 
fields are blank until tones are learned.

3. If you are using PBXpert for the first time after installation, the PBXpert 
wizard starts automatically. If the PBXpert32 Wizard starts, check the 
�Don�t run wizard at startup� checkbox and click the Cancel button.

A new, empty TSF is now active.

4. In the PBXpert main window, click Settings on the button bar.
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5. In the Settings window:

a. For Line A, enter the Board Number (such as 1) and the Channel Number 
or port number.

b. The Manual mode checkbox should be checked.

c. For Line B, for Phone Number, enter extension for this port or channel. See 
Required switch and messaging information on page A-12 for port board 
extensions

You can use the default values for all the other fields on this screen. 
Click Help for more information if needed.

d. Click OK.

Adding a new tone set

To add a new tone set to a TSF:

1. From the PBXpert main window, click Edit > New Tone Set.

2. In the New Tone Set window:

a. Enter the PBX Manufacturer (such as Mitel) and Model name (such as 
SX-2000).

b. Click OK.

The PBXpert main window shows the manufacturer and model names 
you entered. The tone definitions are set to zero.

Learning tone definitions

To add tone definitions to the new tone set:

1. From the PBXpert main window, click Tones > Learn.

2. On the Start Learn window:

a. Select the tones for the Dialogic cards to learn (the default is all tones). 

b. Click Start Learn to have PBXpert start learning tones.

Note: If you are familiar with your PBX environment and the 
Dialogic API, you can change these default settings. Any 
settings that you change are saved when you exit PBXpert.
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The Learn Tones window appears (see Figure C-4 on page C-9). 

3. You are prompted to listen for ringing, and to pick up or replace the 
telephone handset during the test. When the message box pops up, do 
the requested action, then click OK. 

4. When the learning process has finished, tone definitions appear in the 
Learn window. Keep or discard the data as follows:

! If the tones were learned without errors, select Keep Data. The 
Learn Tones window closes and you can proceed.

! If errors occurred, select Discard Data. The window closes. Click 
Back on the wizard, adjust your settings, and try to learn the tones 
again. You cannot test or save the tone file if it contains errors. 

The Learn window closes. The new tone definitions appear in the 
PBXpert main window. See Figure C-3 on page C-6 for an example. 

Note: Click Cancel at any time to stop learning.

Figure C-4. Learn Tones window (learning complete)
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Testing the tone set

The Test function checks that the consolidated tone set in the active TSF works 
correctly with the Perfect Call call-progress analysis utility. 

To test the newly learned tones:

1. In the main PBXpert window, Tones > Test.

2. A Test window appears. 

When testing is complete, test results are displayed in the Test window.

3. Check that the tone definitions of the learned tones are correct.

Consolidating and saving the TSF file

You must consolidate and save the new TSF file so that you can use it with the Dialogic 
voice driver. To do this:

1. Click Tones > Consolidate.

2. When finished, click File > Save to save the new TSF file.

a. On the Save As screen, use the default DATA directory. 

b. Specify a file name with file type of TSF (such as Mitel-SX-2000.tsf).

Using the new TSF in Dialogic Configuration Manager

To use the new TSF that you just created: 

1. Return to the Intel Dialogic Configuration Manager window.

2. Click the red Stop Service button on the button bar.

3. Return to step 4 in ��Configuring analog port boards�� on page 4-28 and 
complete board configuration and testing.
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D
Reloading the software on an MSS

Overview

This appendix describes how to reload the operating system and application software 
on a Message Storage Server (MSS). This procedure may be used to install new 
software on a new system, or to put the required software on the hard disk if the MSS 
suffered a catastrophic disk failure and all the hard disks had to be replaced. 

The new MSS software is provided on a CD-ROM. 

Loading new MSS software

To copy new software to the MSS:

1. The KVM switch should be connected to the MSS through the first 
computer port (VGA 01). Verify that the monitor is showing the MSS.

! For a Belkin OmniView Pro2 KVM: To have the monitor show a 
different server, press slowly in sequence Scroll Lock, then Scroll 
Lock, then the up (or down) arrow key to change to the server 
connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the up 
or down arrow key (such as 01 for port 1). See your KVM switch 
documentation for complete user instructions.

! If the monitor does not showing the correct server, see ��Connecting 
the KVM cables�� on page 2-26 and verify the cable connections. To 
correct cabling problems, power down the system, correct the 
cabling, then power up the system again. 
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2. Insert the Avaya Modular Messaging Message Storage Server (MSS) 
Software CD into the MSS�s DVD drive. 

! For a picture of the MSS-S, see Figure 2-5 on page 2-12.

! For a picture of the MSS-H, see Figure 2-7 on page 2-14.

3. To reboot the system, press Ctrl + Alt + Del (or use a thin tool to press 
the reset switch on the front of the system).

The machine begins to boot, then displays the following options:

To install on a �standard availability� platform, 
type: standard <ENTER>.
To install on a �high availability� platform, type: 
high <ENTER>.
To reboot, remove the CD and press the 
<Ctrl><Alt><Delete> keys.

4. Type the word for the model of MSS that you installed and press Enter:

! Type standard for the MSS-S (no drive handles on the front).

! Type high for the MSS-H (has drive handles on the front). 

The system takes about 20 minutes to copy the software. 

When the copy is finished, you are prompted to remove the CD from the 
drive as follows:

Please, remove the Install CD from the CD drive, and 
press <ENTER>.

5. Remove the MSS software CD from the MSS�s DVD drive. 

6. When the CD is removed, press Enter to reboot the system.

7. At the Avaya Messaging welcome screen, press Enter to select OK.

The server displays the Time Date Selection screen. 

8. Set the time and date as follows:

a. Use the up or down arrow keys to highlight your time zone.

Note: Make sure that the CD is seated solidly between the plastic 
clips.

Note: Do not leave the CD in the drive, or the system will boot from it.
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b. Press Tab to move to the New Time section.

c. Enter the current time in hh:mm (hours and minutes) format, based on a 
24-hour clock.

d. Press Tab to move to the New Date section.

e. Enter the current time in mm/dd/yy (month, day, and year) format, such as 
12/04/03 for December 4, 2003.

f. Make sure an asterisk (*) appears in the Set hardware clock to GMT box. If 
not, press the space bar to add one.

g. Press Tab to move to the OK field, then press Enter.

9. When prompted to log in at the localhost login prompt, type root and 
press Enter.

10. Put the MSS software CD back in the DVD drive. 

11. At the # prompt, type autoinstall and press Enter.

12. When prompted to continue or quit, press Enter to continue.

13. You are prompted to change several passwords. 

! Enter the passwords you are provided for the following logins: root, 
craft, tsc, and craftppp. See Services logins and passwords on 
page A-14.

! It is okay to ignore any warnings, such as the passwords being too 
short.

When the autoinstall program completes, you are prompted to remove 
the MSS software CD from the drive as follows:

Please remove the Installation CD from the CD drive 
and press <ENTER>.

14. Remove the MSS software CD from the MSS�s DVD drive. 

15. When the CD is removed, press Enter to reboot the system.

16. Continue with step 2 in ��Logging in to the MSS server�� on page 3-3.

Note: Wait for the drive�s light to stop flashing before you proceed.

CAUTION: Do not leave the CD in the drive. If the system reboots from 
the CD, you must remove the CD and press Ctrl + Alt + Del 
when you see the menu listed in step 3. If you fail to do this 
and enter the machine type again, all your data will be 
erased, and you will have to install the software again.

!
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E
Reloading the software on an MAS

Overview

This appendix describes how to reload the operating system and application software 
on an Avaya Messaging Application Server (MAS). This procedure may be used to 
install new software on a new system, or to put the required software on the hard disk if 
the MAS suffered a catastrophic disk failure and a hard disk had to be replaced. 

Loading new MAS software

To copy new software to the Avaya Messaging Application Server (MAS):

1. The KVM switch should be connected to the MAS through one of the 
VGA computer ports. Verify that the monitor is showing the correct MAS.

! For a Belkin OmniView Pro2 KVM: To have the monitor show a 
different server, press slowly in sequence Scroll Lock, then Scroll 
Lock, then the up (or down) arrow key to change to the server 
connected to a higher or lower port number. 

You can alternatively type the port number instead of pressing the up 
or down arrow key (such as 02 for port 2). See your KVM switch 
documentation for complete user instructions.

! If the monitor does not showing the correct server, see ��Connecting 
the KVM cables�� on page 2-26 and verify the cable connections. To 
correct cabling problems, power down the system, correct the 
cabling, then power up the system again. 
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2. Insert the Avaya Modular Messaging OS Boot Software DVD in the DVD 
drive.

Wait for green LED on the drive to go out. 

3. Press Ctrl + Alt + Del to reboot the system.

a. In the Windows Security window, click Shut Down...

b. On the Shut Down Windows screen, select Restart and click OK.

4. When the machine begins to boot, it displays a warning message that 
the hard drive contents will be overwritten. Press any key to continue. 

5. At the message confirming that the hard drive will be overwritten, press 
any key to continue.

The MAS begins to copy the disk image to the hard disk. The entire copy 
procedure may take up to 20 minutes. 

If you are prompted to Cancel, click Yes. Reload the software starting 
with step 3. 

6. When finished, the program prompts you to remove the media before 
the system reboots.

! Remove the DVD from the drive and close the drive door. 

! Press any key to continue.

7. When the reboot completes, the Windows 2000 Server Setup Wizard 
appears. Complete the wizard as follows:

a. On the Your Product Key screen, type the Windows product key for this 
MAS (each unit has a unique product key). 

b. Click Next.

c. On the Licensing Modes screen, do nothing. The wizard continues the 
setup on its own.

The machine automatically reboots. 

8. When the reboot completes, proceed as follows:

! If no Found New Hardware Wizard appears, continue with step 9.

Note: This number must be entered exactly as shown. It is located on 
a sticker or tag on the side or rear of each MAS unit.

CAUTION: Do not touch the keyboard once the software starts loading, 
or the software will not install properly.!
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! If a Found New Hardware Wizard appears, it must be completed first, 
or the software will not install correctly. The hardware wizard appears 
once for every Dialogic port board installed in the system.

Disable the Dialogic hardware for now as follows: 

a. On the Welcome screen, click Next. 

b. On the Install Hardware Device Drivers screen, accept the default option 
(Search for a suitable driver) and click Next.

c. On the Locate Driver Files screen, clear the checkbox for �Specify a 
location� (no boxes will be checked). Click Next.

d. On the Driver Files Search Results screen, make sure that �Disable the 
device� is selected.

e. Click Finish.

f. Repeat steps a through e for each repetition of the wizard.

9. Double-click the MM_Setup.bat icon on the desktop. 

A C:\WINNT\system32\cmd.exe window appears. 

10. The program prompts you to load the required application software:

a. When prompted, insert the Avaya Modular Messaging Application Software 
DVD or CD in the DVD drive.

b. Wait for green LED on the drive to go out. 

c. When ready, press any key to continue. 

d. When notified that the D:\MM_Load\MM_Load.bat file was copied, press 
any key to continue. 

The machine displays the list of files that were copied. 

e. When prompted, press any key to continue.

11. When prompted to remove the media:

a. Remove the DVD or CD from the drive and close the drive tray door.

b. Press any key to continue.

12. When prompted that the Mini-Setup program will run after the system 
reboots, press any key to continue.

The machine stores the information and shuts down. 

13. Continue with ��Setting up the Windows system�� on page 4-4. 
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F
Recovering from a catastrophic disk

failure

Overview

This appendix summarizes the procedure for restoring an Avaya Messaging 
Application Server (MAS) if the hard disk drive failed and had to be replaced. The 
procedures are slightly different if you are restoring the first MAS in the system, or a 
subsequent MAS. 
 

To recover from a catastrophic disk failure, you will need:

! Avaya Modular Messaging OS Boot Software DVD for the Messaging 
Application Server (MAS).

! This guide and other required documentation for system installation. See 
��Required documentation�� on page 1-2 for a complete list.

! A copy of the completed planning forms, which should be on file. See 
Appendix A, ��System planning forms.�� 

Note: Make sure that the planning forms are accurate and up-to-date. 
When you restore the MAS machine, you must duplicate exactly 
the information from your original setup (machine names, domain 
names, passwords, and so on) to avoid problems.

CAUTION: This procedure is only valid for the following cases:
� The first MAS was damaged and there is no other MAS in 

the domain. 
� A subsequent MAS was damaged but MAS#1 is fine.

All other failure cases must be escalated at this time.

!
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Recovery procedure

To restore an Avaya MAS following a catastrophic disk failure:

1. The faulty drive must be replaced and the system powered back up. See 
�IDE drive replacement� on the documentation media for these steps.

2. Install the operating system on the new disk drive. Follow the steps in 
Appendix E, ��Reloading the software on an MAS.��

3. Continue restoring the system depending on the MAS as follows:

! If you are restoring MAS#1: Continue with ��Restoring the first MAS�� 
on page F-2.

! If you are restoring a subsequent MAS: Continue with ��Restoring a 
subsequent MAS�� on page F-3.

Restoring the first MAS

The first MAS is the domain controller for a Modular Messaging system, so it requires a 
unique procedure. To restore MAS#1:

1. Follow the steps in Chapter 4, ��Administering the Avaya MAS,�� from 
��Setting up the Windows system�� on page 4-4, through ��Installing the 
Modular Messaging software�� on page 4-16. 

2. In the section ��Configuring the MAS�� on page 4-19, for step 3 (the Voice 
Mail Domain Selection screen), you must select the radio button for 
�Subsequent server in an existing voice mail domain.�

3. Complete the rest of Chapter 4, ��Administering the Avaya MAS.�� 

4. On the MSS, repeat the procedure for ��Placing the MSS in the Windows 
domain�� on page 5-5.

5. Continue with restoring MAS#1 as follows:

! If MAS#1 is the only MAS in the system, continue with ��Completing 
system restoration on every MAS�� on page F-4.

! If any additional MASs are in the system, continue with step 6.

CAUTION: The procedure for restoring MAS#1 to service after a disk 
failure is slightly different from the procedure listed in 
��Configuring the MAS�� on page 4-19. Follow the instructions 
below exactly to restore the first MAS. 

!

mdide.htm
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6. Log in to each subsequent MAS as the local administrator as follows:

a. On each additional MAS, click Start > Log off admin-account.

b. On the Log Off Windows screen, click Yes.

c. Press Ctrl+Alt+Del to log on.

d. On the Log On to Windows screen, change the User name to the Local 
Administrator account name for this MAS (such as mas2-admin). See items 
A2 through A4 on the ��MAS logon accounts form�� on page A-10.

e. Enter the password for this account. 

f. Log on to the machine name for this MAS (such as zorro). See item 1 on 
the ��S3400-family system planning form�� on page A-6.

g. Press Enter or click OK.

7. Now make this MAS a member of a workgroup as follows:

a. Right-click My Computer and select Properties.

b. In the System Properties window, click the Network Identification tab.

c. Click the Properties button. The Identification Changes window appears.

d. Click the Member of Workgroup radio button. 

e. Name the workgroup (WORKGROUP is okay) and click OK.

f. Click OK to close the System Properties screen.

g. Reboot the system when prompted.

8. Log back in as the local machine administrator (the same account you 
used in step 6).

9. Do the section ��Adding an MAS to the Windows domain�� on page F-6 to 
join the existing Windows domain (such as zodiac).

10. Repeat steps 6 through 9 for every additional MAS in the system.

11. To complete the system restoration, continue with ��Completing system 
restoration on every MAS�� on page F-4.

Restoring a subsequent MAS

To restore an additional MAS in a multiple-MAS system:

1. Follow the steps in Chapter 4, ��Administering the Avaya MAS,�� from 
��Setting up the Windows system�� on page 4-4, through ��Installing the 
Modular Messaging software�� on page 4-16.

2. Before you begin the section ��Configuring the MAS�� on page 4-19, 
delete the old account for this machine as follows:
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a. Double-click the Configure icon on the desktop.

b. In the left-hand pane of the Configure window, expand Active Directory 
Users and Computers.

c. Expand Computers.

d. Locate the name of the MAS machine that had the failed drive (the machine 
that you are now restoring).

e. Right-click this machine name and select Delete.

f. Close the Configure window. 

3. Continue with the section ��Configuring the MAS�� on page 4-19 and 
complete the steps as documented.

4. Complete the rest of Chapter 4, ��Administering the Avaya MAS.�� 

5. To complete the system restoration, continue with ��Completing system 
restoration on every MAS�� on page F-4.

Completing system restoration on every MAS

To complete restoring the system for any MAS: 

1. Reinstall any previously installed patches on this MAS.

2. Restore data files from backup including spooled messages, customized 
caller applications and prompts, and the hosts file. 
 

a. Run the Restore Wizard as described in �Restoring backed-up MAS data 
(after a non-catastrophic failure)� on the documentation media. 

b. Restore the following:

! hosts file

! CABACKUP folder (contains Caller Applications)

! Spool directory

CAUTION: You must delete the old account for this MAS before you 
begin ��Configuring the MAS�� on page 4-19. !

CAUTION: Do not restore the System State following a catastrophic disk 
failure.!

AG_MAS_br_4.htm
AG_MAS_br_4.htm
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! custom prompt files (if they have been changed by the customer) 

c. Complete the restoration wizard as directed.

3. To complete the restoration of Caller Applications, do the following:

a. Click Start > Run to open a Command prompt window.

b. In the Run box, type the following in the Open field and press Enter:

C:\Avaya_Support\CMD\CARestore.bat 

4. As a precaution, preserve a copy of the existing backup file as follows:

a. Click Start > Run. In the Open field, type \\mss1\masbackup 

You are prompted for an account name and password.

b. In the Connect As window, use the domain administrator account name 
(such as dom-admin) and password. See item A1 on the ��MAS logon 
accounts form�� on page A-10. Click OK.

Windows Explorer will launch.

c. Locate the backup file for the MAS that you are restoring (such as 
ZIPPYDailyBackup.bkf, where ZIPPY is the host name of this MAS). 
Right-click the file name and select Rename.

d. Type a new name for this backup file (such as OldZIPPYDailyBackup.bkf) 
and press Enter.

5. Do ��Performing acceptance tests�� on page 5-9.

6. Reinstall any other software that was previously installed on this MAS 
(for example, Subscriber Options or virus-checking software).

7. When you are satisfied that the system is running correctly, do the 
��Backing up the system (MAS and MSS)�� on page 5-18 procedure for 
the MAS that you just restored. 

Note: Do not restore the System State.

Note: This step works only on Release 1 systems after installing 
RFU1.01. Without this patch, the Caller Applications files could 
be lost unless they were backed up in another way.

Note: If you restored MAS#1, when you repeat the procedure for 
��Setting up and running backups on every MAS�� on page 5-18, 
you need to re-enter the domain-administrator account and 
password for every MAS in the system to schedule backups 
again.
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Adding an MAS to the Windows domain

 

If you are adding an additional MAS to the system, it must join the Windows domain 
that you already created for MAS#1 so that it can be administered. 

To add an MAS to the existing Windows domain:

1. Right-click My Computer and select Properties.

2. In the System Properties window, click the Network Identification tab. 

3. Click the Properties button. The Identification Changes window 
appears.

a. Click the Member of Domain radio button. 

b. Enter the name of the Windows domain that you already created (such as 
zodiac). See item 3 on the ��S3400-family system planning form�� on page 
A-6).

c. Click OK.

d. In the Domain Username And Password window:

(1) Enter the Modular Messaging account name (such as mmacct) in 
the format domain\account name (such as zodiac\mmacct). See 
item A5 on the ��MAS logon accounts form�� on page A-10.

(2) Enter the Modular Messaging account password.

(3) Click OK.

It may take several minutes to join the domain.

e. A Network Identification box welcomes you to the domain. Click OK to close 
this box.

f. When prompted to reboot, click OK. 

g. Click OK to close the System Properties window. 

4. Restart the machine when prompted (click Yes).

CAUTION: Do this task only on an additional MAS (not MAS#1, which is 
the domain controller). !

CAUTION: If you are restoring an additional MAS to service after a 
catastrophic disk failure, you need to first create a workgroup 
entry before you can join the domain. See ��Restoring a 
subsequent MAS�� on page F-3 for details. 

!
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5. When the reboot completes, press Ctrl+Alt+Del to log back in using the 
Modular Messaging account name for this system.

a. On the Log On to Windows screen, click Options.

b. Expand the �Log on to� drop-down list and select the Windows domain 
(such as zodiac). 

c. Change the user name to the Modular Messaging account name (such as 
mmacct).

d. Enter the password for this account. See item A5 on the ��MAS logon 
accounts form�� on page A-10.

e. Click OK.

Note: It may take a few minutes for the personal settings to load.
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Removing Modular Messaging

components from an MAS

Overview

This appendix describes how to remove Modular Messaging software components 
from a machine where they are currently installed. You might use this procedure if you 
want to change the Messaging Application Server (MAS) on which a particular feature 
is installed, or to remove Modular Messaging software packages or tools from an 
administrator�s Microsoft Windows machine. 

Removing software components

To remove Modular Messaging software components:

1. Click Start > Settings > Control Panel.

2. From the Control Panel window, double-click Add/Remove Programs.

3. In the Add/Remove Programs window, scroll down the list of currently 
installed programs to locate the Modular Messaging software 
components installed on this machine. 

All Modular Messaging components begin with the name MM. 

4. Click the Modular Messaging software component you want to remove 
(for example, click MM Caller Applications Editor). 

5. Click Remove.

6. If prompted to confirm the deletion:

! Click Yes to remove the selected component.
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! Click No to leave this component installed on this machine. 

When the component removal is complete, the next item in the 
Add/Remove Programs window is selected. 

7. Repeat steps 3 through 6 to remove additional software components if 
needed.

8. When finished, close this window.
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loading new MSS software, D-1
local administrator account, 4-15, A-10
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host machine profile, 3-11
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S3400 logon accounts form, A-10
S3400 password table, A-9
security, 1-5, A-5
Services logins, A-14
SMTP networking, 3-12

PBX
configuration notes, 1-2, 4-27, 4-38, 4-46 to 4-47
configuring, 4-45
demarcation points, 1-11
integration, 4-47
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planning form, A-12
supported integrations, 4-45

PBXpert utility for tones file, C-1, C-7
PBXpert wizard, C-2
performing acceptance tests, 5-9 to 5-13, 6-17
Permissions for Subscriber Administration window, 4-42
Permissions for System Administration window, 4-42
Phone And Modem Options window, 4-23
ping IP addresses, 4-12 to 4-13, 5-4
planning forms, i-x, 1-7, 6-1, A-1

MAS features list, A-11
PPP logins and passwords, A-13
S3400 logon accounts form, A-10
S3400 password table, A-9
S3400 system planning form, A-6 to A-8
services logins and passwords, A-14
switch and messaging information, A-12

Point-to-Point Protocol, see PPP, A-3
port boards

configuring, 4-27, 4-30, 4-32, 4-47, 6-10
connecting cables, 2-24
extension numbers, A-12
supported boards, 2-4, 4-27
testing, 4-32, 4-35, 4-37, 6-11

PostMaster mailbox, 5-6, 5-8, A-12
power cables for S3400 system, 2-22
power requirements, 1-10
powering up the system, 3-2
PPP logins and passwords, 5-14 to 5-15, A-13
PPP Server Configuration screen, 5-15
preferred language, 4-39
preinstallation planning, 1-7, A-1
primary language, 4-43
printing a test fax, 5-11
private FQDN, A-2, A-4
private LAN

cabling, 2-29
default values, A-5
names and aliases, 5-3
settings on MAS, 4-9
settings on MSS, 3-8
terminology, A-3
testing addresses with ping, 4-12, 5-4

product ID number, 4-43, A-13
Prompt Files, 4-17, A-11
public FQDN, A-2
public LAN, see corporate LAN

R
rack-mount setup

KVM switch, 2-25

S3400 servers, 2-19
sample installed system, 2-6

RAS and IAS Servers Properties window, 4-25 to 4-26
recovering from a catastrophic disk failure, F-1
related resources, i-xi
remote access account, 4-15, 5-14 to 5-15, A-10, 
A-13
remote access setup, 4-22, 4-24, 4-26, 5-14, 5-16
Remote Maintenance Board, see RMB
remote support center, i-xi
remove MAS software, G-1
removing test subscribers, 5-13
renaming corporate and private LAN connections, 4-12
restart messaging service, 4-46
restricted-access location, 1-9
retrieving test messages, 5-9
RMB cabling, 2-34 to 2-35
RMB modem, 2-34 to 2-35, 5-15 to 5-16

S
S3400 servers

cabling, 2-28 to 2-29, 2-31
configuration, 2-2
installation, 2-18 to 2-19, 2-21 to 2-22, 2-24
key components, 2-12
weight, height, and depth, 1-8

S3400 system
overview, 2-2
powering up, 3-2

S3400 system planning form, A-3, A-6 to A-8
safe mode password, 4-15, A-10
safety requirements, 1-9 to 1-10
scheduled backup, 5-18 to 5-19
Scheduled Tasks window, 5-18
security, 1-4 to 1-5

passwords, A-5, A-9 to A-10
Security - Voice Mail Domain window, 4-42
security patches, 1-4 to 1-5, 4-21
sending test messages, 5-9 to 5-11
Serviceability - Voice Mail Domain window, 4-43
Services Account Properties window, 4-25
set emulation boards

cabling, 2-24
configuring, 4-30
testing, 4-35

setting up remote access, 4-22, 4-24, 4-26, 5-14, 5-16
setting up the monitor, 3-4
site requirements, 1-1

customer-provided cabinet, 1-9
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demarcation points, 1-11
environmental conditions, 1-8
installation area, 1-9
LAN and PBX/switch administration, 1-7
power and ground, 1-10
security, 1-4 to 1-5
test equipment, 1-6
tools, 1-6
weight and space considerations, 1-8

SMTP networking, 3-12, A-12
SNMP alarming, 4-43 to 4-44, 5-17, A-14
software shipped with system, 1-3
space considerations, 1-8
stackable configuration

KVM switch, 2-26
S3400 servers, 2-21
UPS and EBMs, 2-10

start messaging service, 4-49, 6-15
starting up the MAS system, 4-3
static IP addresses, 4-24, A-4 to A-5
subnet mask, A-2
Subscriber Options package, 5-12, 6-16
switch and messaging information, A-12
switch, see PBX
synchronizing MAS time with the MSS, 5-5
system configuration, 2-2
system hardware, see hardware installation
system planning forms, A-1
System Release 5.1.1 Feature Pack 1, 6-9
system security, 1-4 to 1-5

T
T1/E1 connections, 1-9
T1-QSIG boards

cabling, 2-24
configuring, 4-32
testing, 4-35

TCP/IP settings, 3-7, 4-6, 4-9
technical assistance, i-xi
Telephone User Interface, 4-40
telephones for acceptance testing, 1-6, 5-9
Telephony Configuration wizard, 4-46
Telephony Interface configuration, 4-47
temperature requirements, 1-8
terminology, A-2
test equipment, 1-6, 5-9
test subscriber

add, 5-8
planning form, A-12
remove, 5-13

testing IP addresses using ping, 4-12
testing outcalling capability, 4-37, 5-12
testing port boards, 4-35, 6-11
Text-to-Speech (TTS) feature, 4-18, 4-43, 4-45, 6-13 
to 6-14, A-11
time and date setup, 3-5, 4-4
tone file, 4-28, 6-7, C-1, C-5, C-9
tools for installation, 1-6
Tracing Server, 4-17 to 4-18, A-11
track messaging service startup, 4-47
trademarks, i-xi
training, i-xii
Trusted Server Profile screen, 3-13 to 3-14, 3-16
trusted server setup, 3-13 to 3-14, 3-16

U
uninterruptible power system, see UPS
unpacking the system hardware, 2-3
updating Modular Messaging software, 4-35, 6-1

client software, 6-16
configuring new features, 6-14
Dialogic drivers, 6-7
MAS, 6-6, 6-12, 6-14
MSS, 6-4
subsequent MAS, 6-15

UPS installation, 2-8
USB modem, 2-33, 4-23

V
ventilation of servers, 1-9
verifying alarming setup, 4-49, 5-17
virus-checking software, 1-5, 4-21
voice mail domain, 4-19 to 4-20, 4-38, 4-40, 4-44, A-3 
to A-4
Voice Mail Domain Selection screen, 4-19 to 4-20, F-2
Voice Mail System Configuration window, 4-40, 4-46, 
6-14

W
web access to documentation, 1-2
weight and space considerations, 1-8
Windows 2000 Server Setup wizard, 4-4, E-2
Windows domain, 5-5, 6-12, A-3 to A-4, F-6
Windows Domain Setup screen, 5-5
Windows product key, 4-5, E-2
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